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0 PREFACE
This documentation may contain sections in which particular hazards are defined 
or special attention is drawn to particular conditions. These sections are indicated 
with signal words in accordance with ANSI Z-535.6 and safety symbols (pictorial 
hazard alerts) in accordance with ANSI Z-535.3 and ISO 7010.

User information reported in this manual is in compliance with the following 
standards for Light-Emitting Products: EN/IEC 60825-1 “Safety of laser 
products – Part 1: Equipment classification and requirements” and CDRH 
21 CFR Title 21 Chapter 1, Sub-chapter J, Part 1040 “Performance standards 
for light-emitting products”.

Anyone setting up or operating a laser or working in an environment with working 
lasers must first read and understand how safety information is presented prior to 
beginning any tasks. Also see more information in the section, "Safety and 
Compliance".

0.1 Safety Warnings
This section provides information about signal words and safety symbols that you 
need to know before you begin to use BeamView.NET in a laser environment.

0.1.1 Signal Words
Four signal words are used in this documentation: DANGER, WARNING, 
CAUTION and NOTICE.
These signal words designate the degree or level of hazard when there is the risk 
of injury, as described in Table 0-1:  

Messages relating to hazards that could result in both personal injury and 
property damage are considered safety messages and not property damage 
messages.

Table 0-1.  Signal Words

SIGNAL WORD DESCRIPTION

DANGER! Indicates a hazardous situation that, if not avoided, WILL result 
in death or serious injury. This signal word is to be limited to the 
most extreme situations.

WARNING Indicates a hazardous situation that, if not avoided, could result 
in death or serious injury.

CAUTION Indicates a hazardous situation that, if not avoided, could result 
in minor or moderate injury.

NOTICE Indicates information considered important, but not hazard-
related. “NOTICE” may also be used when there is the risk of 
property damage. 
17
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0.1.2 Symbols
The signal words DANGER, WARNING, and CAUTION are always emphasized 
with a safety symbol that indicates a special hazard, regardless of the hazard 
level. The icons are intended to alert the operator as described in Table 0-2  

0.2 Export Control Laws
It is the policy of Coherent, Inc. to comply strictly with export control laws of the 
United States of America (USA).
Export and re-export of lasers manufactured by Coherent are subject to U.S. 
Export Administration Regulations, which are administered by the Commerce 
Department. In addition, shipments of certain components are regulated by the 
State Department under the International Traffic in Arms Regulations (ITAR).
The applicable restrictions vary depending on the specific product involved and 
its destination. In some cases, U.S. law requires that U.S. Government approval 
be obtained prior to resale, export or re-export of certain articles. When there is 
uncertainty about the obligations imposed by laws in the USA, clarification must 
be obtained from Coherent or an appropriate agency of the U.S. Government.
For products manufactured in the European Union, Singapore, Malaysia, 
Thailand: These commodities, technology, or software are subject to local export 
regulations and local laws. Diversion contrary to local law is prohibited. The use, 
sale, re-export, or re-transfer directly or indirectly in any prohibited activities are 
strictly prohibited.

Table 0-2.  Safety Symbols

SYMBOL DESCRIPTION

Important notes or instructions for operation and maintenance.

Danger of exposure to hazardous visible and invisible laser 
radiation.

Dangerous voltages when working with other equipment may be of 
sufficient magnitude to constitute a risk of electric shock.

Danger of susceptibility to Electro-Static Discharge (ESD).
18



1 INTRODUCTION TO BEAMVIEW.NET
This User Manual includes the following information about BeamView.NET, beam 
diagnostic software from Coherent, Inc.:
• Introduction
• Install the Software
• Set Up Hardware
• Software Interface
• Capture a Beam Image
• Analyze Calculations
• Troubleshooting

1.1 What is BeamView.NET?
BeamView.NET is Coherent's software that extends the analytic capabilities of 
the LaserCam-HR laser beam diagnostic systems. The software has been 
designed to provide flexibility, speed, and ease of use to monitor, analyze, and 
archive laser beam images.

1.2 Products Supported
BeamView.NET supports the following cameras:
• LaserCam-HR, LaserCam-HR-II-1/2”, LaserCam-HR-II-2/3”
• LaserCam-HR-UV, LaserCam-HR-II-2/3”-UV

IMPORTANT:
The LaserCam-HR-InGaAs camera is currently not supported in the 
BeamView.NET software. Users should continue to use the previous release 
of the BeamView v4.x.x software.

In addition, the BeamView.NET software is currently backwards compatible, to 
directly import images (.bin, .img, or .png), configuration files (.atc), and test files 
(.ats) generated by old BeamView software into the BeamView.NET software.

To prepare to import selected images, the command to import images clears the 
current buffer in the software. Selected images replace any previous images in 
the buffer.
19
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1.3 Features
The BeamView.NET software extends the analytic capabilities of the 
LaserCam-HR laser beam diagnostic systems, with multiple numerical analysis 
functions, configurable set-ups, and features to support maximum measurement 
accuracy.

1.3.1 Flat-Top Beam Analysis
Six additional calculations are now available with BeamView.NET software for 
flat-top beam analysis. These calculations are based on the ISO 13694:2000 
standards, and allow greater flexibility for the analysis of applications involving 
flat-top beam shapes. They also may assist in the analysis of beam uniformity of 
excimer and Nd:YAG lasers in the near field. The six new calculations are: 
• Plateau Uniformity
• Flatness Factor
• Edge Steepness
• Beam Uniformity
• Effective Irradiation Area
• Effective Average Power/Energy Density

1.3.2 Adjustable Trigger Delay
The adjustable Trigger Delay feature lets users add default trigger delay to the 
LaserCam-HR camera. This assists by providing additional flexibility when firing 
the camera from an external trigger source, such as the SYNC Output of a laser. 
Adjustable trigger delay assures a valid laser pulse is captured.

1.3.3 Real-Time Laser Monitoring and Alignment
The Live Video mode provides a continuously updated image of the laser beam. 
This mode is ideal for monitoring the laser and observing change sin the form and 
structure of the beam as it is adjusted. Live Mode allows for real-time tuning to 
achieve optimum beam profile quality and laser-cavity alignment. While operating 
in this mode, no beam or statistical data are displayed; however, if Start mode is 
activated, the image is stored and can later be analyzed.

1.3.4 Pass/Fail Analysis
Pass/Fail analysis allows simultaneous real-time monitoring of all (or any one) of 
the analysis results against user-specified minimum and maximum limits. Any 
combination of (or all) fault actions can be activated to signal a test failure, initiate 
a visual or audio alarm, stop data capture, reject or save a failed sample, and 
generate a TTL trigger pulse output signal.
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1.3.5 Adjustable Exposure Time
The camera exposure time is adjustable through the camera settings menu for all 
LaserCam-HR camera models.

1.3.6 Report Generation
BeamView.NET includes a single-page report that can be sent directly to a 
printer, saved to a file (.txt), or converted to an Adobe .pdf file by using a .pdf file 
converter. A simple screen print option is available from the same dialog box 
used to generate a report.

1.3.7 Additional Features
BeamView.NET software offers these additional features:
• Automatic background noise subtraction
• Remote Mode interface and commands
• Both 2D and 3D intensity plots
• Remote Mode interface and new commands
• Support for multiple cameras, each with a separate background image
• “Plug-and-play” feature to automatically recognize cameras
• Set variable aspect ratios for each camera
• Increase in the number of samples that can be captured; save images using 

industry-standard file formats
• Camera information embedded into image files.Software is currently 

backwards compatible, to directly import images (.bin, .img, or .png), 
configuration files (.atc), and test files (.ats) generated by old BeamView 
software into the BeamView.NET.

1.4 Theory of Operation
The BeamView.NET software uses USB 2.0 cameras to image, capture, store, 
and perform 2-dimensional intensity distribution analysis on beams from almost 
any laser or light source.

The digitized beam images are then stored in memory. The beam images can be 
captured with several different triggering methods and stored in a variety of 
resolution modes. 

Once in memory, a variety of analysis functions can be performed on the stored 
beam images. Images are then combined with user-selected graphics and 
calculated analysis results, and displayed on the computer monitor.

A wide variety of other system functions provide the ability to print information, 
control beam image capture, trigger functions for pulsed laser capture, and 
control various video and calibration functions.

In Start mode, these cameras can grab video beam images at 10-bit resolution 
(LaserCam-HR and LaserCam-HR-UV).
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A faster Live mode runs at 8 bits per pixel, but at 10 to 15 frames per second. 
BeamView.NET scales the resolution to 16-bit by up-shifting; all calculations 
using pixel intensity as an output—for example, Max, Mean, and Min— have a 
maximum value of 65,535. For the LaserCam-HR and HR-UV 10-bit cameras, the 
intensity is shifted up by a factor of 64 times (1024 x 64 = 65,536). 
22



2 INSTALL SOFTWARE
This section describes the process to install the BeamView.NET software.

NOTE:
Complete installation of the software before you connect any hardware.

In this User Manual, the term “computer” is used to refer to the device in which 
you install the software. That may be commonly referred to as a PC, laptop, 
workstation, CPU, desktop tower, or other name.

2.1 Before You Begin
To make both installation and operation of the BeamView.NET software easier, 
first check the following before you begin.

2.1.1 IT Procedures and Policies
In today’s world, it is often a challenge for organizations to find a balance 
between implementing security requirements and managing the user experience.
Security processes and controls required to comply with industry-accepted 
standards, regulations, and certifications may impose constraints on user 
authentication and access. Such controls may block a software installation, 
making it appear as incomplete or non functional.
Should you have difficulties installing the BeamView.NET software, before you 
call Coherent Technical Support, check with your IT group first to determine if:
• You have the administrative privileges required for installation.
• There are any internal security policies or controls in place that may render 

installation of a new software package incomplete.
Another option if to right-click in Windows and choose ‘Run as administrator’ (as 
shown in Figure 2-1). For any executable (.exe) files, Coherent recommends that 
you use this method for installation.  

Figure 2-1.  Run Installation as Administrator
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After those issues are resolved, then see “Service and Support” (p. 195) for 
details about how to contact Coherent for assistance. 

2.1.2 Software System Requirement
This section describes system requirements:
• Windows 10 (32- or 64-bit)
• 2.5 GHz processor or faster
• 2 GB of RAM or higher
• 5 GB of available hard disk space
• USB 2.0 or RS-232 port

2.2 Install the Software
Go to the Coherent website and download the BeamView.NETsoftware onto your 
computer.

https://www.coherent.com/measurement-control/measurement/laser-
measurement-and-control-help-center

The download files contains the software and drivers necessary to install and 
operate the BeamView.NET software.

IMPORTANT:
To avoid application instability, it is strongly recommended that you first 
disable computer hibernation or suspend mode before installing the 
software.

1. Close all other programs on your computer or laptop.
2. Double-click to run this file for the BeamView.NET software, where x” is the 

latest version:
BeamView_5.0.1.x.exe

If AutoRun is enabled on your laptop or computer system, installation starts 
automatically.

3. Follow the on-screen instructions to complete installation, described in the 
steps that follow.

2.2.1 Reminder: Close All Programs
As the installation process begins, the first message that is displayed reminds you 
to first close all other applications. Click OK to dismiss the message.  
If other programs are running, stop the installation process now and close the 
other active programs.

If an earlier version of BeamView.NET is installed on your system, the following 
message is displayed:  
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Click Yes to proceed to uninstall the older version, or No to continue without 
removing it.

2.2.2 Accept License Agreement
The License Agreement for BeamView.NET is displayed. Select the radio button 
to Accept the agreement, then click Next to proceed with the software 
installation.
Otherwise, click Cancel to stop installation of the software.  

 

Figure 2-2.  Reminder to Close Other Programs

Figure 2-3.  Message about Earlier Version

Figure 2-4.  Accept License Agreement
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2.2.3 Select Destination Location
Review the directory listed in the “Browse” line. If acceptable, click Next, or 
browse to select a different location, then click Next.  

2.2.4 Select Start Menu Folder
Review the directory that is displayed. If acceptable, click Next, or browse to 
select a different location, then click Next.  

2.2.5 Set Desktop Shortcut
This option allows you to create a desktop shortcut. Click Next when done.  

Figure 2-5.  Selection Destination Folder

Figure 2-6.  Select Start Menu Folder
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2.2.6 Preview Set-Up
This screen lists the selections that you have made. If you want to change any 
setting, click Back. Otherwise, click Install.  

A progress bar is displayed as installation proceeds.  

Because the software installation includes device drivers, another screen is 
displayed for explicit permission. Click Install to proceed.  

Figure 2-7.  Select Desktop Shortcut

Figure 2-8.  Review Set-Up

Figure 2-9.  Progress Bar
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Be aware that the USB drivers may take several seconds to install the first time 
the camera is connected to the computer.
Note that, when you click the checkbox to “Always trust software from Coherent, 
Inc.”, any subsequent installations of Coherent software begins without 
prompting. For example, if you install a later revision of BeamView.NET software 
at any time, the software for device drivers installs automatically with the 
BeamView.NET software, and this dialog box is not displayed.

2.2.7 Select Computer Restart
When installation is complete, the final set-up screen is displayed. Select the 
radio button for Yes or No to restart the computer, then click Finish.  

If you have difficulties installing the software, check first to ensure that you 
have the administrative privileges required for installation. 

Before you call Coherent for technical support, also check whether your 
organization’s IT department has security policies or controls in place that may 
render the software installation incomplete. 
• See “IT Procedures and Policies” (p. 23) for more information. 
• Also see “Service and Support” (p. 195) for details about how to contact 

Coherent for assistance.

Figure 2-10.  Install Drivers

Figure 2-11.  Select Computer Restart
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2.3 Uninstall Software
If you want to install a later version of the software, Coherent strongly 
recommends that you first uninstall the old version. Otherwise, the new 
installation may run over the top of the existing installation, introducing conflicts 
that can lead to serous system errors.
To uninstall the old versions of software:

1. In Windows, go to Settings > Apps > and, from the list of programs, select the 
BeamView.NET software, as shown in Figure 2-12:  

2. Click Uninstall. A warning message shown in Figure 2-13 is displayed that the 
application and all of its related files (including drivers) are removed:  

3. Click Uninstall to process. A confirmation message is displayed, as shown in 
Figure 2-14:  

4. Click Yes to proceed. A progress bar is displayed as the application and its 
related files are removed from the computer. A confirmation message is then 
displayed, as shown in Figure 2-15:  

You may now proceed to install a new version of the software (go to p. 24).

Figure 2-12.  Select Software to Uninstall 

Figure 2-13.  Select Software to Uninstall 

Figure 2-14.  Select Software to Uninstall 
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2.4 Next Steps
Go to “Set Up Hardware” (p. 31) to connect one or more cameras, make a 
connection to a PC, and launch the software.
Go to “Software Interface” (p. 43) to learn about the features and functions of the 
BeamView.NET application.
Go to “Capture A Beam Image” (p. 71) to create a Background Map 
(recommended) and capture a beam image and set Trigger options.

Figure 2-15.  Select Software to Uninstall 
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3 SET UP HARDWARE
This section describes how to set up software to work with the BeamView.NET 
software.

NOTE:
Complete installation of the software before you connect any hardware. After 
a camera is connected, BeamView.NET automatically recognizes the camera. 
See “Software Settings for Cameras” (p. 35) for details.

This section describes how to:
• Physically connect cameras
• Define software settings for cameras
• Setting up optics
• Aligning the laser and camera
• Setting up for Remote Mode
Each of these are described in the sections that follow.

3.1 Connect Camera Hardware
To view images from a camera on the computer, connect the camera to the PC. 
There are two methods and different cables required for this.
• Connect a single camera to a PC
• Connect multiple cameras
• Connect a camera when an external trigger is to be used
Each of these are described in the sections that follow.

IMPORTANT!
Take a new Background Map after each time a camera is set up to ensure that 
the images and calculations being collected are accurate. See “Background 
Map” (p. 73) for more information.

3.1.1 Connect Camera to PC
The LaserCam-HR cameras require only a standard 2-meter USB cable (shipped 
with each camera) and a computer with a USB 2.0- compliant port. Power is 
provided to the Coherent LaserCam-HR cameras directly over an standard USB 
cable. 
On the USB cable, an “A” style (flat) connector plugs into the computer or on the 
side of an LCD monitor. The opposite end—a “B” style connector—plugs into the 
camera, as shown in Figure-3-1:  
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To establish a connection with a PC:

1. Plug one end of the USB cable into the camera.
2. Plug the other end into the USB port on the PC.

IMPORTANT!
For port replicators, such as a USB connection on the side of a monitor, 
verify that the device is a USB v2.0 electronic and provides a good 
connection and current for reliable and uninterrupted processing. Port 
replicators can and have been found to reduce the reliability of connection.

The “plug-and-play” feature of the BeamView.NET software automatically detects 
that a camera is connected, and displays the camera model at the top of the right 
panel of the main window (see p. 43).

IMPORTANT!
The 2-meter cable supplied with the LaserCam-HR camera systems has been 
certified for reliable and low emission operation. At a high data rate, cables 
longer than 4 meters may cause issues.

When using a USB cable, an error message may be displayed, as shown in 
Figure-3-2:  

Figure 3-1.  Connect USB Cable to Camera

Figure 3-2.  USB Error Message
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This type of error can happen when a computer is unable to supply the 400 mA 
required by a LaserCam-HR camera, typically a laptop running on a low battery. 
Also, self-powered USB ports are incapable of supplying this current. Be sure that 
the laptop is fully charged or the USB port is fully powered.

IMPORTANT!
Connect ALL power cables to a surge-protected power source!

3.1.2 Connect Multiple Cameras
To connect multiple cameras, you must have USB ports available that are fully 
powered.
Some desktop computers have multiple USB ports built in that allow you to 
connect multiple cameras, as shown in Figure-3-3.  

Most laptop computers, however, have a limited number of USB ports. To be able 
to connect multiple cameras, install a device commonly referred to as a USB hub, 
dock, or Port Expander. When purchasing such a device, verify that the device 
has its own power supply (with sufficient power) as well as the correct type of 
connectors.
With multiple cameras, you can open multiple instances of BeamView.NET that 
display properties specific to that camera.

NOTE:
Multiple cameras may result in speed/performance degradation. Make sure 
the PC has plenty of computing power and RAM if you want to run multiple 
cameras. The computing power suggested earlier was intended for single 
camera operation.

Figure 3-3.  Connect Multiple Cameras
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3.1.3 Connect a Camera Using an External Trigger
When the camera is to be used with an external trigger, you must use a trigger 
cable, shown in Figure-3-5, instead of a standard USB cable. This cable is 
shipped with a LaserCam-HR camera. 

To connect the trigger cable: 

1. Rotate the cable until the orientation at the end of the connector matches the 
mating connector on the camera, then push the connector securely onto the 
mating connector. The cable connector is a keyed connector and has a lock 
type slide.

2. Connect the other end of the trigger cable to a trigger source, such as from the 
laser or a frequency generator.
This connects a TTL-level Pass/Fail output signal generated by 
BeamView.NET from user-configured calculation settings. See “Capture > 
Capture/Trigger” (p. 77) for information about configuring software for an 
external trigger.

3. After you plug in the camera, wait a few seconds for the computer to recognize 
the hardware.

The trigger cable allows connection of an external trigger source through a BNC 
receptacle (plug-style connector), as shown here:  

After the software installation is complete, launch BeamView.NET by double-
clicking the BeamView.NET desktop icon.  

Figure 3-4.  Trigger Cable 

Figure 3-5.  Connect Cable for External Trigger
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3.1.3.1 Trigger Options
A hardware trigger polarity selection is available with the BeamView.NET 
software. This trigger option selects External Triggering for Pulsed capture.

NOTICE!
Trigger selection is ONLY active for Pulsed mode operation.

Table 3-1 lists trigger specifications:  

A TRIG IN signal (TTL pulse) must be provided to the camera in Pulsed mode to 
capture pulsed image data. This signal normally comes from the laser electronics 
external sync output.
When Pulsed mode is selected (Capture > Trigger > Pulsed), choose either the 
Rising Edge or the Falling Edge. See “Capture > Capture/Trigger” (p. 77) for 
details about setting up parameters for a trigger in Pulsed mode.

3.1.3.2 Auto Trigger | Internal Trigger
The Auto Trigger (also referred to as Internal Triggering) mode does not require 
any trigger signals; therefore, it is often used for set-up and alignment.
• Auto Trigger is suggested for first time set-up if the repetition rate is greater 

than approximately 10 Hz. After some images are captured, using more 
advanced triggering methods can improve capture performance.

• It is not recommended to use the Auto Trigger mode of capture for Pulsed laser 
sources below 10 to 20 Hz.

See “Auto Trigger Mode” (p. 82) for more information about this feature.

3.2 Software Settings for Cameras
The “plug-and-play” feature of the BeamView.NET software automatically 
recognizes a camera after it is connected.
In the software, go to the Setup tab and select Camera.  

Figure 3-6.  BeamView.NET Desktop Icon

Table 3-1.  Trigger Specifications (External/Pulsed)
PARAMETER VALUE

Maximum Voltage 5.5V

High > 2.0V

Low < 0.8V

Minimum Voltage —0.7V
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When you select Camera, the following dialog box is displayed:  

From the drop-down menu, select the Camera for which you want to configure 
settings and capture images. Notice that the name and serial number of the 
camera are listed. Click Select.
A second dialog box is displayed. Notice that the serial number is listed.  

NOTE:
Coherent recommends leaving this user-defined number as the serial 
number of the camera in use in the event that the camera is returned to the 
factory for any reason.

Click OK to continue.

Figure 3-7.  Setup Tab

Figure 3-8.  Setup — Camera

Figure 3-9.  Setup — Camera — User-Defined ID
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3.2.1 Setup > Settings
The Settings area of the Setup tab includes the following options:
• Calibrate Power
• Scale Factor
• Focal Length
• Remote Mode
For a description of each, go to “Setup Tab” (p. 65).

3.2.2 Setup > Configuration Protection (Password)
Password protection is used to prevent accidental change to the BeamView.NET 
configuration settings. 
When you click the icon for Password, the dialog box shown in Figure-3-10 is 
displayed:  

Enter a new password, which can be up to fifteen characters long, and may 
contain only alphabetic characters and numerical digits (no punctuation marks or 
spaces). Entering an invalid character or exceeding the maximum length will 
cause the computer to beep.
When you click OK, a confirmation message is displayed. Click OK to dismiss the 
message:  

After the desired configuration settings are established, select the Password 
command from the Setup menu. After the password is entered, configuration 
settings cannot be changed unless the password is entered again. 
All configuration settings and windows can still be viewed as normal, but making 
a change and pressing the OK button displays a pop-up box requesting that you 
enter the correct password before saving the changes.

Figure 3-10.  Setup — Password Protection

Figure 3-11.  Setup — Password Locked Message
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3.3 Optics Set-Up
As with any sensitive diagnostic tests, accuracy is dependent upon the quality of 
the optics used in the measurement. 
In beam diagnostics testing, it is especially important to deliver the beam to the 
camera with negligible distortion. Therefore, only high quality, low distortion optics 
should be used in the test set up.
Table 3-2 lists the possible causes and effects of issues when using optics:  

If you are using an energy/power meter with the BeamView.NET software, the 
energy that is seen by the meter is also affected by any front-end optics. Although 
distortion is not a major concern with most detector types, scattering can affect 
energy readings (if it causes part of the beam to miss the sensor).
Note that the energy and power levels that a particular meter can dissipate, and 
then compensate the optics for the sensor accordingly. For additional information, 
refer to the owner's manual that came with your meter.
If you are using an energy/power meter, remember that the displayed energy 
(and the energy used in calculations) is just the reading from the meter. If there is 
improper compensation by the front-end optics, all calculations will be inaccurate. 
Be sure that the meter you use is able to compensate correctly for the front-end 
optics that you choose.
Recommended optical set-ups for maintaining minimal beam distortion include:
• Attenuation
• Background Light
• Focus Optics
Each of these are described in the sections that follow.

3.3.1 Attenuation
The most critical set-up operation necessary to avoid saturation or damage of the 
camera is the attenuation of the laser.
Camera saturation occurs at different levels and can vary dramatically between 
wavelength, mode of operation (CW or pulsed), and type of sensor. Check the 
User Manual for estimated saturation levels for the specific LaserCam-HR 
camera being used.

Table 3-2.  Issues When Using Optics
EFFECT CAUSE

Interference effects Caused by parallel optical surfaces. Always set optical surfaces 
at small angles.

Scatter Caused by dirty or damaged optics, or poor quality optical 
coatings.

Aberrations Caused by poor quality optical surfaces or materials.

Distortions Often caused by non-uniform optical materials or coatings, and 
by short focal length optics.

Background noise Caused by room light, scattered light, or laser flashlamp light.
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It is recommended that the laser source is attenuated well below the saturation 
level of the camera before performing any measurements with the beam profiling 
system. Using this precaution ensures that damage to the sensor does not occur.
It is important to attenuate the beam without introducing distortions. Do not use 
absorption-type attenuation optics where distortion and lensing effects can occur. 
It is best to perform the majority of the attenuation with front surface attenuation 
schemes—such as laser mirrors—that allow high levels of attenuation with low 
distortion. Make sure these attenuators are of high quality.
The best method of attenuation is to reduce the beam power with a continuously 
variable attenuator to provide maximum diagnostics test flexibility. This can be 
performed with crossed polarizers, variable-step Neutral Density (ND) filters, or 
continuous variable-wedge devices. Ensure that:
• The ND filters have laser grade surfaces and high quality coatings.
• The variable beam attenuators have the lowest possible distortion.
Coherent offers a selection of variable attenuation modules—C-VARM 
(continuously variable) and VARM (fixed-level attenuation)—that meet these 
specifications. For more information about these and other system accessories, 
visit the Coherent website:

https://www.coherent.com/measurement-control/measurement/beam-
diagnostic-accessories

An example of attenuation scheme is shown in Figure-3-12. Any combination of 
this set-up can be used to properly attenuate the laser beam.  

Figure 3-12.  Optics Attenuation Set-Up
39



BeamView.NET User Manual
3.3.2 Background Light
Background light seen by the camera should be closely monitored. This light 
comes from scattering, room lights, flashlamp lights, and instrumentation lights.
Elimination of background light is especially critical with pulsed laser diagnostics 
when some cameras are required to time-integrate the image to avoid image 
splitting. In these situations, low background light may be time integrated to large 
levels.
The BeamView.NET software cannot distinguish background light from the laser 
beam image, and includes this light in its analysis. In applications where the 
beam image size is small, even a modest amount of background light can greatly 
affect the accuracy of the beam analysis.
An attenuator window with low transmission should be attached to the camera 
housing to reduce background light and protect the sensor from collecting dust 
particles from the environment. 
Coherent recommends using a Low Distortion Faceplate (LDFP or LDFP-UV), 
which eliminates ambient room light that may reach the camera array. The 
Faceplate is made of 1.5 mm thick NG-10 laser-grade filter glass. Both LDFP or 
LDFP-UV surfaces are laser-grade polished.
The Faceplate provides a protective window for the camera array that does not 
cause interference fringes nor distorts the beam image. It also acts as a 
background attenuator with 0.03 to 0.06% transmission from 400 nm to 1100 nm. 
For wavelengths shorter than 400 nm, the camera must be used without the Low 
Distortion Faceplate. For details, see the User Manual for your camera.

3.3.3 Focus Optics
High quality, low-distortion optics and low background light noise are critical for 
obtaining accurate beam diagnostics results with the BeamView.NET software. 
You may use a focusing optic for Far Field beam diagnostics.
For best results, choose a focal length to get an image size that fills roughly 2/3 of 
the array diameter. If multiple wavelength testing is to be performed, a parabolic 
mirror may give better results than a lens, since chromatic aberration is not 
present in mirrors.
The focusing optic should be of superior quality to avoid distortion and 
aberrations. Be aware that the shorter the focal length, the larger the inherent 
aberrations within the image. Focal lengths of 2 meters or more are sufficient to 
avoid these aberrations for small laser beams of 1/8 to 1/4 inch (0.3 to 0.6 mm) in 
diameter.
Another important point to consider is the size of the laser beam spot that the 
camera images. As the image size gets smaller, the digitized spatial data 
resolution decreases, reducing the accuracy of the results. Therefore, the 
focusing optics should be chosen so that the beam image is not less than 
20 to 30 pixels in diameter.
The maximum allowable beam image size is dependent upon the camera used. 
The beam image must be contained within the camera's active area and should 
not overlap the edges. For example, this corresponds to a beam image size of 
about 6 mm on the 2/3 inch format CMOS LaserCam-HR sensor. A reduction or 
expansion telescope may be required if these spot sizes cannot be achieved by 
varying the focal length of the optics, or if Near Field diagnostics must be 
performed.
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Set Up Hardware
The Focal Length command inputs the focal length for a lens or focusing mirror 
used in conjunction with the camera for measurement of Far Field values. See 
“Setup > Focal Length” (p. 66) for details.

3.4 Align the Laser and Camera
The Live Video feature on the Home Tab is useful when setting up and aligning 
the laser and camera.

WARNING—LASER RADIATION!
Always avoid eye or skin exposure to both DIRECT and SCATTERED 
radiation, including damage or noise from laser back reflection. See “Safety 
and Compliance” (p. 189) for more information and safety precautions.

The Live Video command switches the BeamView.NET software system from 
displaying images in Start mode (with overlay graphics and calculations) to a 
real-time display in Live Video mode (with no overlay graphics or calculations).
When Live Video mode is On, the View area displays a contour or 3D plot, which 
allows real-time viewing of the camera video.
To choose the Live Video command:
• On the Home tab, select the Live Video command from the toolbar.
• To turn Live Video Off, choose the Stop Capturing command.

3.5 Set Up for Remote Mode
To set up and run a Remote application, follow these general steps:

1. Run the BeamView.NET software and configure settings for the interface you 
want to use.

2. Turn on Remote Mode in BeamView.NET by clicking the Remote Control icon 
in the toolbar for the Home tab. This provides a fast, single-click control to set 
up a connection.

3. Connect a camera, which BeamView.NET then automatically detects.
4. Run the Remote application (such as the Coherent Remote Data Logging 

Utility) and enable the connection.
For more information about configuring and running applications in Remote 
Mode, see “Remote Mode Set Up” (p. 135).
For details about host commands that can be used in a remote interface, see 
“Remote Mode Host Communication Protocols” (p. 145). 
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4 SOFTWARE INTERFACE 
This section describes the various windows and commands for the 
BeamView.NET software, as well as basic settings to capture beam images.

4.1 Main Window
The following splash screen is briefly displayed after the software is launched.  

The splash screen identifies the product name, current version number, and 
copyright information.
The main window shown in Figure 4-2 is then displayed.  

The main window consists of display and control elements similar to most 
Windows applications, along with the following elements specific to the 
BeamView.NET application.

Figure 4-1.  BeamView.NET Splash Screen

Figure 4-2.  Main Window Areas

Tabs and 
toolbars

Title bar

View area

Statistics Divider bar

Status of samples
Camera type

Results area with 
Calculations

Status bar
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Title Bar
The Title Bar displays the software name, version number, and test name (if a 
configuration or session file has been saved or loaded). This area also includes a 
File menu.

Tabs
The Tabs list menus available for the BeamView.NET window, and contain 
commands that allow specific actions to be performed or display dialog boxes. 
These elements provide various controls for such functions as graphics, analysis, 
configuration set-up, etc.

Tool Bar
The Tool Bar consists of various icon buttons, which are small symbols that 
provide quick access alternatives to using menus or keyboard equivalent keys to 
perform various functions. To use a Smart Icon button, move the mouse cursor 
over the icon and click on the button using the left mouse button. To view the 
function of any icon button, place the cursor on the icon and wait momentarily; a 
brief function description is displayed near the icon.
The set of tabs across the top of the BeamView.NET software application include 
the following toolbars.
• Home
• Edit
• View
• Capture
• Analysis
• Setup
• Help

View Area
This graphics area on the left side of the BeamView.NET window shows the 
current beam image, along with cross-section profiles, crosshair cursors, overlaid 
apertures, and other selected fitted or reference profiles and position graphics.
The digitized pixel intensities of the image can be plotted as a contour map in one 
of four different color scales shown in the color scale bar at the left side of the 
image area or as a 3D isometric plot.
A polar wander plot is also available, which plots the location of the centroid for a 
series of samples, visually showing beam wander over time. 
When graphics Zoom is enabled, scroll bars are displayed on the sides of the 
View area. Interactive mouse control of graphics cursors, 3Dplot view angle, and 
pan functions are provided when the mouse cursor is within the View area.

Results Area
This area at the right side of the BeamView.NET window display shows the 
results of selected calculations for the beam image shown in the View area.
The Sample header at the top of the results area reports the sample number, 
current time, and date.
The panel on the right lists Calculations selected.
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When the Stats On command is selected, an area at the bottom of the main 
window is displayed.

Divider Bar
The divider bar allows you to change the relative size of the View area and Result 
area. Click and drag the divider bar to the left or to the right to resize.

Status Bar
The Status bar is located at the bottom of the BeamView.NET window, and 
indicates the current status of key system measurement, as well as configuration 
and operational parameters.

4.2 File Menu
The file menu at the top of the main window includes commands and menus to 
manage tests, configurations, images and results.

4.2.1 Open Test
The Open Test command opens a Test file from a standard Windows folder.
The Open Test command provides selection of previously-saved test session 
files. A saved test session file contains all images that were in the image buffer 
when the file was saved, as well as information about the BeamView.NET 
software settings (buffer, graphics, calculations, pass/fail, units, etc.). 
When a test session file is loaded, the same software settings are changed to 
those specified in the test session file. All images stored in the test session file 
are also loaded into the image buffer.

4.2.2 Save Test | Save Test As
Saving a test session file stores all images currently in the image buffer, as well 
as information about the BeamView.NET system configuration settings (buffer, 
graphics, calculations, pass/fail, units, etc.) to a user-specified file.
Saving data as a test session allows that data to be recalled at a later date, 
maintaining the analysis parameters that were in place when the data was 
captured.
The Save Test command saves the current test session to the current file to a 
standard Windows folder. The default file name extension for the configuration 
files is “.ATS” (Analyzer Test Session).

IMPORTANT!
After you save the first test session, any subsequent Save Test commands 
override the contents of the existing test session file and replaces them with 
the current images and configuration information. If an existing file is 
replaced, the old file cannot be restored.

To save the test session without destroying the existing test session file, use the 
Save Test As command.
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The Save Test As command saves the current test session to a new file to a 
standard Windows folder.

4.2.3 Load/Save Config
A saved system configuration file contains information about the BeamView.NET 
software settings (buffer, graphics, calculations, pass/fail, units, etc.). When a 
saved configuration file is loaded, the same software settings are changed to an 
identical state in which they were originally saved.
The default file name extension for the configuration files is “.ATC” (for Analyzer 
Test Configuration).

4.2.3.1 Load Config Command
The Load Config (configuration) command loads a previously saved system 
configuration from a standard Windows folder.
Multiple configuration files can be stored and recalled to quickly reconfigure the 
BeamView.NET software to other test configurations.

4.2.3.2 Save Config Command
The Save Config command saves the current system configuration to a standard 
Windows folder.
The default file name extension for the configuration files is “.ATC” (for Analyzer 
Test Configuration).

4.2.4 Import/Export
The default file name extension for image files is .”bin” (for BeamView.NET binary 
images).

4.2.4.1 Import Image Command
The Import Image command allows import (recall) of beam image data from 
stored files for reanalysis, display, or data comparison.
The command to import images clears the current buffer in the software. Selected 
images replace any previous images in the current buffer.
Selecting the Import Image command opens a standard Windows folder. Choose 
an image data file from the list, and click Open.

Import File Format
Raw Images can be imported (recalled) from any of several different file formats. 
The standard BeamView.NET formats are Binary and ASCII, but other graphic file 
formats are supported as well, including .bin, .img,  and .png images. Both Binary 
and ASCII include header information. This is used only by the BeamView.NET 
software to properly reload images.
When a file type is selected, the File Name list box displays only file names for 
the selected type.
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NOTICE:
Coherent recommends that you do NOT use the .JPEG file format to import 
images into the BeamView.NET software.

The JPEG format uses 24-bit, Red-Green-Blue pixel values, while the Analyzer 
uses 8-bit, intensity pixel values. Although the 24-bit pixel values can be scaled to 
8-bit values, a valid intensity value cannot be derived from an RGB value. 
An alternate format that provides good compression, portability, and data integrity 
is the Portable Network Graphics (.png) format.

Select Image to Recall
Images can be recalled one at a time, each from an individual file, or select 
multiple files from the file name list using the Windows click-and-drag, click-and 
Shift-click, or use multiple Ctrl-clicks. The selected images are added to any 
images currently in memory, just as if they were captured with the Start Capturing 
command. The sample number changes to reflect the last image loaded.

IMPORTANT!
The Image files contain only data for a single image and no other information. 
The current configuration settings may not match the settings used at the 
time the image was captured.

If you stored a configuration file at the time the image was captured, recall 
that configuration file before importing the raw image.

4.2.4.2 Export Image Command
The Export Image command allows export (storage) of beam images to disk for 
import into other programs, data logging, archival, or later recall and reanalysis.
The Export Image command saves an image data file in a binary image format 
(*.bin) to a standard Windows folder. Click Save.

IMPORTANT!
Export Image file formats contain only the raw image data and no system 
configuration information. If you save an image for future recall, remember 
to store a configuration file under the same name. The configuration file 
should then be loaded before importing the raw image.

Export File Format
When entering the filename, it is not necessary to specify the extension for the file 
type. The correct extension is added automatically.
The BeamView.NET software allows selection of multiple images to export to a 
file. Most file formats allow only one image to be stored in a file.
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When multiple images are selected, the filename is modified by appending the 
Sample number for each selected image. For example, if the filename is specified 
as “TestA.png” and Sample numbers 1, 2, and 5 are selected for export, the 
BeamView.NET software saves three files:

• “TestA1.png”
• “TestA2.png”
• “TestA5.png”

The BeamView.NET Binary image format is the only format that allows multiple 
image to be stored in a single file. So, if the filename is specified as “TestA.bin” 
and Sample numbers 1, 2, and 5 are selected for export, the analyzer saves all 
three images into the single file named “TestA.bin”.

Select an Image to Store
After a file name has been chosen, the Image Select window is displayed and 
automatically highlights the numbered icon for the sample that is currently being 
displayed on the BeamView.NET software.
If that is the only image to be exported, simply click the OK button.

4.2.4.3 Export Results Command
The Export Results command saves a Results file (in a .txt format) to a standard 
Windows folder. Click Save.
The Export Results command allows export (storage) of analysis results data for 
ALL captured samples to disk in an ASCII text format for data logging and 
archival. 
This is a one-way operation because there is no “Import Results” command. If It 
is important to be able to access these results inside the BeamView.NET file 
later, then save the desired images and a configuration file into a special directory 
where the files are not mixed with other data. 

Results File Format
The Result Data file format contains only the calculated results. The Save as type 
list shows file names for the following file types:
• Result Data (*.txt): Stores results & statistics for all captured samples.
• All Files (*.*): Use this file type when you need to display all the files contained 

in a directory.
The Export Results command creates a data file containing the calculations for 
captured images (from the Image buffer) and statistics on all samples (from the 
Sample buffer).
• The first data set contains the calculations for each sample in the Image 

buffer. The data set is numbered 1 through x; in this example, results are 
numbered 1 through 5.

• The second data set contains the statistics on the calculations in the Sample 
buffer and is always numbered 1 through 4. This data set is listed directly 
below the first data set. in the Export Results file.

The example in Table 4-1 shows the results after exporting a data file from 
BeamView.NET and importing it into a spreadsheet.  
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In the data file, samples are separated by a carriage return and a line feed. 
Individual results and pass/fail indicators for each sample in the file are separated 
by tab characters. This file format allows the analysis results to be imported into 
spreadsheet programs.
A calculation taken while the Perform Pass/Fail checking option (Calculations 
dialog box) is enabled displays a result that is followed by a “P” (Pass) or “F” 
(Fail). These designations indicate whether that specific result is inside or outside 
the acceptable test range limits. 
In the example above, there are no entries in the “P/F” column on the far right. 
This signifies the Perform Pass/Fail checking option was turned off for this 
calculation.
The Sample buffer always contains all samples in the Image buffer and, in 
addition, can include samples not in the Image buffer. As a result, you may see 
something similar to the following example (see highlights to compare).
In the example in Table 4-2, the MIN, MEAN, and SIGMA values are correct. 
Based on those values, you know the Sample buffer contains more samples than 
the Image buffer.
To generate statistics based solely on the samples in the Image buffer, remove 
the unwanted samples (that is, samples with no images) from the Sample buffer 
before you export the results:

1. Under the Edit tab, open the Clear Buffer dialog box.
2. Select “Keep Samples that have Images.”
3. Click the OK button.

  

Table 4-1.  Export Results File

SAMPLE DATE TIME
PEAK % 

RESPONSE
P/F

APER. 
DIAMETER 

86.5% (MM)
P/F

Im
ag

e 
B

uf
fe

r

1 “Dec. 19, 2019” “03:39:01 PM” 96.1 P 1.690

2 “Dec. 19, 2019” “03:39:01 PM” 95.3 P 1.690

3 “Dec. 19, 2019” “03:39:02 PM” 95.3 P 1.690

4 “Dec. 19, 2019” “03:39:02 PM” 94.9 P 1.690

5 “Dec. 19, 2019” “03:39:02 PM” 95.7 P 1.690

Sa
m

pl
e 

B
uf

fe
r 1 “MIN” “” 94.9 1.690

2 “MEAN” “” 95.5 1.690

3 “MAX” “” 96.1 1.690

4 “SIGMA” “” 0.4 0.000
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4.2.4.4 Export Profiles Command
The Export Profiles command allows export (storage) of image profile data to an 
ASCII text (.txt) file. The profiles that are stored are the image profiles displayed 
in the View window when Export Profiles is selected.
Reference profiles and fit curves are not stored.
The Export Profiles dialog box provides selection of file names, data types, and 
directory locations in a standard Windows folder.
The Save as type list shows file names for the following file types:
• Profile Data (*.txt): Stores the currently displayed image profiles. See Profile 

Data Format for details on the file structure.
• All Files (*.*): Use this file type when you need to display all the files contained 

in a directory.

Profile Data Format
When profile data is stored, the image intensity information for each pixel are 
stored in a single file, along both X and Y axis profiles.
• The X axis profile is stored first, with each pixel value separated by a comma (,) 

and ending with a carriage return and line feed.
• The Y axis profile is then stored in similar fashion.
As an example, profile data looks similar to:

0,0,0,0,0,1,3,6,13,25, … ,22,17,13,8,4,2,0,0,0,0 
0,0,0,1,2,5,8,12,18,23, … 27,22,16,11,7,4,3,1,0,0

Note that the number of data points in a profile vary, relative to the Capture > 
Resolution settings.

Table 4-2.  Export Results File — Samples NOT in Image Buffer

SAMPLE DATE TIME
PEAK % 

RESPONSE
P/F

APER. 
DIAMETER 

86.5% (MM)
P/F

Im
ag

e 
B

uf
fe

r

1 “Dec. 19, 2019” “03:39:01 PM” 96.1 P 1.690

2 “Dec. 19, 2019” “03:39:01 PM” 95.3 P 1.690

3 “Dec. 19, 2019” “03:39:02 PM” 95.3 P 1.690

4 “Dec. 19, 2019” “03:39:02 PM” 94.9 P 1.690

5 “Dec. 19, 2019” “03:39:02 PM” 95.7 P 1.690

Sa
m

pl
e 

B
uf

fe
r 1 “MIN” “” 1.6 1.690

2 “MEAN” “” 39.1 1.690

3 “MAX” “” 96.1 1.690

4 “SIGMA” “” 22.3 0.000
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4.2.5 Print Set-Up
The Print Set-Up command displays a standard Windows print dialog box.
This command allows you to select a Windows printer from the list of installed 
printers, as well as select options for printing. Use this dialog box to verify (or 
modify) printing parameters.
Click OK to save the currently-displayed printing parameters.

4.2.6 Print Report
The Print Report command prints a report, current image, results, or saves a 
report to a .PDF file.
Selecting the Print Report command displays the following dialog box:  

NOTE:
The report is set by default to a black background on the image area to better 
display the laser image. Click the checkbox to select a White Background to 
safe ink when printing.

Depending on the source you select for the report—Report or BeamView.NET 
Window (Screen shot)—a different menu displays when you click the OK button 
in the Report Setup dialog box.
Selecting Report as the source then displays a Report that you can then:
• Click the Save button to store a .pdf version of the report to a location that is 

selectable by the user.  
• Click Print on this menu to send the report to the printer previously selected on 

the Print Setup menu.This prints a single-page report that contains both the 
image and user-defined calculations.

A sample report is shown in Figure 4-4:
To capture a screen shot, press 'Ctrl' + 'Alt' + 'PrtScr' and paste into the 
application of your choice.

Figure 4-3.  File > Print Report Set-Up Dialog Box
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4.2.7 Test Information
The Test Information command displays a dialog box where you can enter 
descriptive information about the test session, as shown in Figure 4-5:  

The Test Information dialog box includes a title, a serial number, an operator 
name, a comment field, and a workstation number.

Figure 4-4.  Print Report

Figure 4-5.  File Menu > Test Information
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Any test information that is entered is displayed on the right side of the display 
screen, below the calculation Results area. All fields are optional, and only those 
that have information are displayed.
When a Test Session is saved to disk using either the Save Test or Save Test As 
menu, the test information is also stored. A subsequent recall of the test session 
(Open Test) then loads and displays that test information, along with the image 
and result data from the test session. 
The only information that is remembered by the BeamView.NET software after 
exiting and restarting it is the workstation.

4.2.8 Exit
The Exit command closes the BeamView.NET program.

4.3 Home Tab
The Home Tab shown in Figure 4-6 lets you select the sample, start and stop 
capture, as well as whether to include crosshair, aperture, profiles or reference 
positions for the sample. You can also select the level of zoom and coloring style.  

The commands available in the Home tab include:
• Operations:

• Start Capturing Samples
• Stop Capturing Samples
• Live Video — Capture and display image samples s fast as possible
• Select the First Sample, Previous Sample, Next Sample, or Last Sample

• Enable/Disable Profiles - Turn properties for each on or off for:
• Crosshair
• Aperture
• Profiles
• Reference Position
• Inclusion
• Crosshair Location — Drop-down menu to select:

• User Coordinates
• Peak
• Centroid

Figure 4-6.  Home Tab
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• Plot Type — Set the plot type:
• Contour Plot
• 3D Plot
• Polar Plot

• Screen
• Change Zoom — Adjust the zoom level.
• Coloring Style — Change the plot between colors and black-and-white

• Communications
• Remote Control — Enable or disable

These are described in more detail in “Analyze Calculations” (p. 87). For an 
example about remote data logging, see “Remote Data Logging Utility” (p. 139).

4.4 Edit Tab
The Edit Tab shown in Figure 4-7 lets you select the current sample displayed, 
copy the view plot or selected results to the clipboard, and clear the image data 
buffer.  

The Edit tab includes the following options. Selecting the commands displays a 
dialog box for each:

4.4.1 Edit > Sample Number
This command lets you select a specific image sample to display.Enter the 
sample number in the dialog box shown in Figure 4-8:  

Figure 4-7.  Edit Tab

Figure 4-8.  Sample Number
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4.4.2 Edit > Clear Buffer
This command clears the captured image samples or select buffer properties. 
The options listed in the dialog box shown in Figure 4-9 include:
• Keep Samples that have Images
• Keep Samples marked “Saved”
• Delete Samples marked “Saved”
• Clear all Samples  

4.5 View Tab
On the View Tab (shown in Figure 4-10), you can select the level of zoom, display 
calculations, statistical results, and/or test results. Also, you can configure 
crosshair and various profile settings.  

The View tab includes the following options:
• Zoom
• Display
• Profiles

4.5.1 View > Zoom Levels
Select a zoom level from the drop-down menu.

Figure 4-9.  Clear Buffer

Figure 4-10.  View Tab
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4.5.2 View > Display 
This command sets the fit profile properties and turn the display on or off in the 
main window of the View Tab for:
• Calculations—The panel shown in Figure 4-11 on the right of the main window 

is now populated with the following calculations:
• General calculations
• Ellipticity
• Gaussian Fit
• Aperture Uniformity
• Image Uniformity
• Flat Top
Click the up or down arrows to display or hide each section.  

• Statistics—The same categories listed for Calculations are displayed in the 
bottom panel of the main window, shown in Figure 4-12. 
• General calculations
• Ellipticity
• Gaussian Fit
• Aperture Uniformity
• Image Uniformity
• Flat Top
Click the up or down arrows to display or hide each section.  

Figure 4-11.  View Calculations
56



Software Interface
• Test Information — Data is displayed under the Results area, shown in 
Figure 4-13. For more information, see “Test Information” (p. 52).  

Figure 4-12.  View Statistics

Figure 4-13.  View Test Information
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4.5.3 View > Profiles
Set fit profile properties for the following:
• Plot Type
• Crosshair
• Profiles
• Reference Profiles
• Fit Profiles
Each of these are described in the sections that follow.

4.5.3.1 View > Plot Type
Set the image plot type properties in the dialog box shown in Figure 4-14:

• Contour  

The options for the Color Scaling under Contour include:

• Fixed
• Scale to Peak
• Low intensity
• High intensity
The options for the Color Style under Contour include:

• Sharp 17
• Smooth
• Gray Scale
• Shaded Bands

• 3D  
The options for the Type of Plot Construction for image displays under 3D, 
shown in Figure 4-15, include:

• Transparent Wire
• Hidden Wire
• Solid Wire

Figure 4-14.  Image Display Plot Type — Contour
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The options for the Movement for the Viewing Angle under 3D include:

• Stationery
• Counter Clockwise
• Clockwise
The options for the Color Scaling under 3D include:
• Fixed
• Scale to Peak
• Low intensity
• High intensity
The options for the Color Style under 3D include:
• Sharp 17
• Smooth
• Gray Scale
• Shaded Bands

• Polar
The options for Plot points, shown in Figure 4-16, include:  
• Centroid 
• Peak

Figure 4-15.  Image Display Plot Type — 3D Plot
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The options for Plot Center include:

• User Coordinate
• Mean Centroid/Peak
• Current Centroid/Peak
• Center of Image
• Reference Position
The options for Polar Plot Objects include:
• Mean location
• Center location
• Current sample
• Passing samples
• Failing samples
The options for Object color for a Polar Plot include:
• White
• Red
• Green
• Magenta
• Yellow
• Blue
• Cyan

Figure 4-16.  Image Display Plot Type — Polar 
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4.5.3.2 View > Crosshair
The Crosshair feature is commonly set to track the centroid of the beam. This 
shows the profiles set along the crosshair, as in the example in Figure 4-17.  

The options for Position for the Crosshair include:
• User Coordinate
• Peak
• Centroid

For the crosshair to be most useful, set the angle setting to either user angle or 
ellipticity.

• User angle: Setting this to 0 degrees displays the crosshair exactly 
horizontal and vertical in the image.

• Ellipticity: If the laser is an elliptical beam, the angle displays the profile 
along the long and short axis of the beam.

The options for Color for the Crosshair include:
• White
• Red
• Green
• Magenta
• Yellow
• Blue
• Cyan

Figure 4-17.  Crosshair Properties
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4.5.3.3 View > Profiles
Set profile properties as shown in the dialog box in Figure 4-18  

The options the Selected Profile include:
• Fixed
• Scale to Peak

The options for Color for the Profile include:
• White
• Red
• Green
• Magenta
• Yellow
• Blue
• Cyan

The options for a Line for the Profile include:
• Solid
• Dash 1
• Dash 2

4.5.3.4 View > Reference Position 
Set reference profile properties as shown in Figure 4-19.  

Figure 4-18.  Profile Properties

Figure 4-19.  Reference Position Properties
62



Software Interface
The options for a Reference Profile include:
• Current Profile
• Gaussian Fit
The options for Color for the Reference Profile include:
• White
• Red
• Green
• Magenta
• Yellow
• Blue
• Cyan
The options for a Line Style for the Reference Profile include:
• Solid
• Dash 1

4.5.3.5 View > Fit Profiles
Set fit profile properties as shown in Figure 4-20.  

The options for a Fit Profile include:

• Gaussian Fit
The options for Color for the Fit Profile include:

• White
• Red
• Green
• Magenta
• Yellow
• Blue
• Cyan
The options for a Line Style for the Fit Profile include:
• Solid
• Dash 1

Figure 4-20.  Fit Profiles Properties
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4.6 Capture Tab
On the Capture tab shown in Figure 4-21, you can choose to show or delete the 
Collection Map, enable CW or pulsed capture operations, select trigger 
operations, set the resolution and depth, as well as configure the storage buffer 
for samples. You can also specify the exposure time.  

The sections for the Capture tab include:
• Background Map
• Trigger Mode (Source)

• CW (Continuous Wave)
• Pulsed

• Capture Settings
• Capture/Trigger
• Resolution
• Buffer

• Exposure Time Settings
See “Capture A Beam Image” (p. 71) for details and instructions for settings.

4.7 Analysis Tab
The Analysis tab shown in Figure 4-22 lets you configure settings for analysis 
calculations, pass/fail options, overlay apertures, and other profile information.  

For details about how to set up and use options this toolbar, see “Analyze 
Calculations” (p. 87).

Figure 4-21.  Capture Tab

Figure 4-22.  Analysis Tab
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4.8 Setup Tab
In the Set-up Tab shown in Figure 4-23, identify a camera, adjust properties for 
the selected camera, define input power/energy for calibrations, set the input 
optical magnification scale, input Far Field optical focal length, and set password 
protection for configuration settings.  

There are three sections in the Setup Toolbar:
• Camera
• Settings

• Calibrate Power
• Scale Factor
• Focal Length
• Remote Mode

• Configuration Protection (Password)

4.8.1 Setup > Camera
For information about how to connect one or more cameras, see “Set Up 
Hardware” (p. 31).
After a camera is connected, the BeamView.NET software automatically 
recognizes the camera. See “Software Settings for Cameras” (p. 35) for details.

4.8.2 Setup > Calibrate Power
The Calibrate Relative Power/Energy command provides entry of a power/energy 
value as a “base” power/energy level. 
The power /energy calculation sets the total summed intensity of all pixels in the 
next sample captured to this value. All subsequent samples are calibrated with 
this factor for Power/Energy and Peak Power/Energy Density (Fluence) 
calculations. 
To choose the Calibrate Relative Power/Energy command, go to the Setup menu 
>> Calibrate Power. Select the Calibrate Relative Power/Energy command to 
open the following dialog box, shown in Figure 4-24:  

Figure 4-23.  Setup Tab
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The Power Value function is available in the Calibrate Relative Power dialog box. 
This function allows you to input the power/energy calibration value, which is 
entered numerically. 
After entering the value, click Finish the displayed instructions to perform the 
calibration operation

4.8.3 Setup > Scale Factor
The Scale Factor command lets sets the optical magnification scale factor by 
defining a scaling factor to multiply the camera pixel size.
The Scale Factor settings are defined in the dialog box shown in Figure 4-25:  

The Scale Factor command provides input of a scaling factor to multiply the 
camera pixel size to compensate for magnification or de-magnification of the 
laser beam by various optical systems, such as a magnifying lens.
If there are optics (either expanding lens or a reducing lens) in the beam path, 
you can set a Scale Factor into this setting to adjust your calculations. For 
example, if you enter a scale factor of 6 into the BeamView.NET software, and it 
makes all of the corrections to match the calculations to the actual beam size.

4.8.4 Setup > Focal Length
In the Focal Length dialog box, define the focal length value for a lens or focusing 
mirror being used with the camera for Far Field measurements (such as 
Divergence or Pointing Stability).
For all Far Field calculations to be correct, the focal length of the optic being used 
must be entered in the Focal Length function.
When you select Focal Length, the dialog box shown in Figure 4-26 is displayed:  

Figure 4-24.  Setup >> Calibrate Power

Figure 4-25.  Setup > Scale Factor 
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4.8.5 Setup > Remote Mode
Remote Mode lets you set or disable a TCP/IP or serial (RS-232) connection. See 
“Remote Mode Set Up” (p. 135) for detailed information about Remote Mode.

4.8.6 Setup > Configuration Protection (Password)
This an option only if you need the added security and is not considered a 
general set-up task.
To enable Password protection:

1. Click the Lock icon. The dialog box shown in Figure 4-27 is displayed:  

2. Enter a password, and click OK. The message shown in Figure 4-28 is 
displayed.  

Figure 4-26.  Setup — Focal Length

Figure 4-27.  Configure Password Protection

Figure 4-28.  Test Configuration Locked
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4.9 Help Tab
The Help tab is displayed as shown in Figure 4-29:  

In the Information area:
• Using Help — displays contents of the Help file
• Keyboard shortcuts — see “Keyboard Shortcuts” (p. 69)
• Background Warning — displays Help information about background warnings
In the About area, you can check:
• System Status shown in Figure 4-30 — Details about the host PC.  

• About shown in Figure 4-31 — View license and copyright information for the 
software.  

Figure 4-29.  Help Tab

Figure 4-30.  Help — System Status

Figure 4-31.  Help — About BeamView.NET
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4.10 Controls for the User Interface
Within BeamView.NET are a functions offered by the mouse cursor, keyboard 
shortcuts, and commands/menus.

4.10.1 Mouse Cursor
The BeamView.NET software utilizes a mouse-driven cursor for selection of 
menus and commands, as well as manipulation and control of various graphics 
and result display functions.
These different cursor functions are dependent on the position of the mouse 
within, or over, specific areas of the Windows display.
• When the mouse is moved over menus, command lists, dialog boxes, or icon 

buttons, it retains its normal “arrow” configuration and functionality.
• When the mouse is moved within the View Area, it changes to a “crosshair” 

cursor. This allows you to manipulate and position various graphics and data 
display functions.

Details about the cursor function for various functions are provided in later 
sections.

4.10.2 Keyboard Shortcuts
Table 4-3 lists shortcuts that provide keyboard access to commonly used 
operations:  

Table 4-3.  Keyboard Shortcuts

OPERATION KEY DESCRIPTION

Background Subtraction <Ctrl>+<B> Open the Background Map Collection dialog window

Calculation/result Configuration <Ctrl>+<R> Open the Calculations dialog window

Calculations On/Off <F7> Toggle calculation result display On or Off

Centroid Location <Shift>+<F6> When in Stop mode, move image crosshair to the centroid 
location

Crosshair Display <F5> Toggle image crosshair display On or Off

Crosshair Movement Arrow Keys When in Stop mode, move image crosshair position

CW/Pulsed Selection <Shift>+<F7> Toggle capture settings between CW and Pulsed modes

Goto Sample Number <Ctrl>+<G> Open dialog window allowing entry of Sample number to 
display

Help <F1> Opens the Help file

Image Next <PgUp> When in Stop mode, go to the next sample

Image Previous <PgDown> When in Stop mode, go to the previous sample

Inclusion Area Adjustment <Shift>+<F8> Open the Inclusion area dialog window

Live Video <F9> Toggle Live Video image display On or Off

Peak Position <Shift>+<F5> When in Stop mode, move image crosshair to the peak 
intensity location

Profile On <F2> Toggle profile display On or Off
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4.10.3 Choosing Commands
Like most Windows applications, the BeamView.NET commands may not always 
be functional or available in some modes of operation or configurations. 
Commands that are not available are dimmed in the user interface.
To choose a command or menu item from an open menu list, use one of the 
following methods:
• Move the cursor with the mouse or arrow keys over the desired command or 

item name, and click the left mouse button or Enter key.
• Type the underlined letter (hot key) in the command or item name.
• Type the key equivalent shown to the right of the command or item name.
If a command function is currently active, a check mark is displayed in front of the 
command or item name. 
If a command has a sub-menu associated with it, a right arrow mark (“>”) is 
displayed after the command or item name.
If the command has a dialog box associated with it, the box is displayed when the 
command is selected.

4.11 Next Steps
Go to “Capture A Beam Image” (p. 71) for information about settings for 
calculations and how to capture a beam image.

Reference Position On <F4> Toggle reference position On (crosshair location) or Off 
(upper left corner)

Reference Profile <F3> Open the Reference Profile dialog window

Start/Stop <F12> Toggle between Start and Stop modes

Statistics On/Off <F6> Toggle display of statistics On or Off

Zoom Level <F8> Zoom in with each key press. The last zoom level returns to 
the 1x zoom level.

Test Information <Ctrl>+<I> Test Information dialog

Table 4-3.  Keyboard Shortcuts (continued)

OPERATION KEY DESCRIPTION
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5 CAPTURE A BEAM IMAGE
There are several methods described in this section to capture a beam image 
using the BeamView.NET software.
Capturing desired samples is important in measurement instrumentation. The 
Capture toolbar section lets you collect a Background Map, identify the source of 
the beam image, and define settings (including Trigger options).

IMPORTANT!
It is recommended that you first collect a Background Map, which identifies 
background noise. That noise map is subtracted from all subsequent beam 
images before image analysis is performed. See “Background Map” (p. 73) 
for more information.

5.1 Image File Formats
The BeamView.NET software currently supports a variety of Graphical formats as 
well as Image file formats. 

5.1.1 Graphic File Formats
Almost any graphics package supports at least one of the following file formats. 
Some image analysis software imports some of these formats. The intended use 
of the image should help determine which format to use.
A BeamView.NET software image file can be imported into almost any other 
graphical application.
The graphic file formats are listed in Table 5-1:  

The .jpg format performs compression and is good for image display, but that 
format alters the data and is NOT suitable if further image analysis is needed.
The .bmp and .png formats perform compression and leave the data intact, so 
they are good for both display and further image analysis. Some analysis 
software packages allow direct importation of .bmp formats.

Table 5-1.  Graphic File Formats

FILE EXTENSION FILE FORMAT

.bmp Bitmap Compressed or Uncompressed

.jpg JPEG, JFIF

.png Portable Network Graphics
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5.1.2 Analysis File Formats
Two file types, Binary and ASCII, store the raw data only. No header information 
is included. The primary purpose for these file formats is to export for further 
analysis by other programs, or for later recall and analysis by the BeamView.NET 
software.
If the file is being stored for later recall, Coherent strongly recommends that you 
also store a BeamView.NET software Test Configuration file under the same 
name. That way, the capture settings for the image can be restored before the 
image is recalled.
The ASCII image file format is the only format guaranteed to preserve the 
integrity of every data point in the image, and therefore is best suited when further 
analysis is to be performed on an image.
The ASCII format is a comma delimited file, and can be imported directly into 
spreadsheets or mathematical software programs.

5.1.2.1 ASCII Image (*.IMG; I*.*)
In ASCII image file format, each image pixel value may require up to 5 bytes (one 
for each digit of the value), plus a comma to separate pixel values. Each video 
row in ASCII format must be separated by a carriage return and line feed. It is 
possible for an ASCII format file to be four times larger than a binary format file of 
the same image.
The advantage of an ASCII format file is that it may be loaded directly into a word 
processor or spreadsheet program, whereas a binary file cannot. When this file 
type is selected, the file list displays all files that end in .IMG.

5.2 Capture a Beam Image
In the Home Tab, the following commands allow you to quickly capture, analyze, 
and display of beam image data:
• Start a Capture
• Stop Capture
• Live Video (real-time display)
• These icons are displayed in color on the toolbar.  

Figure 5-1.  Home > Start and Stop Capturing
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5.2.1 Start a Capture
The Start Capturing command switches the BeamView.NET software from either 
Stop Capturing mode or Live Video mode to a Start mode. In Start mode, there is 
capture, analysis, and display of beam image data.
To choose the Start Capturing command:
• From the Capture toolbar, select the Start Capturing icon.
• When Start is On, a green icon is displayed at the top of the window.
To turn Start Capturing Off, click the Stop Capturing icon. The BeamView.NET 
software then switches to Stop mode.

5.2.2 Stop a Capture
The Stop Capturing command switches the BeamView.NET software from either 
Start Capturing mode or Live Video operation to a Stop mode. All data capture, 
analysis, and display of beam image data is halted.
To choose the Stop Capturing command:
• From the Capture toolbar, select the Stop Capturing icon.
• When Stop is On, a red icon is displayed at the top of the window.
To turn Stop Capturing Off, click the Start Capturing icon. The BeamView.NET 
software then switches to Start mode.

5.2.3 Real-Time Display in Live Video
BeamView.NET offers a feature that is useful when setting up and aligning the 
laser and camera. See “Align the Laser and Camera” (p. 41) for details.
The Live Video command switches the BeamView.NET software from displaying 
images in Start mode (with overlay graphics and calculations) to a real-time 
display in Live Video mode (with no overlay graphics or calculations).

5.3 Background Map
The Background Map command collects the noise level of the camera and 
creates a background noise map for that particular camera. 
This Background Map can be used to perform a pixel-by-pixel intensity 
Background Map noise subtraction from all subsequent beam images captured, 
depending upon whether the background subtraction mode is On or Off. Setting a 
Background Map ensures that calculations are correct by eliminating fixed-pattern 
environmental or camera noise and ignoring bad camera pixels.
Before collecting a Background Map, reduce background noise as much as 
possible. See “Background Noise Is Too High” (p. 174) for details.
The following options are displayed in the Background Map section of the 
Capture toolbar: 

• Collect Map: Opens the Collect New Background wizard.
• On: Enables (turns ON) the subtraction of the existing Background Map.
• Off: Disables (turns OFF) the subtraction of the existing Background Map.
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• Show Map: Displays the Background Map.
• Delete Map: Removes the current Background Map.

IMPORTANT!
Before collecting a Background Map, sources of background noise must be 
reduced as much as possible. See “Background Noise Is Too High” (p. 174) 
for more information.

This Background Map is used to perform a pixel-by-pixel noise subtraction from 
all subsequent beam images captured before image analysis is performed. 
(Background subtraction mode can be set to On or Off.) The identified noise is 
not added into a captured image nor into the calculations.
The centroid and crosshairs in the image may not track correctly if a Background 
Map was not set in advance.

5.3.1 Capture > Collect a Background Map
To collect a Background Map:

1. Block (cover) the beam at or near the source such that the camera sensor 
detects no laser light.

2. From the Capture toolbar, go to the Background Map section and select 
Collect Map.
If there is currently no Background Map for the selected camera, the message 
shown in Figure 5-2 is displayed:  

3. Click Yes to proceed.
The Collect New Background wizard is displayed, as shown in Figure 5-3:  

Figure 5-2.  Capture — No Background Map Message
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IMPORTANT!
If you have not done so already, first block the laser beam at its source before 
you proceed.

4. Click Next, and the wizard displays the following:  

5. Enter a Background Bias Value in the dialog box. The range is from 0 to 1966.
This provides additional digital levels of subtraction to reduce the effects of 
random video noise. 
The software automatically determines a recommended bias value for the 
selected camera, but you can change that value as desired. The Bias factor 
depends on the type of LaserCam-HR camera connected to the system, and 
varies depending on whether the camera has a 10-bit output or a 14-bit output. 

6. Click Next, and the dialog box lists the bias factor that you entered.
7. It is recommended that you turn the background warning indicator on. To do 

so, click the checkbox to Enable Background Noise Level Monitoring.  
The BeamView.NET software continuously monitors the background noise 
level during image capture, and issues a warning if that noise level is 
significant enough to affect calculation accuracy (see “Display a Warning 
Message” (p. 175)).

Figure 5-3.  Capture—Collect a Background Map Wizard

Figure 5-4.  Capture—Background Map Bias Value
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8. Click Finish, and the Main Window with the crosshair is again displayed.
The BeamView.NET software acquires a Background Map by capturing and 
averaging a set of 16 images.

5.3.2 Test the Background Map
To study the effects of the Background Map and Bias level:

1. Configure the BeamView.NET software to display a contour map:
a.) From the View Menu, select Plot Type command.
b.) In the dialog box, select the Contour tab.
c.) Select the Scale to Peak scaling function.
d.) Click OK.

2. Block the laser beam at the source.
3. In the Home toolbar, click Start Capturing and monitor the View area.

• If the Background Map and Bias level are set correctly, only a few 
randomly scattered points of noise should be seen.

• If more than just a few points of noise are seen, click Stop Capturing and 
take a second Background Map. This time, increase the Bias level by one, 
then reevaluate the noise in the View area.

When finished, the BeamView.NET software displays the averaged Background 
Map in the View area. All subsequent images captured with BeamView.NET now 
have this Background Map subtracted.
The background subtraction can be disabled or re-enabled. In the Capture 
toolbar, select On or Off in the Background Map section.
• If no Background Map was previously stored, the background subtraction 

remains disabled (Off) and indicates that no map is available.
• If the background subtraction feature is disabled (turned Off) and a 

Background Map has been collected, BeamView.NET retains the Background 
Map, but does not subtract it from the subsequent captured images.

Figure 5-5.  Capture—Complete Background Map
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Switching the background subtraction On means the BeamView.NET software 
uses the already-stored Background Map and subtract it from subsequent images 
collected. If a new Background Map is collected, it replaces the previously-stored 
Background Map. An updated map can be collected at any time if you feel the 
background level has changed.
When changing resolutions or cameras, the BeamView.NET software requires 
capture of a new Background Map.

5.4 Capture > Capture/Trigger
The BeamView.NET software provides a number of features and options to 
control the timing of sample capture for both CW (Continuous Wave) and Pulsed 
laser applications. See details about these settings in “Capture Tab” (p. 64).

5.4.1 Capture/Trigger: Source
When you select Capture/Trigger in the Capture Settings section, the following 
dialog box is displayed:  

The following Capture modes are available, with a radio button to select either 
CW or Pulsed mode.

CW (Continuous Wave)
The CW (Continuous Wave) button switches the software from Pulsed source 
capture to CW source capture mode.
• To choose the CW mode, choose the radio button for CW button.
• To turn CW mode Off, choose the radio button for Pulsed.

Pulsed
The Pulsed button switches the BeamView.NET software from CW (Continuous 
Wave) source capture to Pulsed source capture mode.
• To choose Pulsed mode, choose the radio button for Pulsed.
• To turn Pulsed mode Off, choose the CW button.

Figure 5-6.  Capture Trigger: Source in Status Bar
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5.4.1.1 Capture/Trigger: Edge
If the source selected is Pulsed, the dialog box displays additional selections to 
select Rising or Falling Edge and enter a Trigger Delay:  

1. Select either a Rising or Falling Edge.
2. Enter a Trigger Delay (in seconds).
3. Click OK. 

5.4.1.2 Capture/Trigger: Trigger Option
From the drop-down menu, select a Trigger option:

• External
• Auto Trigger

NOTE:
Trigger selection is ONLY active for Pulsed mode operation.
No trigger signal is required in CW (Continuous Wave) operation, so the 
Trigger drop-down menu is not available for CW. 

5.4.1.3 Capture/Trigger: Capture Timing
From the drop-down menu, select an option from the Capture drop-down menu. 
Click OK when finished.

Continuously
Beamview.NET continuously captures beam images in a repetitive process until 
the user intervenes by selecting the Stop function, or the image storage count is 
achieved.

Figure 5-7.  Capture > Capture/Trigger Pulsed Settings
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The speed of capture depends on the computer being used, image capture 
resolution, number and type of calculations being done, and whether calculations 
are being done after each image capture or after all specified images have been 
captured.

On Time Interval of
Beamview.NET continuously captures beam images only after a user-specified 
time interval has passed. The units for this time interval setting can be adjusted 
by selecting the Analysis menu and the Units menu item.
This process repeats until the user intervenes by selecting the Stop function, or 
the image storage count is achieved.
When this option is selected, the dialog box displays a field for “Interval” - enter a 
user-defined value in seconds.

On Key Press
Beamview.NETcaptures beam images only after the <Enter> or <Spacebar> 
keyboard keys have been pressed, or the OK button in the Capture Image dialog 
box is selected.
This process repeats until the user intervenes by selecting the Cancel function in 
the Capture Image dialog box with the mouse, or the image storage count is 
achieved.

5.4.2 Capture with Trigger (Pulsed Mode)
To capture samples, a trigger signal is often used. This signal tells other devices 
to either generate or capture data at a specific time.
Most camera types have a small period of vulnerability, between one image and 
the next, where the incident light on the camera detector is not being recorded or 
is otherwise invalid (analogous to a camera shutter being closed).
• For CW (Continuous Wave) systems, this period is not important.
• For Pulsed laser systems, the laser pulses must either not be generated during 

the period of vulnerability, or the image generated during the vulnerable period 
must be disregarded.

The triggering configuration used is especially important in Pulsed laser 
applications where these signals are used to fire and/or detect the output laser 
pulse.

NOTE:
Trigger selection is ONLY active for Pulsed mode operation.

This section describes how to select a trigger to capture beam information. See 
“Connect a Camera Using an External Trigger” (p. 34) for instructions about set 
up and connecting a cable specific to the trigger function.

5.4.2.1 Triggering Methods
To take Pulsed measurements using the LaserCam-HR, the camera and software 
offer two triggering methods that can be used to capture images.
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• External
• Auto Trigger
The Auto Trigger and Trigger Delay features do not work well for capturing single-
pulse lasers. In the case of a single pulse laser, the timing between the trigger 
signal and the laser firing needs to be adjusted to allow the camera to capture the 
first pulse while still accounting for the 150 μs delay in the camera. Often a pulse 
generator or signal delay box can be used to help set this up.

5.4.2.2 External Trigger Mode
External Trigger mode allows the camera to synchronize its capture period to the 
pulses being fired by the laser.

The software sends a voltage signal (typically a TTL pulse from the laser) to 
the camera to synchronize its capture period to the timing of the laser.

In External Trigger mode, the software disregards input trigger signals that 
occur during the period of vulnerability.

To access the Trigger Delay feature:

1. Go to the “Capture > Capture/Trigger” menu.
2. Select the radio button for Pulsed.
3. Select the radio button for a Rising or Falling Edge.
4. Under Trigger, Select “External” from the drop-down menu. The dialog boxes 

changes to display a box where you enter a value for the delay.  

5. Enter the delay value in microseconds. This is the time from the hardware 
trigger until exposure begins. The allowable range is 0 to 100,000,000 (one 
hundred seconds).

The LaserCam-HR external trigger circuit has a built-in delay of 150 μs. This is 
something that is inherent with the CMOS camera and there is no way the delay 
can be shortened through the camera set-up.
For this camera to operate correctly with an external trigger, the trigger signal 
needs to occur at least 150 μs before the laser pulse hits the camera. The 
LaserCam-HR has a 10 ms integration time, which means the camera is “open” to 
capturing pulses for 10 ms after the trigger delay.

Figure 5-8.  Capture — Set Trigger Delay
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As long as the trigger delay of 150 μs has passed, the pulse can hit the camera 
anytime within the next 10 ms and be captured correctly.
Figure 5-9 shows a timeline for the trigger period.  

This 150 μs delay may be an issue with some laser systems. On many lasers, the 
trigger signal and laser pulse may not match up with this 150 μs delay.

5.4.2.3 Trigger Set-Up Example
For example, if a user has a laser that triggers only 50 μs before the pulse fires, 
the LaserCam-HR triggers but does not capture any images. That is because the 
laser is firing during the 150 μs delay, so nothing is captured by the camera. 
In this situation, the user must add some delay, either into the trigger signal or 
into the actual firing of the laser. If, for example, a 200 μs delay is added to the 
time between the trigger signal and the laser firing, it should work correctly. 
This can often be done through external delay boxes or signal generators. If the 
LaserCam-HR is being used in Pulsed mode and is capturing only blank images, 
trigger timing may be the problem.
The BeamView.NET software added a feature that helps in cases where the 
trigger delay is causing issues, called the “Trigger Delay” setting. This feature 
uses the first trigger signal to capture the second laser pulse. 
The Trigger Delay feature may be useful in cases such as described here, where 
the laser is firing only 50 μs after the trigger signal is sent to the camera. Due to 
the 150 μs delay, this usually results in the camera not capturing anything. If, 
however, a longer than normal delay is added between the trigger signal and the 
second pulse, the camera does capture a second pulse while triggering on the 
first trigger signal.
A user has a pulsed 10 Hz laser with an external trigger that sends a trigger 
signal about 50 μs before the laser fires a pulse. If hooked up directly to the 
external trigger connection on a LaserCam-HR camera, this results in the camera 
triggering but not capturing any images because the laser pulse is firing during 
the 150 μs delay period.
If the time between the trigger and the laser pulse cannot be adjusted on the 
laser, the trigger delay on the camera can be lengthened to correctly help capture 
the pulse.

Figure 5-9.  Capture — Trigger Delay Timeline
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In this example, one possible solution is to set up a lengthy delay between the 
trigger signal and the second laser pulse. Because the camera has a 10 ms 
integration time and the laser is firing one pulse every 100 ms (1/10 Hz), a user 
could set a trigger delay of 95 ms in the BeamView.NET software. With a 95 ms 
setting, the laser sends a trigger signal and then, 50 μs later, the laser fires.
The result is that the first pulse is ignored and 95 ms passes before the camera 
starts its integration time. The laser then triggers again, fires another pulse, and 
the camera catches this second pulse. This second pulse is taking place 
approximately 5 ms into the 10 ms integration time and is captured correctly.

5.4.2.4 Set a Trigger Delay
The amount of delay can typically be determined by using an interval slightly 
shorter than the time between laser pulses. For a 10 Hz laser (100 ms between 
pulses), a 95 ms delay could be used. For a 50 Hz laser (20 ms between pulses), 
a 15 ms delay could be used. This sets enough delay for the camera to start its 
integration period before the next pulse is fired.
The 10 ms capture time on the LaserCam-HR also sets the camera's maximum 
rep rate that can be used for pulsed measurements. For a 10 ms capture window, 
the inverse is 100 Hz.
This means the camera can have up to 100 of these 10 ms capture periods per 
second and, therefore, can capture single-pulse images for rep rates up to 
100 Hz. 
This does not mean the software captures images at 100 Hz. The update rate of 
the software is still limited to approximately 10 to 20 Hz, depending on the 
computer speed and the resolution being used. 
However, the camera can capture pulses at up to 100 Hz without getting multiple 
pulses into the same image. At 200 Hz, the camera picks up two pulses in each 
capture period, which does not give an accurate image of each pulse. This 10 ms 
capture period limits the camera to rep rates of 100 Hz while capturing only single 
pulses in each image. If working at rep rates above 100 Hz, the camera can be 
put into CW mode, which should capture correctly.

5.4.3 Auto Trigger Mode
The Auto Trigger mode is a simple setting to capture pulses that does not require 
any trigger signals or need to synchronize the camera to the laser. Therefore, it is 
often used for set-up and alignment.

The software uses a set intensity threshold to determine if it captures or 
discards a pulsed image.

Auto Trigger is similar to the trigger used in oscilloscopes. Image capture 
occurs when the intensity level on any pixel in the video image is greater than 
a user-defined level.

Using this trigger method captures video images that have a pixel intensity above 
a user-defined level. Note that % response refers to a percentage level from 
0 to 100 percent of the maximum intensity.
To select Auto Trigger:
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Capture a Beam Image
1. Go to the Capture tab, select Capture/Trigger from the Capture Settings area 
in the toolbar, and the following dialog box is displayed: 

2. Select the radio button for Pulsed.
3. Select the radio button for a Rising or Falling Edge.
4. Under Trigger, Select “Auto Trigger” from the drop-down menu. The dialog 

boxes changes to display a Qualifying Level:  

This feature allows the user to define a pixel intensity threshold that 
BeamView.NET uses to determine whether to capture an image or discard it. If a 
laser pulse hits the camera and causes a certain number of pixels to exceed the 
set intensity level, that image is captured and saved into the BeamView.NET 
software.
Auto Trigger is suggested for first time set-up if the repetition rate is greater than 
approximately 10 Hz. After some images are captured, using more advanced 
triggering methods can improve capture performance.
• Note that % response (Qualify Level box) refers to a percentage level from 

0 to 100 percent of the maximum intensity. 
• The intensity threshold level can be adjusted to any value between 0 and 

100% to qualify whether an image is kept or not. Start with an intensity value 
of approximately 50%.

It is recommended to not use the Auto Trigger mode of capture for Pulsed laser 
sources below 10 to 20 Hz.
One drawback to the auto-trigger method is that not all pulses reaching the 
camera are captured. Due to the timing of the capture period on the 
LaserCam-HR camera, it is not possible for the camera to capture every pulse 
when working in auto-trigger mode.
Generally, this is not an issue when collecting pulses from a laser Start running at 
rep rates higher than 10 Hz or so. At those rates, the camera collects images on 
a fairly regular interval and runs at a good rate.
Below 10 Hz, BeamView.NET seems to run slower because of the low rep rate 
and the camera’s inability to capture every pulse. For lasers running at rep rates 
lower than 10 Hz (especially for single-pulse applications), it is recommended that 
you use the External Trigger mode.

Figure 5-10.  Capture — Select Auto Trigger
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5.5 Capture > Resolution
To choose the Resolution command:

1. Select the Capture menu.
2. From the toolbar select Resolution, and the following dialog box is displayed:  

The drop-down menu lists options, and the selection changes depending on 
which camera model is used:
• 1280 x 1024 x 10
• 680 x 512 x 10
• 680 x 512 x 8
The grid on the right side of the dialog box changes to reflect the settings, as 
shown in this example:  

5.6 Capture > Buffer
The Buffer command in the Capture toolbar provides configuration of the size and 
actions of the sample buffer. There are a variety of settings in this dialog that 
interact with each other. Each sample captured and stored to the sample buffer 
contains the calculated results for that sample.

Figure 5-11.  Capture > Resolution Command

Figure 5-12.  Capture > Change in Resolution
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To choose the Buffer command:

1. Select the Capture menu.
2. From the Capture Settings section of the toolbar, select Buffer, and the 

following dialog box is displayed: 

3. Enter a value for the maximum number of samples to capture.
4. Click the checkbox if you want the capture to continuously replace old images.
5. In the section for Do Calculations, select an option from the drop-down menu: 

• After Capturing EACH Sample
• After Capturing ALL Samples

6. Click OK to finish the settings.

5.6.1 Buffer Size
This function provides selection of the maximum number of results to be stored to 
the Sample Buffer.
The maximum sample capacity is dependent on the amount of computer memory 
available and the selected image resolution, but typically allows up to 2500 
samples in the buffer.

NOTE:
Insufficient disk space can lead to errors, causing the software to terminate.

5.6.2 Do Calculations
The Do Calculations function provides control over when the beam images are 
analyzed after being captured. 
Two modes are provided for doing image calculations relative to their capture:

Figure 5-13.  Capture — Buffer 
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• After Capturing EACH Sample
Selecting After Capturing EACH Sample, configures the BeamView.NET 
software to perform image analysis and display immediately after each beam 
image is captured.

• After Capturing ALL Samples
This mode configures the BeamView.NET software to capture the number of 
beam images specified to the image buffer without analysis or display between 
captured images. In this mode, the BeamView.NET software captures all 
images first, and then analyzes and displays the results for each one.
This mode provides image capture at high rates because calculations and 
display are not done between each captured image. Because of this, this 
method of image capture has been called “Burst Mode”. To restart BURST 
MODE, select the Start command after the specified number of beam images 
are captured.

Setting “Capture continuously over old samples” is not valid when “Do 
Calculations” is set to “After Capturing ALL Samples”.

IMPORTANT!
Doing Calculations after all samples is incompatible with the Pass/Fail fault 
actions because the analyzed results are not available between samples. 
While in BURST MODE, the BeamView.NET ignores all Pass/Fail fault actions 
(except the Background Color option).

5.7 Capture > Exposure Time Settings
In the section for Exposure Time, enter a value in μS. Exposure time must be 
greater than or equal to (68) μS.  

5.8 Next Steps
Now that images have been captured, go to “Analyze Calculations” (p. 87) to view 
and analyze results.

Figure 5-14.  Capture — Exposure Time
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6 ANALYZE CALCULATIONS
The BeamView.NET software can easily be configured to capture and display the 
information required for a particular application, then perform calculations for the 
beam image.
In the Calculations area, there are two commands available:
• Calculations
• Fault Actions

6.1 Summary of Calculations
Following are features to consider when setting up calculations in the 
BeamView.NET software. Click the check boxes to turn calculations on or off.
Table 6-1 lists the calculations that are available for each type of analysis, with a 
brief description of each:  

Table 6-1.  Summary of Calculations

CALCULATION DESCRIPTION

GENERAL CALCULATIONS

Peak (X,Y)R Beam peak intensity position

Centroid (X,Y)R Beam centroid position

Peak % Response Peak intensity of beam as a % response of the camera

Total Relative Power/Energy Total relative power or energy in beam

Effective Area Effective area of the laser beam

Peak Power Density Peak power/energy density of beam

Effective Diameter (%Int) Effective beam diameter at selected intensity level

Aperture Diameter 
(%Power/Energy)

Beam diameter with selected % of total power/energy

d4 Sigma Widths Beam widths based on second moments

d4 Sigma Diameter Beam diameter based on second moment

Divergence Far field beam divergence at selected % of total power/energy

Knife Edge Widths Beam widths based on moving knife edge (image profiles)

Slit Diameters Beam diameters based on moving slit

Peak to Average Peak-to-average intensity of beam

ELLIPTICITY Ellipticity of beam at selected intensity level

Major, Minor Major and minor axes diameter of ellipse

Angle Angular orientation of major ellipse axis

Circularity Angular orientation of major ellipse axis
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6.1.1 Settings for Calculations
When you select Calculations, a dialog box is displayed for the selected 
calculation.
• The panel on the left shows which calculations are currently enabled (turned 

On) for beam analysis and display. These list a check mark to the left of the 
name of the calculation. 

• The panel on the right side of the window changes to display a dialog box with 
settings and controls unique to the selected calculation.

The dialog box for each calculation includes the following common fields. Any 
additional fields unique to each calculation are displayed in the dialog boxes.
• Check Box: The check box enables or disables the selected calculation. If no 

x appears, the selection is not calculated nor displayed.

GAUSSIAN FIT Least squares Gaussian fit of cross-section beam profiles

Coefficient Fit correlation (normalized residuals)

Centroid Center location of Gaussian fit

Peak Intensity Peak intensity of Gaussian fit

Diameter Beam diameter of Gaussian fit

Roughness Roughness of Gaussian fit

APERTURE UNIFORMITY Statistical analysis of beam intensity uniformity within an aperture

Minimum, Mean, Maximum Minimum, mean, maximum beam intensity within the aperture

Sigma, RMS Sigma (standard deviation) and RMS

% Power/Energy in Aperture % of total power/energy in selected aperture

IMAGE UNIFORMITY Statistical calculations of the uniformity of the beam intensity on the 
captured beam image across the sensor's active area

Minimum, Mean, Maximum The Uniformity calculates the minimum, mean (average), and maximum
of the pixel intensities across the sensor's active area.

FLAT TOP FIT

Beam Uniformity Normalized RMS deviation of the power (energy) density.

Plateau Uniformity Ratio of the full width half maximum to the maximum of the histogram 
of pixel intensities for all pixels in the active region above the intensity 
threshold.

Flatness Factor Ratio of the average power (energy) density to the maximum or peak 
power (energy) density.

Edge Steepness Normalized difference between two Effective Irradiation areas with 
intensity levels above 10% and 90% of maximum intensity.

Effective Irradiation Area Area of the beam which exceeds the user-defined threshold.

Effective Average Power (Energy) 
Density

Average power (energy) density of the portion of the beam exceeding 
the user-defined threshold.

Table 6-1.  Summary of Calculations (continued)

CALCULATION DESCRIPTION
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• Format: Indicates the format of the analysis result value to be displayed in the 
Results Area (total number of digits and number of significant digits). The 
(X,Y)R format means:
• X is the X axis position relative to the coordinate origin.

• Y is the Y axis position relative to the coordinate origin.
• R is the direct radial distance from the (X,Y) coordinate to the coordinate 

origin.
• Units:

• Indicates the units to be displayed with the analysis results in the Results 
Area.

• If the box is disabled, the units for this calculation match the global Units 
selected from the Units command.

• Pass/Fail Test Settings: This function provides selection of parameters to be 
used to perform a Pass/Fail test on the analysis result to check whether it falls 
inside (Pass) or outside (Fail) of the settings range. The following functions are 
provided:
• Perform Pass/Fail Checking: If x is selected, the Pass/Fail test is 

performed for every captured and analyzed beam image. If no x appears, 
no testing is performed.

• Range: The minimum and maximum values for the test range.
• Center: The X and Y axis position of the test range Center.
• Maximum Radius from Center: The maximum radial distance range from 

the test Center.

• Fault Actions: This button provides access to the Fault Actions command to 
select actions to be taken if the results should fail the selected tests. Click the 
Fault Actions button at the bottom of the dialog box to display settings (see 
“Fault Actions” (p. 122) for more information).

To turn calculations on or off within the BeamView.NET software, double-click 
anywhere in the calculations portion of the software screen to display a menu of 
available calculations. The list of available calculations depends on the type of 
application this system is being used for and the measurements you want.
If the following symbol is displayed in the dialog box, then the calculation is 
compatible with the proposed International Standards Organization (ISO) 
standards for laser beam measurements:  

Figure 6-1.  ISO Symbol
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6.1.2 Categories of Calculations
The categories of calculations commonly used in the BeamView.NET software 
include:
• General
• Ellipticity
• Gaussian Fit
• Aperture Uniformity
• Image Uniformity
• Flat Top
Each of these categories are more fully described in the sections that follow.

6.2 General Calculations
The following options with their units of measurement and associated dialog 
boxes are available under the General settings:
• Peak (X,Y)R [mm]
• Centroid (X,Y)R [mm]
• Peak % Resp. [%]
• Total Relative Energy [mJ]
• Effective Area [mm2]
• Fluence [J/cm2]
• Effective Diameter 86.5% [mm]
• Aperture Diameter 86.5% [mm]
• d4 Sigma Width [mm]
• d4 Sigma Diam. [mm]
• Divergence 86.5% [mrad]
• Knife Edge 84.0$% [mm]
• Slit Diameter 868.5% [mm]
• Peak to Average

6.2.1 General Calculations > Peak (X,Y)R
The beam peak intensity location is found by searching all the pixels in a sample 
for the maximum digital intensity level. The location of the pixel with maximum 
intensity is the peak location.
It is possible that more than one pixel is at the maximum intensity signal. In this 
case, the peak location is the peak intensity pixel which is found first. The search 
is conducted by scanning the image from left to right, top to bottom.
The Peak (X,Y)R calculation provides the position of the Peak intensity in the 
captured beam image as defined in the peak location algorithm.
The settings are defined in the following dialog box.  
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6.2.2 General Calculations > Centroid (X,Y)R
The Centroid calculation shows where the weighted center of the beam is 
located. This calculation corresponds with the center of the crosshairs in the main 
window. This Centroid measurement is typically tracked to determine if the beam 
is moving.
The Centroid (X,Y)R calculation provides the position of the Centroid intensity in 
the captured beam image, as defined in the Beam Centroid Location algorithm.
The location of the centroid of power or energy of a beam is determined by 
summing the intensities of all image pixels in both X and Y axes, and computing 
the “center of mass” of the power or energy. The pixel coordinates of this location 
define the beam centroid. The X and Y location of the centroid are computed 
using the following formula:

X = SUM[x * p(x,y)]/I

Y = SUM[y * p(x,y)]/I
where:

• p(x,y) = intensity at location (x,y)
• I = total intensity 
• SUM taken over total area.

Because the beam centroid involves summing over the entire sample area, a 
large area of pixels with a small amount of background illumination signal can 
have a larger effect on the centroid location than a small area of relatively bright 
pixels.

Figure 6-2.  General Calculations > Peak (X,Y)R Settings
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IMPORTANT!
For this reason, it is important that steps be taken to reduce the background 
noise level. Use the Background Subtraction feature to ensure the most 
accurate calculation (see p. 73).

Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box.  

6.2.3 General Calculations > Peak % Response
The Peak % Response calculation is one of the most important calculations to 
use when setting up BeamView.NET because it shows how close you are to 
saturating the camera.
• Basically, 100% is the saturation level of the camera and, at that level, it may 

be clipping part of the beam profile.
• Conversely, a response level set too low means that the full dynamic range of 

the camera is not being used.
A general recommendation is to try getting the Peak % Response setting in the 
85% to 95% range. A setting above 95% risks saturating the camera and a 
setting below 85% may miss out on some of the dynamic range of the camera.
To reach the 85 to 95% range, adjust the attenuation in front of the camera by 
using something like a C-VARM. A C-VARM has some fine adjustments that 
allow you to tweak the attenuation until it falls within the appropriate range.
Using this Peak % Response calculation is a good way to track camera 
saturation. This is also a good way to help monitor if the beam is increasing or 
decreasing in intensity over time.
The Peak % Resp. calculation provides the beam peak intensity in terms of a 
percentage (%) of peak camera response, as defined in the Peak Camera 
Response algorithm.

Figure 6-3.  General Calculations > Centroid (X,Y)R Settings
92



Analyze Calculations
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box.  

6.2.4 General Calculations > Total Relative Energy
The Total Relative Power/Energy calculation provides the total integrated power 
or energy in the captured beam image, as defined in the Power and Energy 
algorithm. 
• Total power is calculated for CW beams.
• Total energy is calculated for pulsed beams.
Before taking a measurement, the user should use the Calibrate Relative Power/
Energy command; see “Setup > Calibrate Power” (p. 65).
The Calibrate Relative Power/Energy command provides entry of a power/energy 
value as a “base” power/energy level. The power /energy calculation sets the total 
summed intensity of all pixels in the next sample captured to this value.
The method for calculating the Total Power (CW) or Total Energy (Pulsed) of the 
beam uses an intensity summation of all pixels in the captured image. The power 
or energy summation is calibrated by measuring the beam using an energy or 
power meter. The meter reading is then entered into the Relative Power/Energy 
command in the Set-Up menu.
After the externally-measured power or energy level is entered, the 
BeamView.NET software stores this value and the total summed intensity for that 
image. This information is then used as a reference for the power/energy 
measurement of all the subsequent samples.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box.  

Figure 6-4.  General Calculations > Peak % Response
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6.2.5 General Calculations > Effective Area
The Eff. Area calculation provides the effective area of the captured beam, as 
defined in the Effective Area algorithm.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box.  

The Effective Area of a beam is calculated by dividing the total power or energy, 
as follows:

EffArea = TotalEnergy / PeakFluence

or
EffArea = TotalPower / PeakDensity

The Effective Area of a beam represents the area of an ideal flat top beam having 
the same peak intensity and total energy of the measured beam.

Figure 6-5.  General Calculations > Total Relative Energy

Figure 6-6.  General Calculations > Effective Area
94



Analyze Calculations
6.2.6 General Calculations > Peak Power Density
The Pk. Pwr Density calculation provides the peak power or energy density 
(Fluence) of the captured beam, as defined in the Peak Power/Energy Density 
algorithm. 
The peak power or energy density (or peak fluence for pulsed laser applications) 
is the power density at the pixel with the greatest intensity in the beam image.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

The peak intensity of the captured beam image and the physical area of a single 
camera pixel are used to calculate the Peak Power/Energy Density (Fluence) at 
the beam peak intensity pixel location.
This measurement is calibrated with the Setup > Calibrate Relative Power/Energy 
command using a reading from an external energy or power meter; see “Setup > 
Calibrate Power” (p. 65).
By summing the total digitized intensities over the beam image, the value of 
energy or power per pixel digital level can be determined. Multiplying this value by 
the peak pixel intensity yields the total energy or power on the peak pixel. 
Dividing by the area of the pixel (in cm2) yields the Peak Power Density or Peak 
Energy Density (Fluence).

6.2.7 General Calculations > Effective Diameter
The Eff. Diameter (%Int) calculation provides the effective beam diameter of the 
captured beam image, as defined in the Effective Beam Diameter algorithm.
Effective Beam Diameter calculates the diameter of a circle with an area equal to 
the area of all pixels with intensity above a (user-defined) percent of the 
measured beam peak intensity.
This intensity level is set in the Eff. Diameter calculation dialog box, and is given 
as a percentage of the beam peak. The actual level is considered as X% down 
from the peak response, where X is the user-defined level. For example, if 70% is 
selected, then the beam diameter is the result of all pixel intensities above 30% of 
the peak response (70% down from the peak). The effective beam diameter is 
calculated by the method shown as follows.

Figure 6-7.  General Calculations > Fluence
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1. The intensity level from the user-defined percentage level is determined. For 
example, to determine the effective beam diameter at the 60% level of a beam 
that has a peak intensity of 800 (on a scale of 0 to 1023 (10 - bit)), the intensity 
level is calculated as follows:

Intensity = Peak Intensity – (Peak Intensity * Percentage Level)
In this example, this yields:

Intensity = 800 – (800 * 60) = 320

2. The total area (Apixels) of all pixels that have an intensity greater than the 
defined level is calculated. This is done by counting the number of pixels with 
intensity of 320 or more (for this example) and multiplying by the area of a 
single pixel. The effective beam diameter (Deff) is calculated from this area 
using the formula for the area of a circle.

Deff = SQRT(4*Apixels)/SQRT(pi)

The BeamView.NET software calculates the Effective Beam Diameter based on 
the area of the pixels with an intensity above the user-selected percentage of 
beam peak intensity. If there are pixels from beam wing structure or satellite 
images on the camera array with intensities above the selected intensity, they are 
added to the main beam area and yield a larger beam diameter than expected.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

Calculation Settings
In addition to common fields, the following parameters define settings for the 
Effective Diameter calculation:
• % Peak: Provides selection of the user defined percentage (%) of Peak 

intensity level. All beam image pixels above this level will be included in the 
Beam Diameter calculation.

Figure 6-8.  General Calculations > Effective Diameter
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6.2.8 General Calculations > Aperture Diameter 
The Aper. Diameter (%Power/Energy) calculation provides the diameter of the 
captured beam image containing a specified % of total power or energy.
This command calculates the diameter of a circular aperture that would enclose 
(encircle) a specified percentage of the total beam power/energy. This percent 
power/energy level is set in the Aper. Diameter (%Power/Energy) calculation 
dialog box.
As defined in the Aperture Diameter algorithm, the BeamView.NET software 
performs this calculation by summing the intensities of all pixels contained within 
a circular aperture of a certain diameter, centered at the beam centroid location.
The percentage of the total power/energy contained in that area is then 
calculated. If the resultant power or energy is not equal to the user-defined 
percentage of the total beam power or energy, the diameter of the artificial 
aperture is adjusted and the summation calculation is repeated.
This measurement is often called the “energy-in-the-bucket,” “encircled energy,” 
or “D86” diameter (if 86.5% of the total power/energy is specified).

IMPORTANT!
It is important that steps be taken to reduce the background noise level. Use 
the Background Subtraction feature to ensure the most accurate calculation 
(see p. 73).

Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

In addition to common fields, the following parameters define settings for the 
Aperture Diameter calculation:

% Power/Energy: Provides specification of the % of Total Power or Energy to 
be used in the Diameter calculation.

Figure 6-9.  General Calculations > Aperture Diameter
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6.2.9 General Calculations > d4 Sigma Width
The d4 Sigma Width calculation provides the X and Y axes widths of the captured 
beam image, as defined in the d4 Sigma Width Measurement algorithm. 
The d4 Sigma Widths are the widths in the X and Y axes, based on the second 
moments of the power (energy) distribution of the beam. 
The widths are derived by summing the square of the distance from each point of 
the image to the centroid, multiplied by the intensity at that point. The entire 
summation is then divided by the total power (energy) of the beam, and the 
square root of that value is multiplied by 4.

d4σ x = 4 * SQRT(SUM [(x - xc)2 * p(x,y)] / I)
d4σ y = 4 * SQRT(SUM [(y - yc)2 * p(x,y)] / I)

where:
• xc and yc are the coordinates of the image centroid

• p(x,y) is the intensity at location (x,y)
• I is the total intensity of the image
• SUM is taken over the total image area

IMPORTANT!
Because the d4 Sigma Width measurement uses the square of the distance 
from the centroid, background noise can have a significant impact on the 
calculation. Therefore, it is important to use the Background Subtraction 
feature with this measurement (see p. 73).

Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

Figure 6-10.  General Calculations > d4 Sigma Width
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6.2.10 General Calculations > d4 Sigma Diameter
The d4 Sigma Diameter calculation provides the diameter of the captured beam 
image, as defined in the d4 Sigma Width algorithm. This calculates the beam 
diameter, based on the second moments of the power (energy) distribution of the 
beam.
The diameter is derived by summing the square of the distance from each point of 
the image to the centroid, multiplied by the intensity at that point. The entire 
summation is then divided by the total power (energy) of the beam, and the 
square root of that value is multiplied by 2 times sqrt(2).

d4σ = 2 * SQRT(2 * SUM [((x - xc)2 + (y - yc)2) * p(x,y)] / I)
where:

• xc and yc are the coordinates of the image centroid
• p(x,y) is the intensity at location (x,y)

• I is the total intensity of the image
• SUM is taken over the total image area

IMPORTANT!
Because the d4 Sigma Diameter measurement uses the square of the 
distance from the centroid, background noise can have a significant impact 
on the calculation. Therefore, it is important to use the Background 
Subtraction feature with this measurement (see p. 73).

Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

Figure 6-11.  General Calculations > d4 Sigma Diameter
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6.2.11 General Calculations > Divergence
The Divergence calculation provides the far field divergence of the captured 
beam image, as defined in the Divergence Measurement algorithm.

IMPORTANT!
Because the Divergence measurement depends on a percentage of power/
energy passing through an aperture, it is extremely sensitive to background 
light on the camera. Therefore, it is important to use the Background 
Subtraction feature with this measurement (see p. 73).

The Far Field Beam Divergence is measured by determining the angular spot 
size of the beam in the far field of a focusing lens or mirror that contains the user-
defined percent of total power/energy.
To measure divergence correctly with the BeamView.NET software, a lens or 
mirror with known focal length must be introduced into the laser path. The sensor 
plane of the camera is then placed at the focal length of the lens or mirror, as 
shown in Figure 6-12:  

The camera sensor must be placed at the focal length of the lens to produce a far 
field image for divergence measurement. Placing the camera sensor at any other 
location along the beam path (such as the minimum beam waist) does NOT 
produce the far field image and gives an incorrect divergence measurement.
Divergence measures the far field angular sub-tense of the user-defined 
percentage of the total power/energy in the image. With this method, the focal 
length of the lens and the percent of energy at which divergence is to be 
measured is entered by the user in the Focal length command and the 
Divergence calculation dialog box.
The BeamView.NET software then calculates the beam divergence and displays 
it in the Results Area. This method measures the percentage of power/energy 
passing through a circular aperture containing the specified percentage of energy 
or power. This is often called the “energy-in-the-bucket” method.

Figure 6-12.  General Calculations > Divergence Measurement Optical Set-Up
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The BeamView.NET software performs this calculation by computing the full 
angular sub-tense (spot size in the far field) of the beam. This is done by 
summing the intensities of all pixels contained within a circular aperture of a 
certain diameter centered at the beam centroid location.
The percentage of the total power/energy contained in that area is then 
calculated. If the resultant power or energy is not equal to the user-defined 
percentage of the total beam power or energy, the diameter of the artificial 
aperture is adjusted and the summation calculation is repeated.
The diameter of the aperture is then divided by the focal length to yield the full 
angular sub-tense of the input radiation and, therefore, its divergence.

Θ = d / f
Where: 

• f = the focal length of lens or mirror
• d = the aperture diameter

• Θ = the full angle divergence in radians
A second method can be used to find the divergence manually. This method uses 
the overlaid Aperture function in the View area to determine the percent of energy 
in a user-specified aperture using the % Power/Energy in Aperture calculation. 
The user varies the size, type, and position of the software aperture manually in 
the Apertures command.
To calculate the percent energy or power within a specified aperture, the total 
intensity of all pixels contained within the aperture is summed. This value is then 
used to calculate the power or energy in the aperture as a percentage of the total 
beam power or energy. 
This percent of energy, or power, is displayed in the Results Area. The set 
aperture diameter divided by the focal length of the lens yields the divergence of 
the beam for the percentage of energy/power in the aperture.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

Figure 6-13.  General Calculations > Divergence
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6.2.12 General Calculations > Knife Edge
The Knife Edge calculation provides the X and Y widths of the captured beam 
image, as defined in the Knife Edge Measurement algorithm. The Knife Edge 
widths are calculated by summing profiles, from left to right, and top to bottom, 
until the profile sums contain specified percentages of the total image energy. 
The locations at which the energy percentages are reached are used to define 
the widths.
The Knife Edge Widths are widths in the X and Y axes that are derived by 
summing profiles across the image until the energy in the summed profiles equals 
some percentage of the total energy of the image. For example, to determine the 
knife edge width in the X axis, vertical profiles would be summed, starting from 
the left edge, and moving right, until the profile sums contain 16% of the total 
image energy. 
When 16% is reached, that location is marked as x1. Then continue summing 
profiles, moving to the right, until the profile sums contain 84% of the total image 
energy. That location is marked as x2. 16% and 84% are the levels specified in 
the ISO standard, however, the BeamView.NET software does allow selection of 
any percentage level. Once the x1 and x2 locations are determined, the width is 
twice the difference of the two points.

d x = 2 * (x2 - x1)
The profile in the figure below represents the energy contained in each pixel 
column of the image, shown here:  

The Y axis width is then determined in a similar manner, summing horizontal 
profiles from the top of the image to the bottom, and determining locations y1 and 
y2. The width is twice the difference of the two Y locations.

d y = 2 * (y2 - y1)
If the crosshair is rotated to a fixed position, or if it is tracking the ellipticity angle, 
the profiles used to determine the widths will be parallel to the rotated axes, so 
the widths will also be parallel to the rotated axes.

Figure 6-14.  General Calculations > Knife Edge Profile
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IMPORTANT!
The Knife Edge measurement is sensitive to background noise. Therefore, it 
is important to use the Background Subtraction feature with this 
measurement (see p. 73).

Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

Calculation Settings
In addition to common fields, the following parameters define settings for the 
Knife Edge calculation:

% Power/Energy: Provides specification of the % of Total Power or Energy to 
be used in the Knife Edge calculation. There are two percentage values used 
by the calculation: 
• One is the value entered in this box.
• The other is 100% minus the value in this box.

Therefore, if 16% is entered, then 16% and 84% will be used. If 86.5% is 
entered, then 13.5% and 86.5% will be used.

6.2.13 General Calculations > Slit Diameter
The Slit Diameter calculation provides the X and Y diameters of the captured 
beam image, as defined in the Slit Diameter Measurement algorithm. 
The Slit Diameters are calculated by scanning a 1-pixel wide slit across the 
image, and identifying the two outermost positions at which the slit contains the 
specified percent of Peak power or energy (86.5% by default). The diameter is 
then the distance between the two positions.
A Slit Diameter is determined by the distance between the two slit positions that 
define some percent of the peak energy of the beam. By default, the Slit Diameter 
includes 86.5% of the energy of the beam.

Figure 6-15.  General Calculations > Knife Edge Dialog Box
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For example, to determine the Horizontal Slit diameter:

1. Define a 1-pixel wide slit.
2. Scan across the image from left to right and find the peak energy through that 

slit.
3. Starting at the left edge of the image, again with a 1-pixel wide slit, scan across 

the beam until the slit contains 13.5% of the peak energy, and mark that 
position as X1.

4. Starting from the right side of the image, scan back across the image until our 
slit contains 13.5% of the peak energy, and mark that position as X2. The 
diameter is then the difference between X1 and X2.
d x = X2 – X1

The profile in the drawing below represents the energy contained in each pixel 
column of the image, shown here:  

To determine the Vertical Slit diameter, perform the same process with a slit that 
scans from the top of the image to the bottom, marking the points Y1 and Y2.

dy = Y2 - Y1
The Slit Diameter is always calculated ON-AXIS; that is, rotating the crosshair 
does not cause the Slit Diameter to be performed along the new axes defined by 
the crosshair.

IMPORTANT!
The Slit Diameter measurement is sensitive to background noise. Therefore, 
it is important to use the Background Subtraction feature with this 
measurement (see p. 73).

Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

Calculation Settings
In addition to common fields, the following parameters define settings for the Slit 
Diameter calculation:

Figure 6-16.  General Calculations > Slit Diameter Profile
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% Peak: Provides specification of the % of Peak Power or Energy to be used 
in the Slit Diameter calculation. The percentage value indicates the amount of 
energy to include in the diameter (86.5% by default).

6.2.14 General Calculations > Peak to Average
The Peak To Avg. calculation provides analysis of the Peak to Average intensity 
ratio of the captured beam image, as defined in the Peak-to-Average Ratio 
algorithm.
The Peak-to- Average Ratio is the ratio of the measured beam peak intensity to 
the intensity of a flat-top beam containing the same total power or energy within 
the calculated 1/e2 diameter of the actual beam. This gives a measure of the 
beam flatness. A beam with a peak-to-average ratio of 1 would be a perfect 
“flat top” beam. An example profile is shown here:  

Figure 6-17.  General Calculations > Slit Diameter

Figure 6-18.  General Calculations > Peak to Average Profile
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Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

6.3 Ellipticity Calculations
The following options with their units of measurement and associated dialog 
boxes are available under the Ellipticity calculation:
• Major, Minor: Major and minor axes diameter of ellipse
• Angle: Angular orientation (degrees) of ellipse axes
• Circularity: Circular symmetry of ellipse (ratio of major to minor axes)
Each selection contains a separate dialog box for setting control and analysis 
parameters.
The Ellipticity group of calculations perform a fitted Ellipticity Measurement to the 
captured beam image at a specified intensity level to derive the major and minor 
axis size, the circularity, and angular orientation of the fitted ellipse axes, as 
defined in the Ellipticity Measurement algorithm.
The Ellipticity measurement fits an ellipse to the beam image data, as follows:

1. The BeamView.NET software first finds the set of intensity points which 
correspond to the user-defined intensity level (given as a percentage of beam 
peak). The user-entered percentage level appears in the Ellipticity—Major, 
Minor calculation dialog box. This intensity level is determined as follows:

Intensity = PeakIntensity – (PeakIntensity * PercentageLevel)

2. A least-squares fit is used to fit an ellipse to the intensity contour. This fit is 
done with the centroid of the beam image as the center of the ellipse.

3. The major and minor axes of the fit ellipse are calculated by determining the 
distance from the centroid to the ellipse.

4. Circularity is the normalized ratio of the minor to the major axis. A circularity of 
“1” corresponds to a perfectly circular or round beam.

5. Theta (Θ) is a measure of the orientation of the major axes of the fit. Theta is 
measured from the positive X-axis and varies between +90 and -90. 

Figure 6-19.  General Calculations > Peak to Average
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The dialog box for settings is shown here:  

6.3.1 Ellipticity > Angle
The Ellipticity > Angle calculation provides analysis and display of the Angular 
Orientation of the major and minor axes of the fitted ellipse at the specified 
intensity level, as defined in the Ellipticity Measurement algorithm.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

6.3.2 Ellipticity > Circularity
The Ellipticity > Circularity calculation can be used to monitor how elliptical a 
beam is. 
• A number near 1.0 is very circular. 
• Values dropping from 1.0 becomes more elliptical. 

Figure 6-20.  Ellipticity Calculations > Elliptical Fit

Figure 6-21.  Ellipticity Calculations > Angle
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This is a useful calculation when checking the ellipticity of a diode laser or other 
similar beams.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

6.3.3 Ellipticity > Major, Minor
The Ellipticity > Major, Minor calculation provides analysis and display of the 
major and minor axes diameter of the fitted ellipse at the specified intensity level, 
as defined in the Ellipticity Measurement algorithm.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

Calculation Settings
In addition to common fields, the following parameters define settings for this 
calculation:

% Peak: Provides selection of the user defined % of Peak intensity level. All 
beam image pixels at this level are included in the Ellipticity calculation.

Figure 6-22.  Ellipticity Calculations > Circularity

Figure 6-23.  Ellipticity Calculations > Major, Minor
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6.4 Gaussian Fit
The following options are available under the Gaussian Fit settings:
• Coefficient — Fit correlation coefficient (normalized residuals
• Centroid [mm] — Center location (centroid) of Gaussian Fit.
• Peak Intensity [digital] — Peak intensity of Gaussian Fit.
• Diameter [mm] — Beam diameter of Gaussian Fit. 
• Roughness of Fit [%] — Roughness of Gaussian Fit (difference between actual 

profile and fitted curve). 
Each selection contains a separate dialog box for setting control and analysis 
parameters.
A group setting of % Peak provides selection of the user-defined % of Peak 
intensity level. All pixels above this level in the cross-section profile are used for 
all Gaussian Fit calculations. The default setting of 86.5 includes all pixels above 
the 1/e2 intensity level.
The Gaussian Fit is a least-squares fit of a Gaussian equation to the cross-
section beam profiles. The correlation coefficient is the normalized sum of the 
residuals of the fit. 
The following equation is used to do the Gaussian Fit:

I = Ve-2[(x-c)/σ]2

where I = the intensity of a pixel at location x.
In performing a least-squares fit to this equation, the following terms are derived:

V = the maximum intensity of the fitted Gaussian curve (Peak Intensity).
C = the center of the Gaussian fit peak (Centroid).
σ = the radius of the Gaussian fit curve at the 1/e2 intensity level (Diameter).

6.4.1 Gaussian Fit > Coefficient
The Gaussian Fit > Coefficient calculation shows how closely the beam fits a 
Gaussian profile.
• Numbers near 1.0 are very Gaussian.
• Numbers dropping from 1.0 are further from being Gaussian.
This coefficient is useful to track the quality of the beam profile and how close to 
Gaussian it is.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  
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6.4.2 Gaussian Fit > Centroid
The Gaussian Fit > Centroid calculation provides the center location (centroid) of 
the least squares Gaussian fit of the cross-section profiles.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

6.4.3 Gaussian Fit > Peak Intensity
The Gaussian Fit > Peak Intensity calculation provides the peak intensity of the 
least squares Gaussian fit of the cross-section profiles.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

Figure 6-24.  Gaussian Fit Calculations > Coefficient

Figure 6-25.  Gaussian Fit Calculations > Centroid
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6.4.4 Gaussian Fit > Diameter
The Gaussian Fit > Diameter calculation provides the profile diameter of the least 
squares Gaussian fit of the cross-section profiles at the 1/e2 intensity level.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

6.4.5 Gaussian Fit > Roughness of Fit
The Gaussian Fit > Roughness calculation is a percentage (0 to 100) indicating 
the difference between the actual profile and the fitted Gaussian curve. The 
smaller the roughness value, the smaller the difference between the two curves, 
consequently the more Gaussian the profile.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

Figure 6-26.  Gaussian Fit Calculations > Peak Intensity

Figure 6-27.  Gaussian Fit Calculations > Diameter
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6.5 Aperture Uniformity
The Aperture Uniformity calculation group provides a statistical analysis of pixel 
intensities within the specified aperture area overlaying the captured beam 
image, as defined in the Uniformity Measurements algorithm. The Aperture 
Uniformity calculates the minimum, mean (average), maximum, RMS (root mean 
square) and Sigma (standard deviation) of the pixel intensities within the defined 
aperture area.
The following options are available under the Aperture Uniformity settings:
• Min, Mean, Max [digital] — Minimum, mean, and maximum beam intensity 

within the aperture
• Sigma, RMS [digital] — Sigma (Standard Deviation) and RMS
• % Power/Energy in Aper. {%]
Each of these are described in the sections that follow.

6.5.1 Aperture Uniformity > Min, Mean, Max
The Aperture Uniformity > Min, Mean, Max calculation provides the minimum, 
mean (average) and maximum of the pixel intensities within the specified overlaid 
aperture.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

Figure 6-28.  Gaussian Fit Calculations > Roughness of Fit
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6.5.2 Aperture Uniformity > Sigma, RMS
The Aperture Uniformity - Sigma, RMS calculation provides the Sigma (standard 
deviation) and RMS (root mean square) of the pixel intensities within the specified 
overlaid aperture.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

6.5.3 Aperture Uniformity > % Power/Energy in Aper.
The Aperture Uniformity > % Power/Energy in Aperture calculation provides the 
percent of total integrated power or energy in a specified aperture area overlaid 
on the captured beam image in the View area.

Figure 6-29.  Aperture Uniformity Calculations > Min, Mean, Max

Figure 6-30.  Aperture Uniformity Calculations > Sigma, RMS
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Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

6.6 Image Uniformity
The Aperture Uniformity > % Power/Energy in Aperture calculation provides the 
percent of total integrated power or energy in a specified aperture area overlaid 
on the captured beam image in the View area, as defined in the Percent Power/
Energy in Aperture algorithm.
The following option is available under the Image Uniformity settings:
• Min, Mean, Max [digital]
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

Figure 6-31.  Aperture Uniformity Calculations > % Power/Energy in Aper.

Figure 6-32.  Image Uniformity Calculations > Min, Mean, Max
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6.7 Flat Top
Flat top calculations are based upon the ISO 13694:2000(E) Standard, although 
this specific implementation relies upon numerical approximations over a fixed 
inclusion region. 
This inclusion region can be set using the Inclusion Area command on the 
Analysis menu. This area should be made as large as possible, up to the limit of 
capture resolution: 1279 x 1023. All calculations are based upon the Inclusion 
Area—a rectangular region with upper left corner (xm,ym) and lower right corner 
(xM,yM).
Because these calculations have a chain of dependence, start with the most 
basic idea: a Threshold Fraction ŋ. This is a ratio of “floor” Power (Pth) to Peak 
Power (Pm). Note that an equivalent definition is made for pulsed beams, where 
Uth and Um are threshold and maximum energy, respectively.
Typically this ratio is set based upon the “floor” being close to the observed noise 
level of the camera. This roughly corresponds to the bias level when taking a 
Background Map.
For all Flat Top settings, Threshold selects the user-defined % of Peak intensity 
level. All pixels above this level in the cross-section profile are used for all Flat 
Top calculations. The default setting is 14.0%.
The following options with their units of measurement and associated dialog 
boxes are available under the Flat Top settings:
• Beam Uniformity
• Plateau Uniformity
• Flatness Factor
• Edge Steepness
• Eff. Irradiation Area [cm2]
• Eff. Avg. Energy Density [J/m2]
Each of these are described in the sections that follow.

6.7.1 Flat Top > Beam Uniformity
The Flat Top > Beam Uniformity command is the normalized RMS deviation of 
the power (energy) density. The Beam Uniformity range is zero to one, with a 
perfect flat top beam having a value of zero. To calculate this value:

1. Calculate the average power (energy) density of the portion of the beam 
exceeding the user defined Threshold.

2. Calculate the RMS deviation of the power (energy) density of the portion of the 
beam exceeding the user defined Threshold.

3. Calculate the ratio:  

Figure 6-33.  Flat Top Calculations > Beam Uniformity Ratio
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4. Enter the value in the dialog box:  

6.7.2 Flat Top > Plateau Uniformity
The Flat Top > Plateau Uniformity is the ratio of the full width half maximum to the 
maximum of the histogram of pixel intensities for all pixels in the active region 
above the intensity threshold. The Plateau Uniformity range is zero to one, with a 
perfect flat top beam having a value of zero.
To calculate Plateau Uniformity:

1. Construct a histogram of pixel intensities for all pixels above the user-defined 
threshold.

2. Find the peak in the histogram—that is, the pixel intensity value which has the 
largest number of pixels at that intensity.

3. Measure the full width half maximum (FWHM) of the peak in the histogram.
4. Find the highest pixel intensity (Max).
5. Calculate the ratio:  

The plot in Figure 6-36 illustrates the histogram of pixel intensities with the peak 
in the histogram, the highest pixel intensity, the full width half max, and the user-
defined threshold individually labeled.  
Note that there are two peaks in the histogram, one corresponding to the 
illuminated area of the beam, which is used for the Plateau Uniformity calculation, 
and one near zero pixel intensity, below the user-defined threshold, which 
represents the dark region of the camera not illuminated by the laser beam.

Figure 6-34.  Flat Top Calculations > Beam Uniformity

Figure 6-35.  Flat Top Calculations > Plateau Uniformity Ratio
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Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

6.7.3 Flat Top > Flatness Factor 
Flat Top - Flatness Factor: The ratio of the average power (energy) density to the 
maximum or peak power (energy) density. The Flatness Factor range is zero to 
one, with a perfect flat top beam having a value of one.
Flat Top - Flatness Factor: The ratio of the average power (energy) density to the 
maximum or peak power (energy) density. The Flatness Factor range is zero to 
one, with a perfect flat top beam having a value of one.
To calculate Flatness Factor:

1. Calculate the average intensity of all pixels with intensities above the user-
defined threshold.

2. Find the peak pixel intensity.

Figure 6-36.  Flat Top Calculations > Plateau Uniformity Histogram

Figure 6-37.  Flat Top Calculations > Plateau Uniformity 
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3. Calculate the ratio:  

4. Enter the value.  

6.7.4 Flat Top > Edge Steepness
The Flat Top > Edge Steepness calculation is the normalized difference between 
two Effective Irradiation areas with intensity levels above 10% and 90% of 
maximum intensity.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

The range is zero to one, with a Flat-Top beam with vertical edges having a value 
of zero.

Figure 6-38.  Flat Top Calculations > Flatness Factor Ratio

Figure 6-39.  Flat Top Calculations > Flatness Factor

Figure 6-40.  Flat Top Calculations > Edge Steepness
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NOTE:
The Edge Steepness calculation does not use the threshold value per ISO 
13694:2000 Standard for laser beam measurement.

To find this value:

1. Find the area of the beam where the intensity is 10% (of the peak intensity) or 
greater. Call this A1.

2. Find the area of the beam where the intensity is 90% (of the peak intensity) or 
greater. Call this A2.

3. Normalize to A1 and find the difference, then simplify:  

View the “perfect” flat top beam in Figure 6-42:  

The area of the beam at 10% intensity is equal to the area at 90% intensity 
(A1 = A2). For a 1 mm diameter beam, the area is 0.79 mm2 and the calculation 
is:  

The expected Edge Steepness value for a “perfect” flat top is zero (see row 1 in 
Table 6-2). Two flat top images are included in the BeamView.NET sample 
library.
Now compare the “perfect” beam to the “realistic” beam in Figure 6-44:  

Figure 6-41.  Flat Top > Edge Steepness – Normalize

Figure 6-42.  Flat Top > Edge Steepness: “Perfect” Flat-Top Beam

Figure 6-43.  Flat Top > Edge Steepness – Calculate for 1 mm Beam
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In this beam profile, A1 > A2 and the Edge Steepness is greater than 0. (Note 
that A1 < A2 is not physically possible.) When the diameter at 10% intensity is 
30% larger than the diameter at 90%, the Edge Steepness is:  

This measurement corresponds to the information in Row 4 of Table 6-2:  

6.7.5 Flat Top > Eff. Irradiation Area [cm2]
The Flat Top> Effective Irradiation Area is the area of the beam that exceeds the 
user-defined threshold.
Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  
To calculate this value:

1. Count the number of pixels that exceed the user-defined threshold.
2. Multiply the number of pixels counted by the area of a single pixel.

Figure 6-44.  Flat Top > Edge Steepness: “Realistic” Flat-Top Beam

Figure 6-45.  Flat Top > Edge Steepness Calculation

Table 6-2.  Flat Top > Edge Steepness Calculations

ROW
DIAMETER AT AREA AT EDGE

STEEPNESS10% 90% 10% (A1) 90% (A2)
1 1.0 1.0 0.79 0.79 0.00

2 1.1 1.0 0.95 0.79 0.17

3 1.2 1.0 1.13 0.79 0.31

4 1.3 1.0 .1.33 0.79 0.41

5 1.4 1.0 1.54 0.79 0.49

6 1.5 1.0 1.77 0.79 0.56
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The result is the Effective Irradiation Area, shown in the following example.  

This is similar to the Effective Area calculation, with the distinction that 
non-symmetrical beams or donut-shaped beams are better represented.

6.7.6 Flat Top > Eff. Avg. Energy Density [J/m2]
The Flat Top - Effective Average Power (Energy) Density is the average power 
(energy) density of the portion of the beam exceeding the user-defined threshold. 
This calculation is an extension of the Effective Irradiation Area.
To calculate this value:

1. Every pixel that is above the user threshold is counted and its Power (Energy) 
value is recorded.

2. Sum all of the Power (Energy) values recorded in Step 1, and divide by the 
number of pixels to find the Effective Average Power (Energy).

3. The Effective Irradiation Area is found by multiplying the number of pixels 
(above the user-defined threshold) by the area of a pixel.

4. Calculate:  

Figure 6-46.  Flat Top Calculations > Eff. Irradiation Area

Figure 6-47.  Flat Top Calculations > Eff. Irradiation Area

Figure 6-48.  Flat Top Calculations > Eff. Avg. Energy Density Calculation
121



BeamView.NET User Manual
NOTE:
“Effective” means the portion of the beam (or the pixels) where the intensity 
is above the user threshold.

Click the checkbox in the left column for the calculation you want to use to display 
settings in the following dialog box:  

6.8 Fault Actions
Each calculation in BeamView.NET has a Fault Action feature. This means you 
can set a minimum and maximum value in BeamView.NET for each specific 
calculation.
The Fault Actions command works in conjunction with the Pass/Fail feature of the 
Calculations command dialog box to provide selection of the action(s) to be taken 
when one or more of the selected pass/fail analysis items fall outside the chosen 
Pass/Fail range. 
If that calculation falls outside the minimum and maximum settings, 
BeamView.NET sends warnings through several user-selectable actions, such 
as:

• An audible alarm (beep)
• Stop capturing an image

• Reverse the Background color
• Save or discard an image when one of these faults occurs
• TTL pulse out (high or low)

For example, if you always want the diameter of the beam to be between 2.2 mm 
and 2.5 mm, you can set those values as the minimum and maximum. Then, if 
the beam size gets too large or too small, BeamView.NET warns you that the 
beam is outside of those parameters.

Figure 6-49.  Flat Top Calculations > Eff. Avg. Energy Density
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This can be useful in manufacturing set-ups where a beam size specification is 
part of the quality control process on certain types of lasers.
To set Preferences for the type of notification, Go to the Analysis tab and select 
Fault Actions. The following dialog box is displayed:  

Any combination of Fault Actions can be selected—except Image-Save and 
Image-Discard. All analysis results that fall outside range limits are displayed with 
an “F” before the result in both the View and Statistics Areas. This provides visual 
identification of failed results.

Beep
This option produces an audible tone for each image captured that has any result 
that falls outside of the acceptable Pass/Fail range set in the Calculations dialog 
box.

Stop
This option stops capturing images on the first image captured that has any result 
that falls outside of the acceptable Pass/Fail range set in the Calculation dialog 
box.

Reverse Background Color
This option changes the color of the results area for any sample that has results 
outside of the acceptable Pass/Fail range set in the Calculations dialog box. This 
provides a visual identification of failed samples.

Image Save | Discard
The BeamView.NET software can be configured to save or discard images, 
depending on whether any of the results are outside of the acceptable Pass/Fail 
range set in the Calculations dialog box.
Image-Save and Image-Discard functions cannot be active at the same time.

Figure 6-50.  Analysis — Fault Actions
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• Image Save: This option stores images that have any result outside of the 
acceptable range. The total number of failed images that can be stored with 
this function—the BeamView.NET image buffer capacity, minus one—insures 
at least one image location is available for continued image capture. 
All collected images can be subsequently displayed. All images that have been 
saved due to a failed result value are indicated in the sample header area with 
the word “Saved” next to the sample number. 

• Image Discard: With this option, any image with results that fall outside range 
limits are not stored in video memory but are discarded. The results for that 
image are displayed in the View area during the capture process, but are not 
stored and are not included in the statistics calculations.
If an image is being discarded, the sample number does not increment, 
causing the next image to be captured over the image being discarded. 
If Pass/Fail settings are such that all images fail, the sample number in the 
Results Area title bar does not update.

NOTICE!
When Image-Discard is used, make sure that range limits are not set to 
discard all captured images. The BeamView.NET software appears to be 
“locked up” and does not store data, when in actuality every image is being 
discarded.

TTL Pulse
This option tells the camera to send a pulse whenever a fault is detected. A pulse 
can be set to Low or High, which means high or low voltage.
Using the optional Trigger In and Pass/Fail cable allows the user to translate 
pass/fail calculations into TTL voltage levels. The calculation pass/fail state is 
indicated on the status bar.
This same state is also available on the external camera cable as a TTL HI/LOW 
output. Polarity is selected from the Analysis > Fault Actions menu by selecting 
the checkbox for the TTL High (> 2.0V) or TTL Low (< 0.8V) option.

6.9 Analysis Profiles
In the Profiles section of the Analysis toolbar, define parameters for the following 
settings:
• Apertures
• Reference Position
• Inclusion Area
• Units
• Average Images (dimmed when not available)
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6.9.1 Analysis > Apertures
The Apertures command controls the shape, size, and color of the overlay 
aperture displayed in the View area of the BeamView.NET interface. The position 
and rotational orientation of the Apertures is controlled from the Crosshair dialog 
box.
The Aperture setting can help determine if you’re getting accurate diameter 
measurements. If the aperture that is drawn around the beam does not fit the 
beam very well, the diameter calculations may not be accurate either.
The Aperture feature can be used with the different diameter calculations to make 
sure the diameter calculations are valid. For example, if you set the aperture to 
track the knife-edge diameter calculations on your beam and the aperture does 
not actually fit nicely around the beam, the camera is either picking up some 
noise that is throwing off that specific calculation or the knife-edge diameter 
calculation is not the best diameter calculation to use on that specific beam.
The Apertures represent a synthetic hard aperture, located with the crosshair for 
performing aperture related beam analysis functions.
If any part of the aperture moves outside the image area, uniformity calculations 
can only be performed on the part of the aperture area that is still within the valid 
image area.

Check for Duplications
The aperture setting can help determine if you’re getting accurate diameter 
measurements. If the aperture that is drawn around the beam does not fit the 
beam very well, the diameter calculations may not be accurate either.
The aperture feature can be used with the different diameter calculations to make 
sure the diameter calculations are valid. For example, if you set the aperture to 
track the knife-edge diameter calculations on your beam and the aperture does 
not actually fit nicely around the beam, the camera is either picking up some 
noise that is throwing off that specific calculation or the knife-edge diameter 
calculation is not the best diameter calculation to use on that specific beam.
When you select Analysis > Apertures, the following dialog box is displayed:  

Figure 6-51.  Analysis — Profiles — Apertures
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Functions in the Apertures dialog box include:
• On
• Select Shape
• Size and Style Settings
The position and rotational orientation of the Apertures is controlled from the 
Crosshair dialog box.

6.9.1.1 Aperture Settings ON
The On check box enables or disables the display of the overlaid apertures in the 
BeamView.NET window's View area. If no x appears, the apertures is not shown 
in the View area.
The apertures are not available with the 3D isometric plot.

6.9.1.2 Shape of the Aperture
The Aperture setting turns on an aperture that is traced around the diameter of 
the beam. Select from following options for shapes:

• Circle — Provides a circular aperture overlaid on the beam image

• Ellipse — Provides an elliptical aperture overlaid on the beam image
• Square — Provides a square aperture overlaid on the beam image
• Rectangle — Provides a rectangular aperture overlaid on the beam image

The CIRCLE and SQUARE aperture types allow entry of one dimension (width), 
while the RECTANGLE and ELLIPSE type allow two dimensions (width and 
height).

6.9.1.3 Size of the Aperture
Select from the following options for the size of the Aperture:

• User Size — Selecting User Size as the tracking method activates the 
Width and Height boxes, allowing entry of a specific aperture size.

• Effective Diameter
• Aperture Diameter
• d4 Sigma Width

• d4 Sigma Diameter
• Divergence
• Knife Edge

• Slit Diameter
• Elliptical Axes
• Gaussian Diameters
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6.9.1.4 Width and Height
Enter values for Width and Height (in millimeters).
• Width allows the width of the aperture to be selected by either entering the 

value numerically or by using the spin buttons (Up and Down arrows) with the 
mouse to achieve the desired number. The units for the coordinates are shown 
in parentheses next to the Width label.

• Height allows the height of the aperture to be selected by either entering the 
value numerically or by using the spin buttons (Up and Down arrows) with the 
mouse to achieve the desired number. The units for the coordinates are shown 
in parentheses next to the Height label.

6.9.1.5 Color of the Aperture
Selects the color used for display of the Reference Position cross indicator in the 
View area:

• White
• Red

• Green 
• Magenta
• Yellow 

• Blue 
• Cyan

6.9.2 Analysis > Reference Position
The Reference Position command provides control of the Reference Position 
coordinate function. This function defines the location of the BeamView.NET 
system coordinate origin. 
When you select Reference Position, the following dialog box is displayed. The 
reference position is not available with the 3D isometric plot.  

Figure 6-52.  Analysis — Profiles — Reference Position
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6.9.2.1 Enable Reference Position
The Reference Position point is displayed as a small cross in the View area (“+”). 
• When this function is Off, the reference point cross is no longer seen and all 

location values are calculated from 0,0 (located at the upper left-hand corner 
of the View area). 

• When the Ref. Position function is On, a (“±”) symbol appears in all coordinate 
position displays. With this function On, positive calculation values are 
displayed up and to the right of the reference position in the image.

6.9.2.2 Set Reference Position Location
This item provides selects the location where the Reference position will be 
located when the Set button is pressed, or when the Reference position is turned 
on from the Tool Bar Icon. Select from the drop-down menu to locate the 
Reference Position and click Set:

• The current Crosshair Position
• User-specified coordinates

• Minimum centroid location shown in the Statistics 
• Mean (average) centroid location shown in the Statistics Area
• Maximum centroid location shown in the Statistics Area

• Minimum peak location shown in the Statistics 
• Mean (average) peak location shown in the Statistics Area
• Maximum peak location shown in the Statistics Area

Enter X and Y values for User Coordinates
• X (units) - This item allows the X axis location of the reference position to be 

selected when User Coordinate location is set either by entering the value 
numerically or by using the spin buttons (Up and Down arrows) with the mouse 
to achieve the desired number. The units for the coordinates are show in 
parentheses next to the X label. 

• Y (units) - This item allows the Y axis location of the reference position to be 
selected when User Coordinate location is set either by entering the value 
numerically or by using the spin buttons (Up and Down arrows) with the mouse 
to achieve the desired number. The units for the coordinates are show in 
parentheses next to the Y label.

6.9.2.3 Style Settings
Select a color: 

• White
• Red
• Green 

• Magenta
• Yellow 
• Blue 

• Cyan
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6.9.3 Analysis > Inclusion Area
The Inclusion Area is a user-defined area within which the selected analysis 
calculations are performed. The area is displayed as a red square in the main 
window.
An Inclusion Area is used (activated) to improve beam diameter accuracy. The 
size of the Inclusion zone should be approximately 2 to 2.5 times larger than the 
beam diameter for beams less than 3 mm.
When the Inclusion Area is turned on (activated), BeamView.NET analyzes only 
the area inside that area. Any beam image data outside the inclusion area are 
ignored in the calculations.
When an aperture is used with the Inclusion Area, that aperture is allowed to 
move outside the Inclusion Area, but all uniformity analysis is performed only 
within the area of the aperture that is inside the Inclusion Area.
Using the Inclusion Zone is a good way to help the software ignore noise from the 
camera or the environment that may be affecting the image. The goal is to draw 
the Inclusion Zone around the area where the beam is located.
To choose the Inclusion Area command:

1. From the Analysis menu, select Inclusion from the menu list. The following 
dialog box is displayed:  

There are three functions in the Inclusion Area dialog box:
• On
• Center Position

• Size
For information about using the Inclusion Area in troubleshooting, see 
“Divergence measurement seems too large” (p. 177). 

6.9.3.1 Enable Inclusion Area
Click the checkbox to turn Inclusion ON, which displays the red square in the 
main window. When the Inclusion area is Off, the entire captured resolution 
image area is used for calculations.

Figure 6-53.  Analysis — Profiles — Inclusion Command
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6.9.3.2 Define Center Position
‘This function provides the ability to locate the center of the Inclusion area.
• X [pixels]: Allows the X axis location of the Inclusion area center position to 

be selected by either entering the value numerically or by using the spin 
buttons (Up and Down arrows) with the mouse to achieve the desired number. 
The units for the coordinates are show in parentheses next to the X label.

• Y [pixels]: Allows the Y axis location of the Inclusion area center position to 
be selected by either entering the value numerically or by using the spin 
buttons (Up and Down arrows) with the mouse to achieve the desired number. 
The units for the coordinates are show in parentheses next to the Y label.

Enter values for the X and Y coordinates for the center position (in millimeters).

6.9.3.3 Define Size 
This function provides the ability to control the size of the Inclusion area:
• Horizontal [pixels]: Allows the width of the Inclusion area to be selected by 

either entering the value numerically or by using the spin buttons (Up and 
Down arrows) with the mouse to achieve the desired number. The units for the 
coordinates are show in parentheses next to the Horz. label.

• Vertical [pixels]: Allows the height of the Inclusion area to be selected by 
either entering the value numerically or by using the spin buttons (Up and 
Down arrows) with the mouse to achieve the desired number. The units for the 
coordinates are show in parentheses next to the Vert. label.

Enter values for the Horizontal and Vertical size (in millimeters).

6.9.4 Analysis > Units
The Units command provides selection of desired spatial, power/energy, position, 
time, and intensity units to be used in the BeamView.NET software. These units 
are used in the display of the various system-wide function and values, such as 
input dialog boxes, cursor position, and intensity displays, etc.

NOTE:
Many calculations provide independent unit selection in the Calculations 
command dialog box. These units are not affected by unit changes made 
here for Analysis.

When you select Units, the following dialog box is displayed:  
The drop-down menu for each setting lists different units of measurement. Select 
as desired from these lists.
130



Analyze Calculations
6.9.4.1 Spatial and XY Position
The Spatial function provides selection of different spatial units used for 
dimensional values.
Both the Spatial and XY Position settings list the following options:

• mm (microns)
• μm (millimeters)
• cm (centimeters)

• m (meters)
• inch
• pixel

• μrad (radians)
• mrad
• rad

• degrees

6.9.4.2 Energy/Power
Power settings include the following options:

• μW

• mW
• W
• KW

• GW

Figure 6-54.  Analysis — Profile Settings— Units
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6.9.4.3 Intensity
The Intensity function provides selection of the units for the pixel Intensity level or 
energy/power density values. The settings include the following options:

• μW/cm2

• mW/cm2

• W/cm2

• KW/cm2

• digital

• % resp.

6.9.4.4 Time
The Time function provides a selection of different units used for time values and 
include the following options:

• milliseconds
• seconds

• minutes

6.9.5 Analysis > Average Images
The Average Images command allows you to select any images in the image 
buffer to be averaged together. This menu item is dimmed when no images have 
been captured.
The dialog box shown in Figure 6-55 is displayed:  

Figure 6-55.  Analysis — Average Images
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The numbered icons represent samples that still have images in the image buffer. 
You can select more than 1024 images to average.
• To select an image, click the mouse on the checkbox beside each icon that you 

want to compare. Clicking the checkbox a second time deselects that image. 
• To select all images in the buffer, use the Select All button.
When the desired images are selected, press OK to perform the average. 
A progress bar at the bottom of the dialog box indicates the percent complete 
during the averaging process.
After the selected images are averaged, the new average image is added to the 
image and sample buffers, and the calculations are performed on the image. The 
header bar for the results area displays the word “Average”, indicating the image 
is the result of an average, not a captured image.
Use the Clear All button to deselect all images that are currently selected.
The averaged image overwrites the oldest image in the buffer (the image for 
Sample #1), as indicated by a Warning message. To avoid overwriting an existing 
image, either press the Cancel button or stop image collection before the 
maximum buffer size is reached. This action cancels the averaging operation and 
closes the dialog box. 

6.10 Options to Customize Settings
Table 6-3 lists settings that are commonly customized:  

Table 6-3.  Options to Customize Settings

TO CHANGE THIS MENU COMMAND SHORTCUT

Source Type (CW or Pulsed) Capture Capture/Trigger <Shift> + <F7>

Trigger Mode (if Pulsed) Capture Capture/Trigger

Resolution (use 1:4 to begin) Capture Resolution

Sample Buffer Size Capture Buffer

Type of Image Plot View Plot Type, Profiles, 
Crosshair, Fit Profiles

Graphic Zoom Level 
(use 1X for Setup)

View Zoom <F8>

Aperture Shape & Size Analysis Apertures

Inclusion Area 
(use Off for the first time)

Analysis Inclusion <Shift> + <F8>

Reference Position 
(use Off for first time)

Analysis Reference Position <F4>

Desired Calculations Analysis Calculations <Ctrl> + <R>

Desired Units Analysis Units

Capture Background Map Capture Background Map

Save Settings File Save Config
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7 REMOTE MODE SET UP
Remote Mode in BeamView.NET allows a terminal application to send and 
receive commands directly into the Beam VIEW.NET software application. This 
includes such programs as LabVIEW or a custom Windows application.
Coherent also offers such a terminal application (named “Remote Data Logging 
Utility”) that can be used to explore BeamView commands and to test response/
results. For example, you can use this application to query information from the 
BeamView or automate data collection using this remote interface, such as 
monitoring the beam position over time.
BeamView.NET must be running in the background to collect any information 
from the camera.

7.1 Set Up Remote Mode
Both BeamView.NET and the Remote Data Logging application must be 
configured before a connection can be established.
In general, here is an overview of the steps to run in Remote Mode. Detailed 
instructions and more information about set-up are in the sections that follow.

1. Run the BeamView.NET software and configure settings for the interface you 
want to use. (Setup tab > select Remote Mode)

2. After settings are configured, turn on Remote Mode in BeamView.NET (Home 
tab > Remote Control icon). This provides a fast, single-click control for a 
connection.

3. Connect a camera, which BeamView.NET then automatically detects.
4. Run the Remote application (such as the BeamView Data Logger Utility from 

Coherent) and enable the connection.
5. Enter host commands described in “Remote Mode Host Communication 

Protocols” (p. 145).

7.1.1 Define Communications Interface
Set-up for Remote Mode varies by the interface, described in more detail in the 
following sections.These communication interfaces are supported in the 
BeamView.NET software:
• RS-232 Serial Interface
• TCP/IP network protocol
To configure Remote Mode in BeamView.NET, go to the Set-up Tab, shown in 
Figure 7-1.  
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The dialog box shown in Figure 7-2 for TCP/IP settings is first displayed. 
• Click the check box to “Enable Remote Mode” and the dialog box changes to 

show “Listening” at the bottom, as shown in Figure 7-2.
• The default Port number is assigned by the BeamView.NET software. Enter 

the Port, Baud Rate, Data Bits, Stop Bits, and select Parity, then click OK.  

When you select the tab for an RS-232 connection, the contents change. 
• Click the checkbox to “Enable Remote Mode” and the dialog box changes to 

show “Connected” at the bottom, as shown in Figure 7-3:  

In the Remote Communications Settings dialog box, use the controls listed in 
Table 7-1 to select an interface:  

Figure 7-1.  Setup Tab

Figure 7-2.  Setup — Remote Mode — TCP/IP Connection

Figure 7-3.  Setup — Remote Mode — RS-232 Connection
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7.1.2 Serial Interface Connection
A Serial RS-232 interface requires both a hardware and software connection.

7.1.2.1 Serial Interface — Cable Requirements
The BeamView.NET software uses the serial port on the host PC for 
communication. Interface to this port requires a Null Modem RS-232 cable. 
Table 7-2 lists the pin-outs:  

7.1.2.2 Serial Interface — Software Communication Settings
This section describes the BeamView.NET communication settings for the Serial 
RS-232 interface.

1. Go to the Setup tab in the BeamView.NET software.
2. Click Remote Mode in the Settings section of the toolbar.
3. Ensure that the checkbox for “Enable” is not checked, then click the tab for 

RS232. The following dialog box is displayed:  
BeamView.NET remembers the “Connected” state; the application starts up with 
the Serial Port connected in the state Box is Connected.

Table 7-1.  Controls for Communication Settings
CONTROL DESCRIPTION

Enable 
checkbox

This checkbox toggles between Enable and Disable.
• When checked, Enable connects the Serial COM after you click OK.
• When not checked, disconnects the Serial COM after you click OK.
To switch interfaces, first ensure that the checkbox for the interface you 
do NOT want to use is not checked.

OK button Saves the current settings and connects or disconnects the Serial Port.

Cancel button Closes the Dialog Box without making any changes to existing settings.

Table 7-2.  Serial Null Modem Cable Pin-Outs
9-PIN D-TYPE 9-PIN D-TYPE OR… 25-PIN D-TYPE

BEAMVIEW.NET ON 
LOCAL PC REMOTE PC REMOTE PC

DCD 1 1 DCD 8 DCD

RX 2 3 TX 3 TX

TX 3 2 RX 2 RX

DTR 4 6 DSR 6 DSR

GND 5 5 GND 7 GND

DSR 6 4 DTR 20 DTR

RTS 7 8 CTS 5 CTS

CTS 8 7 RTS 4 RTS

RI 9 9 RI 22 RI
137



BeamView.NET User Manual
The Available and Recommended settings are listed in Table 7-3:  

7.1.3 TCP/IP Interface
The remote TCP/IP application may be installed on the same computer as 
BeamView.NET, but this is not necessary. All that must be specified at the client 
is the BeamView.NET server TCP/IP host name or IP address and the port 
number.

7.1.3.1 TCP/IP Hardware Requirements
The only requirement to use the TCP/IP protocol is connecting the PC on which 
the BeamView.NET software is installed to the network.

7.1.3.2 TCP/IP Communication Settings
For TCP/IP settings:

1. Go to the Setup tab in the BeamView.NET software.
2. Click Remote Mode in the Settings section of the toolbar.
Figure 7-5 shows the dialog box that is displayed for the TCP/IP interface:  

Figure 7-4.  Serial Interface Communication Settings 

Table 7-3.  Communication Settings for RS-232
SETTING OPTIONS RECOMMENDED

COM Port COM1, COM2, COM3, COM4 No Hand shaking

Baud Rate 1200, 2400, 4800, 9600, 19200, 38400, 115200 115,200 bps

Data Bits 7, 8 8 Data Bits

Stop Bits  1, 2 1 Stop Bit

Parity None, Even, Odd No Parity
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If TCP/IP is selected, the properties of the Local Host and IP address are seen in 
the window; these are fixed as your computer is a TCP/IP server to a client 
application. Port number 1024 is used as the default TCP/IP port in the 
BeamView.NET application.

7.1.4 Run Remote Mode in BeamView.NET
To run Remote Control in BeamView.NET:
Go to the Home tab and click the Remote Control icon in the toolbar, shown in 
Figure 7-6. This provides a fast, single-click control for a connection.  

7.2 Remote Data Logging Utility
This section provides an example about using remote control with the BeamView 
Data Logging Utility, a software application. To download the Data Logging Utility 
for BeamView.NET:

1. Go to the Coherent website and locate the following page:
https://www.coherent.com/measurement-control/measurement/laser-
measurement-and-control-help-center

Figure 7-5.  TCP/IP Communication Settings

Figure 7-6.  Remote Control Icon on Home Tab
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2. Scroll down the page in the Help Center and select the BeamView.NET 
application.

3. Click the product name to display associated products.
4. Click the name of the Data Logging Utility and download the file 

BeamViewNet Data Logger v2.0.exe to your computer.
For BeamView.NET software, you must use v2.0 of the BeamView Data Logging 
Utility. This software supports cameras listed in “Products Supported” (p. 19).

NOTE:
The LaserCam-HR-InGaAs camera is currently not supported in the 
BeamView.NET software. For the InGaAs camera, you must use the older 
BeamView v4.8.3 software with the original version of the BeamView Data 
Logging Utility.

7.2.1 Connect the Data Logging Utility
To set up and connect the BeamView Data Logging Utility to run with the 
BeamView.NET software:

1. Run the BeamView.NET software, shown in Figure 7-7.  

2. Verify that there is a camera connected and that you can collect information.
3. Verify the serial number for the camera; this is displayed in the bottom right 

corner of the BeamView.NET window.

Figure 7-7.  BeamView.NET Software
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7.2.1.1 Verify the Connection
The following test validates the settings and communication that you need using 
the Send/Receive functions. Perform this test before you continue.

1. Open the BeamView Data Logger Utility, shown in Figure 7-8.  

2. In the BeamView Data Logger window, go to Connect to BeamView and click 
Connect, as shown in Figure 7-9.  

Figure 7-8.  Data Logger – Run BeamViewNet Data Logger v2.0

Figure 7-9.  Data Logger – Connect to BeamView
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3. Enter a command in the Send / Receive window. See “Remote Mode Host 
Communication Protocols” (p. 145) for a list of available host commands.
For example, enter *idn? In the Send window and click the Send button, as 
shown in Figure 7-10:  

The response from the camera is displayed in the Receive window, as shown 
in Figure 7-11.  

Figure 7-10.  Data Logger – Send Command

Figure 7-11.  Data Logger – Response from Command
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7.2.1.2 Using XY Positional Data
For users who want to use the BeamView data logger to provide XY positional 
data to track beam movement, the following additional XY Position settings can 
be used for reference to help with this task.

• mm (microns)
• μm (millimeters)

• cm (centimeters)
• m (meters)
• inch

• pixel
• μrad (radians)
• mrad 

• rad
• degrees

7.2.2 Example Using a Remote Command
Following is an example about how to set up a query for the XY centroid position 
of the laser beam. This sample test was set up without a laser to track position, 
but the process works the same.
In the Calculation Query section, shown in Figure 7-12:

1. Enter the command “ARCRV?”.
Other commands are listed in the section, “Remote Mode Host Communication 
Protocols” (p. 145).

2. Set the query to request (loop) the position ten times. Note that there is a 
checkbox to click if you want to run this continuously.

3. Set a time interval (such as three seconds) to wait each time before the next 
query.

4. If desired, click the checkbox to add a time stamp to the results file.  
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You can run the query now, or set up a location on your desktop to collect the 
data.
5. Click Create File and, in the standard Windows browser, select a destination.
6. Click the checkbox for Write to File to save a text file. If this checkbox is not 

clicked, the results are displayed only in the window.
7. Click Start.
The resulting .txt file is collected on the desk top location you selected.This 
example text file shown in Figure 7-13 lists the time stamps and XY locations  

Figure 7-12.  Query XY Centroid Position 

Figure 7-13.  Data Logger – Text File Collected
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8 REMOTE MODE HOST 
COMMUNICATION PROTOCOLS
Almost any operation that can be performed or controlled via the keyboard on the 
BeamView.NET software can be done using remote control commands through 
the RS-232 serial interface or the TCP/IP interface.

8.1 Before You Begin
To use the Remote feature, you must first set up the Remote connection. This 
generally requires both hardware and software (a terminal program that supports 
the TCP or RS-232 protocol). The requirements vary by interface. Go to “Set Up 
for Remote Mode” (p. 41) for instructions.
After image samples have been captured, data can be sent over the RS-232 port.

8.2 Commands in Remote Mode
This section describes the command set in the BeamView.NET software. These 
commands can be used to turn analysis functions on or off, set configuration 
parameters (aperture size and shape, Trigger mode, etc.), set Pass/Fail limits, 
and receive captured image data.
The following commands are available in Remote Mode:
• Help commands (p. 146) 
• File commands (p. 147)
• Edit commands (p. 147) 
• Control commands (p. 148)

• Calculation commands (p. 148)
• Calculation sub-command (p. 149)

• Set sub-commands (p. 151)
• Query sub-command (p. 152)
• Distance Units (p. 153)

• Profile and Image Data commands (p. 153)
• Miscellaneous Serial commands (p. 154)

• Capture Parameter commands (p. 156)
• Analysis commands (p. 159)

• Analysis Fault Actions and Units Parameters (p. 162)
• System Configuration commands (p. 167)
In these commands, replace the ‘XX’ placeholder with any valid calculation that is 
listed in the tables. 
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Syntax:
For example, to Query for the Result calculation for the Peak (X, Y) R, issue the 
following command:

ARPXV?
where:
• Analysis Result: AR
• PX = Peak (X,Y)R (the expected calculation)
• V? = Query for Value

8.3 Help Command
Table 8-1 describes the output from Help commands in Remote Mode.  

Table 8-1.  Help Commands

COMMAND DESCRIPTION EXAMPLE

HELP Displays all commands. HELP
HELP;command; Displays the command, its parameter. 

This command provides more details 
than a simple HELP command.
Use only the alphabetic part of the 
command. The command starts and 
terminates with a”;”.

HELP;BDIR;
BDIR xxx?
Query the Live Image Profile data for the specified 
image row.
Example: Enter BDIR 120? Returns the Image 
Profile Data for row 120.

HELP;command; HELP;PFDVR;
PFDVR?
Query the Pass Fail Range for divergence.
Example: Enter PFDVR? Returns the Minimum 
Value followed by the Maximum Value for Pass/
Fail on divergence.
PFDVR Set the Pass Fail Range for divergence. 
Format is PFDVR;x.x,y.y; where x.x is the 
minimum and y.y is the maximum.

HELP;command; HELP;SAMPLE;
SAMPLE? 
Query the Active Beam View Sample.
Example: Enter SAMPLE? Returns the active 
sample number.
SAMPLE;xxx; Set the Active Beam View 
Sample. 
Example: Enter SAMPLE;4; Sets the active 
sample number to 4.
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8.4 File Commands
Table 8-2 lists the File commands.

IMPORTANT! The file path must first be created on the hard drive before 
using the File commands.  

8.5 Edit Commands
Table 8-3 lists the Edit commands.  

Table 8-2.  File Commands

COMMAND DESCRIPTION EXAMPLE

FLCL;Full file path; File Configuration Load from 
specified file name.

FLCL;C:\BV\USER32\Config_2.ATC;
OK

FLCS;Full file path; File Configuration Save to 
specified file name.

FLCS;C:\BV\USER32\Config_2.ATC;
OK

FLST;Full file path; File Save Test As to specified file 
name.

FLST;C:\BV\USER32\Test_8.ATS;
OK

FLEI;Full file path; File Export Image to specified file 
name.

FLEI;C:\BV\USER32\Image_5.BIN;

FLSI;Image numbers 
separated by commas;

File Select Images from specified 
images. This command needs to 
be preceded by either FLST or 
FLEI. Commas must separate the 
image numbers.

FLSI;012,024,044;
OK

Select ALL images. FLSI;ALL;
OK

FLSTL; Load .ats files Load all .ats files. FLSTL;C:\BV\USER32\HasToWork2.AT
S;

FLII; Load .bin, .img, 
and .png files

Load .bin, .img, and .png files FLII;C:\BV\USER32\Image_5.bin;
FLII;C:\BV\USER32\Image_5.img;
FLII;C:\BV\USER32\Image_5.png;

Imports file from specified location FLII;C:\BV\USER32\802samples-
UV.bin;

Table 8-3.  Edit Commands

COMMAND DESCRIPTION EXAMPLE

CLIB;ALL; Clear the Image buffer CLIB;ALL;
OK
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8.6 Control Commands
Table 8-4 lists the first two letters of the command language:  

8.6.1 Calculation Commands
Table 8-5 lists the next two letters apply to each of the calculations. Note that 
these are listed bu function and are not in alphabetical order.  

Table 8-4.  Control Commands

SUB-COMMAND DESCRIPTION

AR Analysis Result Calculation sub-command

PF Pass Fail Calculation sub-command

SR Statistics Result Calculation sub-command

Table 8-5.  Calculation Sub-Commands

SUB-COMMAND DESCRIPTION

PX Peak (X, Y) R

CR Centroid (X, Y) R

PR Peak % Response

TP Total Relative Power (CW only)

TE Total Relative Energy (Pulsed only)

EA Effective Area

PD Peak Power Density (CW only)

FL Fluence (Pulsed only)

ED Effective Diameter

AD Aperture Diameter

DW D4 Sigma Width

DD D4 Sigma Diameter

DV Divergence

KE Knife Edge

SD Slit Diameter

EM Ellipticity - Major, Minor

EN Ellipticity –  Angle

EC Ellipticity – Circularity

GO Gaussian Fit Coefficient

GC Gaussian – Fit Centroid

GP Gaussian - Fit Peak Intensity

GD Gaussian - Fit Diameter
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8.6.2 Calculation Sub-Commands
Table 8-6 lists the sub-commands for Calculations. Replace the ‘XX’ placeholder 
with a valid calculation listed in the tables.For more information about setting Pass/
Fail options, see “Fault Actions” (p. 122).  

GR Gaussian - Roughness of Fit

PA Peak To Average

AM Aperture Uniformity – Min, Mean, Max

AS Aperture Uniformity – Sigma, RMS

AP Aperture Uniformity – % Power in Aperture (CW only)

AE Aperture Uniformity – % Energy in Aperture (Pulsed only)

IM Image Uniformity – Min, Mean, Max

Table 8-5.  Calculation Sub-Commands (continued)

SUB-COMMAND DESCRIPTION

Table 8-6.  Calculation Sub-Commands

COMMAND DESCRIPTION EXAMPLES

ARXXF? Query using Fluence as the Clip Level for calculation (currently only 
works on Effective Diameter).

AREDF?
ON
AREDF?
OFF

ARXXF Set using Fluence as the Clip Level for calculation (currently only 
works on Effective Diameter).

AREDF;ON;
ON
AREDF;OFF;
OFF

ARXXL? Query Fluence Value as the Clip Level for calculation (currently only 
works on Effective Diameter).

AREDL?
50.0

ARXXL Set Fluence Value as the Clip Level for calculation (currently only 
works on Effective Diameter).

AREDL;50.0;
50.0

ARXXO? Query the ON/OFF status for calculation. ARDVO?
OFF
ARDVO?
ON

ARXXO Set the ON/OFF status for calculation. ARDVO;OFF;
OFF
ARDVO;ON;
ON

ARXXP? Query the Parameter Value for calculation. ARDVP?
86.5

ARXXP Set the Parameter Value for calculation. 
Example: Enter ARXXP;x.y; sets the value.

ARDVP;75.0;
75.0
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ARXXU? Query the Units for calculation. 
Divergence uses Position units. 
Aperture and Effective Diameter 
use Spatial units.

Micrometers
Millimeters
Centimeters
Meters
Inches
Pixels
Micro radians
Milliradians
Radians
Degrees

ARDVU?
UMRP or UMRS
MMRP or MMRS
CMRP or CMRS
MTRP or MTRS
INCP or INCS
PIXP or PIXS
URDP or URDS
MRDP or MRDS
RADP or RAD
DEGP or DEGS

ARXXU Set the Units for calculation.
Micrometers by Position
Millimeters by Position
Centimeters by Position
Meters by Position
Inches by Position
Pixels by Position
Micro radians by Position
Milliradians by Position
Radians by Position
Degrees by Position
Spatial Micrometers
Spatial Millimeters
Spatial Centimeters
Spatial Meters
Spatial Inches
Spatial Pixels
Spatial Micro radians
Spatial Milliradians
Spatial Radians
Spatial Degrees

ARXXU;xxxx;
UMRP
MMRP
CMRP
MTRP
INCP
PIXP
URDP
MRDP
RADP
DEGP
UMRS
MMRS
CMRS
MTRS
INCS
PIXS
URDS
MRDS
RADS
DEGS

DIMENSIONLESS UNITS Percent %
Degrees
Ratio
Coefficient

PERCENT
DEGREES
RATIO
COEFFICIENT

INTENSITY UNITS Microwatts/CM2

Milliwatts/CM2

Watts/CM2

Kilowatts/CM2

Microjoules/CM2

Millijoules/CM2

Joules/CM2

Kilojoules/CM2

Digital
% Response

UWCM
MWCM
WCM2
KWCM
UJCM
MJCM
JCM2
KJCM
DIGI
PRCT

POWER UNITS Microwatts
Milliwatts
Watts
Kilowatts
Gigawatts

PUWT
PMWT
PWAT
PKWT
PGWT

Table 8-6.  Calculation Sub-Commands (continued)

COMMAND DESCRIPTION EXAMPLES
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8.6.3 Set Sub-Command
Table 8-7 lists the sub-commands in Remote Mode to Set various parameters:  

Table 8-8 lists examples of the Set sub-command. Replace “XX” in the command 
with the DV (Divergence calculation) from the Calculation sub-command table. 

ENERGY UNITS Microjoules
Millijoules
Joules
Kilojoules
Gigajoules

PUJL
PMJL
PJUL
PKJL
PGJL

TIME UNITS Milliseconds
Seconds
Minutes

MSEC
TSEC
TMIN

AREA UNITS Micrometers squared
Millimeters squared
Centimeters squared
Meters squared
Inches squared
Pixels squared

AUMT
AMMT
ACMT
AMTR
AINC
APIX

PFXXR? Query the Pass/Fail Range for calculation. PFDVR?
2000 3000

PFXXR Set the Pass Fail Range for calculation. For more information about 
setting Pass/Fail, see “Fault Actions” (p. 122).
Example: Enter PFXXR;x.x,y.y; sets the value

PFDVR;2.0,3.0;
2.0 3.0

PFXXO? Query the Pass/Fail ON/OFF status for calculation. PFDVO?
OFF

PFXXO Set the Pass/Fail ON/OFF status for calculation.
For more information about setting Pass/Fail, see “Fault Actions” 
(p. 122). 

PFDVO;OFF;
OFF
PFDVO;ON;
ON

Table 8-6.  Calculation Sub-Commands (continued)

COMMAND DESCRIPTION EXAMPLES

Table 8-7.  Set Sub-Commands

SUB-COMMAND DESCRIPTION

O;ON; Set ON/OFF value

P; XX; Set Parameter value

U; XX; Set Units

R; XX; Set Range
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8.6.4 Query Sub-Command 
Table 8-9 lists the sub-commands in Remote Mode to Query various values.  

Table 8-10 lists the Query sub-commands. Replace “XX” in the command with 
the DV (Divergence calculation) from the Calculation sub-command table.  

Table 8-8.  Examples of Set Sub-Commands

SUB-COMMAND DESCRIPTION NOTES

ARXXO Set the ON/OFF status for calculation. ARDVO;OFF;
OFF
ARDVO;ON;
ON

ARXXP Set the Parameter value for calculation.
Example: Enter ARXXP;x.y;
Sets the value.

ARDVP;75.0;
75.0

Table 8-9.  Query Sub-Commands

SUB-
COMMAND

DESCRIPTION

V? Query the value

M? Query the minimum value

N? Query the mean value

X? Query the maximum value

S? Query the sigma value

O? Query the ON/OFF status

Table 8-10.  Examples of Query Sub-Commands

SUB-COMMAND DESCRIPTION EXAMPLE

ARXXV? Query the value for calculation. ARDVV?
4252

PFXXV? Query the Pass/Fail value for calculation. PFDVV?
FAIL
PFDVV?
PASS

SRXXM? Query the statistics minimum value for calculation. SRDVM?
4229

SRXXN? Query the statistics mean value for calculation. SRDVN?
4257.5730

SRXXX? Query the statistics maximum value for calculation. SRDVX?
4291

SRXXS? Query the statistics sigma value for calculation. SRDVS?
14718118
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8.6.5 Distance Units
Distance Units can be either Positional or Spatial
• Positional units correspond to a point.
• Spatial units correspond to a surface area.

8.6.5.1 Positional Units
The calculations that use Positional Distance Units are listed in Table 8-11:  

8.6.5.2 Spatial Units
The calculations that use Spatial Distance Units are listed in Table 8-12:  

8.6.6 Profile and Image Data Commands 
Table 8-13 lists the Profile and Image Data commands.  

Table 8-11.  Commands for Distance Units

SUB-COMMAND DESCRIPTION

PX Peak (X, Y) R

CR Centroid (X, Y) R

DV Divergence

Table 8-12.  Commands for Spatial Distance Units

SUB-COMMAND DESCRIPTION

ED Effective Diameter

AD Aperture Diameter

DW d4 Sigma Width

DD d4 Sigma Diameter

KE Knife Edge

SD Slit Diameter

EM Ellipticity - Major, Minor

GC Gaussian Fit - Centroid

GD Gaussian Fit - Diameter
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8.6.7 Miscellaneous Commands 
Table 8-14 lists miscellaneous Remote commands:  

Table 8-13.  Profile and Image Data Commands

COMMAND DESCRIPTION EXAMPLE

BDIPH? Query the image profile X-axis from the Crosshair. These 
display a profile only if the CMODE is Run. 
PROFILE EXAMPLE: 
0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,0,5,4,7,18,
29,22,23,26,39,36,26,32,41,39,48,51,51,55
,63,90,79,84,100,107,99,96,94,103,144,159
,
15,158,169,174,188,187,198,179,163,106,10
7,102,84,80,69,73,73,65,65,56,60,61,47,34
,27,18,14,11,10,7,5,6,8,5,1,0,0,0,0,0,0,0
,0,0,0,0,0,0,0,0

BDIPH?
Returns profile example

BDIPV? Query the image profile Y-axis from the Crosshair. This displays 
a profile only if the CMODE is set to Run.

BDIPV?
Returns profile example

BDRPH? Query the reference profile X-axis. This displays a profile only if 
the CMODE is set to Run, and Ref. Profile ON, and Ref. Profile 
is set to GAUSS FIT

BDRPH?
Returns profile example

BDRPV? Query the reference profile Y-axis This displays a profile only if 
the CMODE is set to Run, and Ref Profile ON, and Ref. Profile 
is set to GAUSS FIT.

BDRPV?
Returns profile example

BDGFH? Query the Gaussian fit curve X-axis. This displays a profile only 
if the CMODE is Run, and FIT Profile ON, and Ref. Profile is set 
to GAUSS FIT.

BDGFH?
Returns profile example

BDGFV? Query the Gaussian fit curve Y-axis. This displays a profile only 
if the CMODE is set to Run, and FIT Profile ON, and Ref. Profile 
is set to GAUSS FIT.

BDGFV?
Returns profile example

BDIR xxx? Query the data for specified image row xxx. BDIR 120?
Returns profile example

BDCL? Query the current Crosshair location. BDCL?
1.171 -1.260

Table 8-14.  Miscellaneous Commands

COMMAND DESCRIPTION EXAMPLE

*IDN? Displays the System ID and Revision 
number.

*IDN?
BeamView.NET
32Bit Release 5.0.1.4

TRM? Queries terminal mode for displaying 
image or profile data with a CRLF after 
each 80-byte line.

TRM?
ON
TRM?
OFF
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TRM Sets terminal mode for displaying image 
or profile data with a CRLF after each 
80-byte line.For LabView set TRM to OFF.

TRM;ON;
ON
TRM;OFF;
OFF

CMODE? Query Capture Mode STOP, RUN, LIVE CMODE?
STOP
CMODE?
RUN
CMODE?
LIVE

CMODE;R Set Capture Mode to Run. CMODE;R
RUN

CMODE;S Set Capture Mode to Stop. CMODE;S
STOP

CMODE;L Set Capture Mode to Live. CMODE;L
LIVE

SAMPLE? Query active sample number. SAMPLE?
112

SAMPLE;xxx; Set active sample number. SAMPLE;100;
100

SCAP Set Active Camera
For use when more than one cameras is 
connected t BeamView.NET (Camera 1, 
Camera 2, and so on).
An error is displayed when selecting a 
camera number that is greater than the 
number of available cameras.

SCAP;1;
1
SCAP;2;
2
SCAP;5;
Error:Exceeds number of cams

SCAP? Query Active Camera
For use when more than one cameras is 
connected t BeamView.NET (Camera 1, 
Camera 2, and so on).

SCAP?
1
SCAP?
2
SCAP?
3
SCAP?
4

Table 8-14.  Miscellaneous Commands (continued)

COMMAND DESCRIPTION EXAMPLE
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8.7 Capture Parameter Commands
Table 8-15 lists commands that set capture parameters.  

Table 8-15.  Capture Parameter Commands

COMMAND DESCRIPTION EXAMPLES

SCCS? Query Capture Source CW/Pulsed SCCS?
CW
SCCS?
PULSE

SCCS Set Capture Source CW/Pulsed SCCS;CW;
CW
SCCS;PULSE;
PULSE

SCCT? Query Capture Trigger
SYNC (Freq. in Hz)

ASYNC

AUTO (Threshold in %)

SCCT?
SYNC 10
SCCT?
ASYNC
SCCT?
AUTO 40

SCCT Set Capture Trigger
SYNC (Freq. in Hz)

ASYNC

AUTO (Threshold in %)

SCCT; SYNC 10;
10
SCCT; ASYNC;
ASYNC
SCCT; AUTO 40;
40

SCCI? Query Capture Interval

Continuous

Time (Interval mS, Sec, Min)

Pulse (Count)

On Key Press

One Shot

SCCI?
CONT
SCCI?
TIME 1000
SCCI?
PULSE 2
SCCI?
KEY
SCCI?
ONE SHOT

SCCI Set Capture Interval - Continuous

Time 

Pulse (Count)

On Key Press

One Shot

SCCI;CONT;
CONT
SCCI;TIME 1000
1000
SCCI;PULSE 10;
10
SCCI;KEY;
KEY
SCCI;ONESHOT;
ONESHOT
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SCCR? Query Capture Resolution

Half Resolution, Full Array ON

Half Resolution, Full Array OFF

Full Resolution, Full Array ON

Full Resolution, Full Array OFF

Frame Resolution, Full Array ON

Frame Resolution, Full Array OFF

SCCR?
HALF 1
SCCR?
HALF 0
SCCR?
FULL 1
SCCR?
FULL 0
SCCR?
FRAME 1
SCCR?
FRAME 0

SCCR Set Capture Resolution

Half Resolution, Full Array ON

Half Resolution, Full Array OFF

Full Resolution, Full Array ON

Full Resolution, Full Array OFF

Frame Resolution, Full Array ON

Frame Resolution, Full Array OFF

SCCR;HALF,1;
HALF,1
SCCR;HALF,0;
HALF,0
SCCR;FULL,1;
FULL,1
SCCR;FULL,0;
FULL,0
SCCR;FRAME,1;
FRAME,1
SCCR;FRAME,0
FRAME,0

SCCP? Query Capture Pan (x, y) SCCP?
X=0 Y=0

SCCP Set Capture Pan (x, y)
This example is for Full Array only.

SCCP;48,0;
SCCP?
48,0

SCYI? Query Capture Y axis Invert SCYI?
OFF
SCYI?
ON

SCYI Set Capture Y axis Invert SCYI;ON;
ON
SCYI;OFF;
OFF

SCBZ? Query Buffer Size SCBZ?
256

SCBZ Set Buffer Size SCBZ;256;
256
SCBZ;128;
128

Table 8-15.  Capture Parameter Commands (continued)

COMMAND DESCRIPTION EXAMPLES
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SCBL? Query Buffer Location
Hard Drive

Frame grabber

SCBL?
HD C:\TEMP
SCBL?
FG

SCBL Set Buffer Location
The buffer directory set to the HD.

Set the buffer on the Frame grabber (FG).

SCBL;HD,C:\TEMP;
C:\TEMP
SCBL;FG;
FG

SCBA? Query Buffer Analysis Normal/Burst
NORMAL ON is EACH sample on GUI
Capture Continuously is True
NORMAL OFF is EACH sample on GUI
Capture Continuously is False
Burst is Capture ALL samples on GUI

SCBA?
NORMAL ON
SCBA?
NORMAL OFF
SCBA?
BURST

SCBA Query Buffer Analysis Normal/Burst

NORMAL ON is EACH sample on GUI
Capture Continuously is True
NORMAL OFF is EACH sample on GUI
Capture Continuously is False
Burst is Capture ALL samples on GUI

SCBA;NORMAL ON;
NORMAL ON
SCBA;NORMAL OFF;
NORMAL OFF
SCBA;BURST;
BURST

SCBS? Query Background Subtract
ON

OFF

Capture

SCBS?
ON
SCBS?
OFF
SCBS?
CAP

SCBS Set Background Subtract ON/OFF/Capture

Capture (CAP) may fail with ERROR 026 when the 
camera picks up too much light while capturing a 
background map.The user can set a background bias 
value using the SCBB command.

SCBS;ON;
ON
SCBS;OFF;
OFF
SCBS;CAP;
CAP

SCBB? Query the background Bias SCBB?
1

SCBB Set Background Bias. SCBB retries to capture a 
Background Map with the users entered value.
The Bias has to be between 1 and 8

SCBB;4;
4

Table 8-15.  Capture Parameter Commands (continued)

COMMAND DESCRIPTION EXAMPLES
158



Remote Mode Host Communication Protocols
8.8 Analysis Commands
Table 8-16 lists the commands used to configure the apertures Inclusion area.    

Table 8-16.  Analysis Commands

COMMAND DESCRIPTION EXAMPLE

ACCP? Query Crosshair Position OFF/
Centroid/Peak/User

ACCP?
OFF
ACCP?
USER COORD
ACCP?
CENTROID
ACCP?
PEAK

ACCP Set Crosshair Position Off/Centroid/
Peak/USE COORD

ACCP;OFF;
OFF
ACCP;CENTROID;
CENTROID

Move crosshair ACCP;USER COORD 0.51,0.41;
ACCA? Query Crosshair USER ANGLE, 

ELLIPTICAL
ACCA?
USER ANGLE 23.4

ACCA Set Crosshair USER ANGLE, 
ELLIPTICAL

ACCA;USER ANGLE;
USER ANGLE
ACCA;ELLIPTICAL;
ELLIPTICAL

Change the angle of the Crosshair ACCA;USER ANGLE 23;
ACIP? Query Image Profile ON/OFF ACIP?

ON
ACIP Set Image Profile ON/OFF ACIP;OFF;

OFF
ACIP;ON;
ON

ACRP? Query Reference Profile ON/OFF, 
Profile/Gauss Fit

ACRP?
GAUSS FIT
ACRP?
REFERENCE FIT
ACRP?
OFF

ACRP Set Reference Profile ON/OFF, 
Profile/Gauss Fit. Doesn't actually 
start on GUI unless Image profile is 
on, and Gaussian Fit.

ACRP;ON;
ON
ACRP;GAUSS FIT;
GAUSS FIT

ACFP? Query Fit Profile ON/OFF, Gauss Fit ACFP?
GAUSS FIT
ACFP?
OFF
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ACFP Set Fit Profile ON/OFF, Gauss Fit ACFP; GAUSS FIT;
GAUSS FIT
ACFP;OFF;
OFF
ACFP;ON;
ON

ACAS? Query Aperture Shape
OFF

CIRCLE

SQUARE

ELLIPSE

RECTANGLE

ACAS?
OFF
ACAS?
CIRCLE
ACAS?
SQUARE
ACAS?
ELLIPSE
ACAS?
RECTANGLE

ACAS Set Aperture Shape ON/OFF/Circle/
etc.

ACAS;OFF;
OFF
ACAS;ON;
ON
ACAS;CIRCLE;
CIRCLE

ACAZ? Query Aperture Size ACAZ?
APER_DIAMETER Width=260 Height=260
ACAZ?
USER_SIZE Width=2200 Height=2200
ACAZ?
DIVERGENCE Width=260 Height=260
ACAZ?
GAUSSIAN DIAMETERS Width=260 Height 260
ACAZ?
EFF_DIAMETER Width=260 Height=260
ACAZ?
D4_SIG_WIDTH Width=260 Height=260
ACAZ?
D4_SIG_DIAM Width=260 Height=260
ACAZ?
KNIFE_EDGE Width=260 Height=260
ACAZ?
SLIT_DIAMETER Width=260 Height=260
ACAZ?
ELLIPTICAL_AXES Width=260 Height=260

Table 8-16.  Analysis Commands (continued)

COMMAND DESCRIPTION EXAMPLE
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ACAZ Set Aperture Size (can set the width 
and height for USER_SIZE 
only).The user can have different 
width and heights for Ellipses and 
Rectangles only. The Height 
returned for a Square or Circle will 
be the same as the Width.

ACAZ;USER_SIZE 1.2,1.4;
USER_SIZE 1.2,1.4
ACAZ?
USER_SIZE Width = 1.2 Height = 1.4
ACAZ; USER_SIZE 1.00,1.4;
USER_SIZE 1.2,1.4
ACAZ?
USER_SIZE Width = 1.2 Height =1.2

ACIA? Query Inclusion Area ACIA?
H = 240 V = 260

ACIA Set Inclusion Area ACIA;120,240;
120, 240
ACIA?
H = 120 V = 240

ACIL? Query Inclusion Location ACIL?
X = 119 Y = 119

ACIL Set Inclusion Location ACIL;120,119;
X = 120 Y = 119
ACIL?
X = 120 Y = 119

ACIO? Query Inclusion ON/OFF State ACIO?
OFF
ACIO?
ON

ACIO Set Inclusion ON/OFF State ACIO;ON;
ON
ACIO;OFF;
OFF

ACRL? Query Reference Position ACRL?
OFF
ACRL?
CROSS HAIR X = .1 Y = .2
ACRL?
USER COORDINATE X = .1 Y = .2
ACRL?
CENTROID MIN X = .1 Y = .2
ACRL?
CENTROID MEAN X = .1 Y = .2
ACRL?
CENTROID MAX X = .1 Y = .2
ACRL?
PEAK MIN X = .1 Y = .2
ACRL?
PEAK MEAN X = .1 Y = .2
ACRL?
PEAK MAX X = .1 Y = .2

Table 8-16.  Analysis Commands (continued)

COMMAND DESCRIPTION EXAMPLE
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8.8.1 Analysis Fault Actions and Units Parameters 
Commands
Table 8-17 lists commands that set and query the analysis fault actions and units 
parameters.  

ACRL Set Reference Position (can only 
change coordinates for USER 
COORDINATE) 

ACRLOFF
OFF;
OFFACRL;ON;
ON
ACRL;USER COORDINATE .1,.12;
USER COORDINATE .1,.12
ACRL?
USER COORDINATE X = .1 Y = .12
ACRL;CROSS HAIR; 
CROSSHAIR
ACRL?
CROSSHAIR X = .1 Y = .12

Table 8-16.  Analysis Commands (continued)

COMMAND DESCRIPTION EXAMPLE

Table 8-17.  Analysis Fault Actions and Units Parameters Commands

Command DESCRIPTION EXAMPLES

SCFA? Query Fault Actions

Beep

Stop

Reverse Background Color

Image

Save

Discard

TTL 

SCFA?
BEEP
SCFA?
STOP
SCFA?
REVERSE BACKGROUND COLOR
SCFA?
IMAGE
SCFA?
SAVE
SCFA?
DISCARD
SCFA?
TTL PULSE

SCFA Set Fault Actions
Beep/Stop/Save/Discard/TTL

TURNS ON BEEP
TURNS OFF STOP IMAGE AND SAVE
SCFA; BEEP, ~STOP, ~IMAGE, ~SAVE;
BEEP, ~STOP, ~IMAGE, ~SAVE
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SCUA? Query Units Spatial

Spatial Micrometers

Spatial Millimeters

Spatial Centimeters

Spatial Meters

Spatial Inches

Spatial Pixels

Spatial Micro Radians

Spatial Milliradians

Spatial Radians

Spatial Degrees

SCUA?
UMRS
SCUA?
MMRS
SCUA?
CMRS
SCUA?
MTRS
SCUA?
INCS
SCUA?
PIXS
SCUA?
URDS
SCUA?
MRDS
SCUA?
RADS
SCUA?
DEGS

SCUA Sets Units Spatial

Spatial Micrometers

Spatial Millimeters

Spatial Centimeters

Spatial Meters

Spatial Inches

Spatial Pixels

Spatial Micro radians

Spatial Milliradians

Spatial Radians

Spatial Degrees

SCUA; UMRS;
UMRS
SCUA;MMRS;
MMRS
SCUA;CMRS;
CMRS
SCUA;MTRS;
MTRS
SCUA;INCS;
INCS
SCUA;PIXS;
PIXS
SCUA;URDS;
URDS
SCUA;MRDS;
MRDS
SCUA;RADS;
RADS
SCUA;DEGS;
DEGS

Table 8-17.  Analysis Fault Actions and Units Parameters Commands (continued)

Command DESCRIPTION EXAMPLES
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SCUL? Query Units Position

Micrometers by Position

Millimeters by Position

Centimeters by Position

Meters by Position

Inches by Position

Pixels by Position

Micro radians by Position

Milliradians by Position

Radians by Position

Degrees by Position

SCUL?
UMRP
SCUL?
MMRP
SCUL?
CMRP
SCUL?
MTRP
SCUL?
INCP
SCUL?
PIXP
SCUL?
URDP
SCUL?
MRDP
SCUL?
RADP
SCUL?
DEGP

SCUL Sets Units Position

Micrometers by Position

Millimeters by Position

Centimeters by Position

Meters by Position

Inches by Position

Pixels by Position

Micro radians by Position

Milliradians by Position

Radians by Position

Degrees by Position

SCUL; UMRP;
UMRP
SCUL;MMRP;
MMRP
SCUL;CMRP;
CMRP
SCUL;MTRP;
MTRP
SCUL;INCP;
INCP
SCUL;PIXP;
PIXP
SCUL;URDP;
URDP
SCUL;MRDP;
MRDP
SCUL;RADP;
RADP
SCUL;DEGP;
DEGP

Table 8-17.  Analysis Fault Actions and Units Parameters Commands (continued)

Command DESCRIPTION EXAMPLES
164



Remote Mode Host Communication Protocols
SCUP? Query Units Power (CW only)

Microwatts

Milliwatts

Watts

Kilowatts

Gigawatts

SCUP?
PUWT
SCUP?
PMWT
SCUP?
PWAT
SCUP?
PKWT
SCUP?
PGWT

SCUP Set Units Power (CW only)

Microwatts

Milliwatts

Watts

Kilowatts

Gigawatts

SCUP;PUWT;
PUWT
SCUP;PMWT;
PMWT
SCUP;PWAT;
PWAT
SCUP;PKWT;
PKWT
SCUP;PGWT;
PGWT

SCUE? Query Units Energy (Pulsed only)

Microjoule /CM2

Millijoules/CM2

Joules/CM2

Kilojoules/CM2

Gigajoules/CM2

SCUE?
PUJL
SCUE?
PMJL
SCUE?
PJUL
SCUE?
PKJL
SCUE?
PGJL

SCUE Set Units Energy (Pulsed only)

Microjoules/CM2

Millijoules/CM2

Joules/CM2

Kilojoules/CM2

Gigajoules/CM2

SCUE;PUJL;
PUJL
SCUE;PMJL;
PMJL
SCUE;PJUL;
PJUL
SCUE;PKJL;
PKJL
SCUE;PGJL;
PGJL

Table 8-17.  Analysis Fault Actions and Units Parameters Commands (continued)

Command DESCRIPTION EXAMPLES
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SCUI? Query Units Intensity (CW and Pulsed)

Microwatts/CM2

Milliwatts/CM2

Watts/CM2

Kilowatts/CM2

Microjoules/CM2

Millijoules/CM2

Joules/CM2

Kilojoules/CM2

Digital

% Response

SCUI?
UWCM
SCUI?
MWCM
SCUI?
WCM2
SCUI?
KWCM
SCUI?
UJCM
SCUI?
MJCM
SCUI?
JCM2
SCUI?
KJCM
SCUI?
DIGI
SCUI?
PRCT

SCUI Set Units Intensity (CW and Pulsed)

Microwatts/CM2

Milliwatts/CM2

Watts/CM2

Kilowatts/CM2

Microjoules/CM2

Millijoules/CM2

Joules/CM2

Kilojoules/CM2

Digital

% Response

SCUI;UWCM;
UWCM
SCUI;MWCM;
MWCM
SCUI;WCM2;
WCM2
SCUI;KWCM;
KWCM
SCUI;UJCM;
UJCM
SCUI;MJCM;
MJCM
SCUI;JCM2;
JCM2
SCUI;KJCM;
KJCM
SCUI;DIGI;
DIGI
SCUI;PRCT;
PRCT

SCUT? Query Units Time

Milliseconds

Seconds

Minutes

SCUT?
MSEC
SCUT?
TSEC
SCUT?
TMIN

Table 8-17.  Analysis Fault Actions and Units Parameters Commands (continued)

Command DESCRIPTION EXAMPLES
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8.9 System Configuration Commands
Table 8-18 lists commands that set and query the Test Information parameters.  

SCUT Set Units Time
Milliseconds

Seconds

Minutes

SCUT;MSEC;
MSEC
SCUT;TSEC;
TSEC
SCUT;TMIN;
TMIN

Table 8-17.  Analysis Fault Actions and Units Parameters Commands (continued)

Command DESCRIPTION EXAMPLES

Table 8-18.  System Configuration Commands

COMMAND DESCRIPTION EXAMPLE

TITL? Query Test Info Title. TITL?
TEST 004

TITL Set Test Info Title. TITL;TEST 044;
TEST 044

TISN? Query Test Info Serial Number TISN?
004

TISN Set Test Info Serial Number TISN;005;
005

TIOP? Query Test Info Operator TIOP?
JOE

TIOP Set Test Info Operator TIOP;ABE;
ABE

TICM? Query Test Info Comment TICM?
ABES TEST

TICM Set Test Info Comment TICM;JOES TEST;
JOES TEST

TIWS? Query Test Info Work Station TIWS?
USER 001

TIWS Set Test Info Work Station TIWS;USER 002;
USER 002
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8.9.1 Scale Factor, Focal Length, and Power Parameter 
Commands
Table 8-19 lists commands that set and query the set-up > scale factors, focal 
length, and calibrated power parameters.  

Table 8-19.  Scale Factor, Focal Length, and Power Parameter 
Commands

COMMAND DESCRIPTION EXAMPLES

SCSF? Query Scale Factor SCSF?
1.00000

SCSF Set Scale Factor SCSF;2;
2

SCFL? Query Focal Length SCFL?
100.0000

SCFL Set Focal Length SCFL;200;
200

SCPC? Query Power Calibrate SCPC?
1

SCPC Set Power Calibrate SCPC;2.4;
2.4

SCEC? Query Energy Calibrate SCEC?
1

SCEC Set Energy Calibrate SCEC;2.4;
2.4
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9 TROUBLESHOOTING, TIPS, AND 
BEST PRACTICES
The following sections describe some common issues and solution, as well as 
tips and best practices when using BeamView.NET software.

9.1 Categories of Errors
Most issues reported by users of the BeamView.NET software fall into a few 
categories.
• Errors with Set-Up or Camera

• USB error
• Camera not connected or recognized
• Camera disconnected or underpowered
• Camera needs calibration
• Camera not compatible with software

• Operating Errors
• BeamView.NET does not capture beam images (or stops capturing)
• See only fragments of the beam
• Printout has dots in the image background
• Loss of TCP/IP connection

• Analysis Errors
• Background noise is too high
• Calculations do not update fast enough
• Divergence measurement seems too large
• Percent energy in the aperture is too large
• Profiles are “flat topped”
• The beam is very small
• The Centroid does not track well

• Errors with Remote Mode
• No response on terminal screen

9.2 Errors With Set-Up or Camera
General errors may be displayed when using a camera that is not connected 
corrected or there are other compatibility issues.
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9.2.1 USB Error
When using a USB connection, your computer’s operating system may display an 
error message warning about low power on a USB port.
This type of error occurs when a laptop is running on a low battery or the USB 
bus is overloaded and unable to supply the 500 mA power required for a USB 2.0 
connection.
When troubleshooting, it has been noted that certain systems are not capable of 
supplying the needed current to its USB ports.
If you run into problems with a connection or software freezing, consider the use 
of a USB hub with its own power supply. These powered USB hubs maintain 
current to the external USB device if your computer or laptop is unable to do so.

IMPORTANT!
Connect ALL power cables to a surge-protected power source!

9.2.2 Camera Not Connected or Recognized
When a LaserCam-HR camera is either not connected or is not being recognized 
by the computer, the area above the Calculations panel displays “No camera 
Attached”.  

Check the USB connections to the camera. If the USB cable is properly 
connected, check in Device Manager on the computer to be sure the camera's 
USB drivers have been installed properly.
The application is now in Analysis Only mode. The Analysis mode of 
BeamView.NET allows for the full analysis of a previously stored image or the 
importation of an .ats test session file. Previously stored images, ats files, and 
data files can be accessed using the File > Open command.
To return to Capture mode, close the application, connect the camera, and 
restart.

9.2.3 Camera Disconnected or Underpowered
The following error message is displayed when the camera is disconnected or 
possibly underpowered. Try moving the cable to a different USB port.  

Figure 9-1.  Error Message: No Camera Connected
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9.2.4 Camera Needs Calibration
The Calibration Error message indicates that the gamma correction table in your 
camera has been either incorrectly stored or corrupted. Contact Coherent 
Customer Support to arrange for evaluation of the camera evaluated and 
potential reprogramming.  

9.2.5 Camera Not Compatible with Software
A compatibility error occurs when the camera and software are not designed to 
work together. Contact Coherent Customer Support for the right match.  

9.3 Operating Errors
Operating errors include:
• BeamView.NET does not capture beam images (or stops capturing)
• See only fragments of the beam
• Printout has dots in the image background
• Loss of TCP/IP connection

Figure 9-2.  Error Message: Connection with Camera

Figure 9-3.  Error Message: Camera Needs Calibration

Figure 9-4.  Error Message: Compatibility with Camera
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9.3.1 BeamView.NET does not capture images (or stops)
An error is displayed if the BeamView.NET software does not capture beam 
images or if it stops capturing after a number of images have been captured.
Check the following:
• Check that the BeamView.NET software is not in Stop mode. Do this by 

verifying the Stop icon button on the Toolbar is not depressed, or look at the left 
side of the Status bar to see if it indicates “Stopped”.
If the BeamView.NET software is in Stop mode, select the Start icon button on 
the Tool Bar or, use the Start command to resume capturing samples.

• Check that the sample buffer size in the Size area of the dialog box is set for 
the sample size expected. The BeamView.NET software halts after the 
specified number of samples is reached. Checking the “Capture continuously” 
check box causes the BeamView.NET software to capture continuously over 
old images and wrap around to the beginning of the sample buffer without 
stopping.

• Check that the proper laser source is selected in the Status bar. If Pulse is 
displayed in the panel, the BeamView.NET software may be waiting for an 
input trigger. If the LaserCam-HR is being used in Pulsed mode and is 
capturing only blank images, trigger timing may be the problem.

• When Image-Discard is checked in Fault Action settings, make sure that range 
limits are not set to discard all captured images. The BeamView.NET software 
appears to be “locked up” and does not store data, when in actuality every 
image is being discarded. See “Image Save | Discard” (p. 123) for more 
information.

9.3.2 See Only Fragments of the Beam
An error is displayed if the displayed beam image seems to have almost totally 
disappeared in the View area, or only a small portion of the beam is visible.
Verify that a Background Map command was not taken while an image was on 
the camera. If a Background Map is taken with an image on the camera, the 
BeamView.NET subtracts a beam image from all subsequent images and only 
the portion of the beam that changes is seen.
To check this:

1. Select the Background Map command from the Capture menu (see p. 73).
2. Turn Off the background subtraction.
3. Go back to the View area and capture images.
The image should now be displayed normally.

9.3.3 Dots in the Image Printout
An error is displayed if the image displayed dots in the image background, similar 
to the sample shown here:  
Notice the black dots around the beam. This effect occurs when the image is 
captured with a background noise level that is too high.
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By default, the print routine turns the bottom four levels of the image to white to 
help conserve black ink. On properly adjusted images, using background 
subtraction produces clear printouts.
To tell if your image has the proper background levels, be sure to turn on the 
Automatic Background Warning Level indicator. If this feature is already on, the 
“Warn” indicator on the right edge of the status bar should be On.
To correct the background problem, click on the warning panel and a Help topic 
describing the corrective action is displayed.

9.3.4 Loss of TCP/IP Connection
Loss of a TCP/IP connection typically occurs when the computer is assigned an 
IP address via DHCP. 
If the computer that is running BeamView.NET loses its DHCP lease, the DHCP 
server has to assign the computer a new IP address. (IP addresses are typically 
allocated to a system only for a fixed period of time.) The DHCP server may 
assign the computer an address other than the original address. If this happens, 
BeamView.NET no longer recognize packets that have the old address (this is 
true, even if the computer is connecting to itself).
Note that “localhost” and “127.0.0.1” are special addresses that always indicate 
“this computer”— no matter what the computer’s assigned external address. 
When the client and server applications are running on the same system, using 
“localhost” avoids dropped connections caused by changes to the IP address.

9.4 Analysis Errors
Analysis errors in BeamView.NET include the following:
• Background noise is too high
• Calculations do not update fast enough
• Divergence measurement seems too large
• Percent energy in the aperture is too large
• Profiles are “flat topped”
• The beam is very small
• The Centroid does not track well

Figure 9-5.  Error: Printout has Dots
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9.4.1 Background Noise Is Too High
If you notice that the crosshairs or the diameter calculations do not seem to be 
tracking the beam correctly, most likely the software is picking up noise from the 
camera. In such cases, capturing a new Background Map or adjusting the 
Inclusion Zone could possibly help.
The Background Map function helps maximize system dynamic range by 
eliminating fixed-pattern noise and ignoring bad camera pixels. For information 
about collecting a Background Map, see “Background Map” (p. 73).

IMPORTANT!
BeamView.NET cannot distinguish between background noise and a true 
beam profile signal. The background noise must be minimized to perform 
accurate beam diagnostics.

Several sources of background noise can contribute to the overall noise level in 
the beam images. Before collecting a Background Map, sources of Background 
Noise must be reduced as much as possible. If too high, check these sections to 
reduce Background Noise:
• Sources of Background Noise
• Monitor Background Noise Level
• Noise Reduction
• Eliminate Background Light
Also see information about “Background Light” (p. 40) and “Background Map” 
(p. 73).

9.4.1.1 Sources of Background Noise
High quality, low distortion optics, and low background light noise—free from 
video electronic noise—are CRITICAL to accurate beam diagnostics results.
Electronic noise in a video image is a common concern whenever video systems 
are used in association with lasers. This is especially the case with Q-switched 
lasers. Take special care to avoid placing any of the cables in a manner that 
could make them susceptible to EMI associated with the laser system.
High-frequency sources can also induce noise into the cables and camera 
electronics. Avoid grounding the camera with the laser or its power supply in a 
manner that could make them susceptible to ground loops. Severe damage to the 
camera and synchronization electronics may result.

IMPORTANT!
If you are using the background subtraction function and need to change 
cameras, you must take a new Background Map since a different camera has 
its own unique background level (see p. 73).

Background light noise seen by the camera is another problem that should be 
closely monitored. This noise can come from sunlight, room lights, flash lamps, 
and instrumentation lights.
174



Troubleshooting, Tips, and Best Practices
To offset some of these issues, you can attach an attenuator window of polished 
NG-type absorption glass (with low transmission) to the camera housing to 
reduce background light. The Low Distortion Face Plate (LDFP) included with the 
LaserCam-HR cameras serves this purpose. This allows diagnostics to be 
performed in a lighted room.

9.4.1.2 Monitor Background Noise Levels
When enabled, the BeamView.NET software continuously monitors the 
background noise level during image capture, and issues a warning if that noise 
level is significant enough to affect calculation accuracy.

Display a Warning Message
By examining the intensities of groups of pixels in each corner of the image, the 
BeamView.NET software can determine the background noise level. If the noise 
level is determined to be incorrect, the right side of the Status bar displays the 
word “WARN”.
If the WARN indicator is present, click on it to find out what corrective steps 
should be taken. If this fails to remove the WARN indicator, follow the steps below 
to check for other sources of noise. You can also display the background warning 
by selecting “Background Warning” from the Help menu.

Check for Background Noise
To check for background noise:

1. Remove any background light, electronic noise, or thermal noise.
2. Capture a Background Map. A Background Map is basically an image of the 

fixed-pattern noise, which is subtracted from captured beam images before 
image analysis is performed (see “Capture > Collect a Background Map” 
(p. 74)).

3. If there is still significant random noise after the fixed-pattern noise has been 
subtracted out, a bias value may need to be added/increased. The bias value 
reduces pixel intensity levels for every pixel in the image. The bias factor 
should be kept as small as possible, because it could remove beam 
information as well as noise.

To turn the Background Warning indicator On:

1. Run “Background Map” (p. 73).
2. Check “Enable Background Noise Level Monitoring” in the last dialog box.

9.4.1.3 Noise Reduction
Most of the sources of background noise can be eliminated by taking the time for 
proper precautions when setting up the BeamView.NET software.
All noise reduction efforts should first be performed optically:
• The best way to determine the background noise level is to block the laser 

beam at the laser output port and observe the intensity at the array while the 
laser is still operating.
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• Check attenuation at the camera, shielding to avoid stray light, or darken lights 
in the room lights to eliminate background light before using the background 
subtraction feature.
• Block or cover the camera array so that no light can possibly be detected. 

In the Results area, check if the minimum, mean, or maximum (Uniformity: 
Min, Mean Max) values change when the camera array is blocked.

• If so, the camera is sensing background light and requires more light 
baffling, darker room conditions, or background attenuation.

Next, set up the BeamView.NET software:

1. In the Analysis menu, use the Apertures command and Calculations command 
to turn on the overlaid Aperture and Aperture Uniformity calculation. Set the 
aperture size to the maximum size allowed. 

2. In the View menu, use the Crosshair command to set the Crosshair position to 
USER COORD

3. In the Capture menu, use the Resolution command to set the Track position to 
pixel in the Resolution capture mode.

This procedure sets up the BeamView.NET software to take the uniformity 
measurement over the entire image area.
This procedure can be used to evaluate possible electronic noise sources. By 
monitoring the minimum, mean, and maximum values while moving cables, 
turning off possible noise sources, or adding electronic shielding, you can identify 
and eliminate some sources of noise.
Accuracy depends on taking the time to eliminate background noise sources as 
much as possible.

9.4.1.4 Eliminate Background Light
See “Background Light” (p. 40) for details about eliminating background light 
when using optics. Using a Low Distortion Faceplate (LDFP) is also 
recommended.

9.4.2 Calculations Not Updating Fast Enough
There many things that can influence the speed of the calculations. Here are 
several suggestions for speeding up the calculations:
• Turn off calculations that are not needed or not being used. Each calculation 

slows down the update rate. Calculations such as Divergence, Gaussian Fit, 
and Ellipticity take more time to process than the other calculations.

• Using an Inclusion Area reduces the amount of data processed (see “Analysis 
> Inclusion Area” (p. 129). If using a very small beam or if the Background Map 
feature does not cancel out all of the noise on the camera, check the Inclusion 
Zone.

• If Background Noise Level Monitoring is active, the calculations may be 
increased by turning it off in the “Background Map” (p. 73). 

• Consider using Analysis After ALL Samples Captured. This mode captures 
images faster because it does not take time to analyze them. 
After the capture cycle is completed, the specified number the images are then 
analyzed. See the “Capture > Buffer” (p. 84) to learn about these settings.
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9.4.3 Divergence measurement seems too large
If the divergence measurement seems too large, some possible causes include:
• Incorrect focal length is specified in the Focal Length command of the Setup 

menu.
• Too much background noise is present on the camera.
Possible solutions:
• Double check the focal length setting in the Focal Length command.
• Place an aperture around the beam using the Apertures command of the 

Analysis menu and check that the percent energy is greater than 90%. 
If the percent energy is less than 90%, use the suggested solutions under 
Background noise is too high and The beam is very small.

9.4.4 Percent energy in the aperture is too large
If the percent energy in the aperture is too large, a possible cause may be that a 
Background Map has a Bias Value that is set too high.
Consider reducing the background Bias Value by using the Background Map 
command in the Capture menu.

9.4.5 Profiles are “flat topped”
If the horizontal or vertical profiles appear to be “flat topped” in the View area, no 
matter how much light is put on the camera, the peak intensity does not reach 
100%.
If the problem only occurs with Background Subtraction On, try reducing the Bias 
value using the Background Map command in the Capture menu (see p. 73).

9.4.6 The beam is very small
If the beam is small, use the Inclusion feature to reduce the image area used in 
the calculations to a small rectangular area surrounding the small beam. This has 
two positive effects: 
• It does not take into account all the noise that may be present outside of the 

inclusion area.
• It speeds up calculations.
To activate the Inclusion feature, see the Inclusion command in the Analysis 
menu.
Another solution is to change or add optics to magnify the beam size onto the 
array. The Scale Factor setting allows the results to take into account the added 
magnification (see “Setup > Scale Factor” (p. 66)). 
The Focal Length setting allows a longer focal length focusing lens or mirror to be 
used to enlarge the Far Field beam image for Divergence measurements (see 
Focal Length Command in the Setup menu).
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9.4.7 The Centroid does not track well
If the calculated centroid of the beam is moving around (bouncing), or if it is off to 
the side from the apparent true centroid, this is an indication that the background 
noise is too high or that the beam is too small.

9.5 Errors in Remote Mode
If there is no response on terminal screen:

1. Make sure that the computers are connected through the correct COM ports 
with a NULL modem cable.

2. Make sure that the serial COM port settings match in BeamView.NET and the 
terminal program.

3. Try to replace BeamView.NET with a terminal session, and check if the two 
terminal sessions can communicate. That can isolate the problem to Hardware 
or incorrect settings.

Use the Serial Connect/Disconnect button on the right end of BeamView.NET 
toolbar for fast single-click control of the connection.
Capture may fail with ERROR 026 when the camera picks up too much light while 
capturing a background map.The user can set a background bias value using the SCBB 
command (see p. 156).

9.6 Errors Codes from the HELP Command
Table 9-1 lists the error codes when using the Help command.  

Table 9-1.  Error Codes from the Help Command
ERROR DESCRIPTION

001 New sample is greater than current sample.
002 HELP command is not recognized.
003 File is password protected.
004 File Load or Save Configuration is invalid file type; should be ATC.
005 Unable to open file.
006 Save Images – nothing selected.
007 Save Images – invalid image.
008 Save Images – Unable to obtain memory to save compressed images. 

Will save as uncompressed.
009 Export Image File is invalid; it needs to be type BIN.
010 Save Test As File is invalid; it needs to be type ATS.
011 Invalid command.
012 Row too large.
013 Wrong Trigger Mode.
014 No pre-existing Background Map.
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9.7 Tips and Best Practices
This section provides additional information about best practices, tips, and 
general information to optimize results when using the BeamView.NEt software. 
This includes such topics as:
• Exporting a binary file
• Ghosting images and solutions
• Camera drawings for depth to imager clarifications
• Preventing contamination
• Optimizing camera calculation

015 Selected Profile has no binary data and cannot be displayed.
016 Selected Profile is OFF and cannot be displayed.
017 Invalid Repeat Command.
018 Unable to obtain Latest Divergence.
019 Unable to Set this parameter.
020 Unknown Units.
021 Unknown Crosshair Position.
022 Unknown Crosshair Angle Setting.
023 Unknown Aperture Size.
024 DLL error.
025 Unable to write to INI.
026 BG Map; A/D Adjust as necessary.
027 BG Map; invalid Bias.
028 SCBL; Unable to find directory.
029 SAMPLE – Sample number is greater than maximum allowed.
030 There is NO parameter value.
031 This Calculation is turned OFF.
032 The units are invalid for this Calculation.
033 The configuration file does not exist.
034 Unable to perform Calculation. No Image.
035 Units not valid for CW mode.
036 Units not valid for Pulsed mode.
037 Invalid Port.
038 Unable to set Fluence Value.

Table 9-1.  Error Codes from the Help Command
ERROR DESCRIPTION
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9.7.1 Exporting a Binary File
Exporting Images as a .bin file saves all selected images into one file. Exporting 
and Importing a .bin file is faster than the other options. It also take up less hard 
disk space on your computer.

When you export a binary file, a header is attached to the beginning. This is 
followed by all selected Images being exported. Images are appended one after 
another in the file.

The exact size of a header is 128 bytes:
Images: Height = 1024, PixelsPerRow = 1280, sizeOfPixel = 2
PixelsPerRow* sizeOfPixel = bytesPerRow = 2560

Height * bytesPerRow =  ImageSize = 2621440 bytes
Header file +2621440  = 2621568 bytes

The remote interface commands for BeamView.NET are the only way to get 
images or calculations out of the BeamView.NET software. There is no way to 
directly access the images from the camera itself without the BeamView.NET 
software. The images that are collected by the camera are a very raw format and 
they do not have any type of background subtraction or linearity correction 
performed on them.
In addition, the BeamView.NET software adds some image correction and noise 
subtraction from the raw camera images in order to produce an accurate beam 
image on which calculations can be performed. These images can then be 
exported from BeamView.NET and imported into other programs.

BeamView.NET is focused on data evaluation from the camera. The data is then 
reviewed in BeamView.NET and is not really designed to be used outside of the 
software; however, it can be done and will take more work for the user.
Exporting binary files to transfer images directly to LabVIEW or MatLab for 
analysis is generally not useful because they are not a true representation of the 
beam.

Working with LabVIEW
BeamView.NET is compatible with LabVIEW. The basic commands outlined in 
the “Remote Mode Host Communication Protocols” (p. 145) can be interfaced 
through the LabVIEW application. This acts as a wrapper for the Host commands. 
You still need to use the BeamView.NET application and set the application to 
Remote to run LabVIEW.
Exporting the images to LabVIEW is really of no value. LabVIEW is used to 
remotely drive the camera through the BeamView.NET software. However, if the 
customer is simply looking for a way to remote commands to the camera and take 
images at some rate, this can be done in LabVIEW. The images must later be 
loaded into BeamView.NET for data evaluation.
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An option is to first run the BeamView.NET Data Logger application (described in 
“Remote Mode Set Up” (p. 135)) and make sure they can run all of the 
commands that they want to use to get the camera to do the functions that they 
want. The next step is to do the same thing in LabVIEW. Again, though, the user 
must still use the BeamView.NET software to review the images once they are 
collected.

Working with MatLab
Remember that MatLab is not an API, so you cannot interact with the 
BeamView.NET software directly through MatLab.
This can be done directly through the BeamView.NET software or by using the 
remote commands. However, the images would have to be saved into the 
BeamView.NET software, then exported, then imported into MatLab. There is no 
feature in BeamView.NET to allow images to be streamed into another program 
or a specific folder location.

9.7.2 Ghosting Images
With the introduction of the LaserCam HR II CCD camera many improved 
performances have been realized. Lower overall noise, increased sensor sizing 
and extension of the product due to obsolescence issues of the CMOS 
predecessor. It is important to understand that due to the chip structure camera 
pixels on the memory layer and the process to get the data to the processor, 
there are Interactions with IR wavelengths exhibits some vertical artifacts that can 
negatively impact calculations of beam diameter. 
The 1/2” version of the camera is more susceptible to this than the 2/3” version, 
but both of these cameras can exhibit unacceptable errors in some situations. It is 
important to understand the methods to compensate for these errors. 
• Increasing the integration time and attenuation reduces this effect significantly. 

The best trade-off on accuracy and frame rate is near 100ms, but the ⅔” 
camera performs acceptably at integration times as low as 10ms. 

• Inclusion Zone, adding an inclusion zone that effectively subtracts unwanted 
artifacts from the camera calculation will improve the behavior considerably. 

Examples of Ghosting
Figure 9-6 shows examples of ghosting and the effects of integration time. Notice 
how the camera picks up the artifacts with the use of our 1047nm laser. The 
effects of integration time have significant change on the ghost image.  

Examples of Use with Inclusion Zone
Using the inclusion zone selects the area in which the camera will use in its data 
calculations. This effectively discards all data outside of the selected area.
When using the LaserCam HR 2/3” camera, the effects of ghosting are almost 
eliminated with a 10ms integration time, as shown in Figure 9-7.  

9.7.3 Depth-to-Housing
Depth-to-housing is a reference to the physical dimensions of the device for the 
following cameras, listed in Table 9-2:  
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Figure 9-8 shows the depth to housing for the Laser Cam II 1/2” USB Camera 
system (P/N 1282868):  

 1MS INTEGRATION TIME  5MS INTEGRATION TIME 

10MS INTEGRATION TIME 100MS INTEGRATION TIME 

1S INTEGRATION TIME

Figure 9-6.  Examples of Ghosting
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 1MS INTEGRATION TIME 

10MS INTEGRATION TIME 

Figure 9-7.  Examples of Using the Inclusion Zone
183



BeamView.NET User Manual
9.7.4 Preventing Contamination
The CCD array is very sensitive to contaminates. This is the reason for the Low 
Distortion Faceplate (LDFP) or other sealing type of protective window. When the 
unit is open to the environment, the bare CCD chip can be easily contaminated by 
particles and debris that are very difficult to remove.
Contamination of the imager can also occur when removing the filter. In addition, 
the attempted removal of debris by a user destroys the imager. To check for 
symptoms of damage:
• Does the camera currently produce images? 
• Does BeamView.NET display only a white screen or bright color, or streaks of 

color? 
• Do you see marks on the image that stay with the camera and appear to block 

or reduce the image intensity on the defect site?
These are indications that the imager has already been damaged by a cleaning 
attempt. If the imager has already been damaged, it is less expensive to replace 
the Camera then repair the unit.
Removal of the Low Distortion Faceplate (LDFP) or other protective window 
should not be done except when following these recommendations:
• Perform the window exchange under a flow hood, or in a clean room.

Table 9-2.  Depth to Housing
P/N CAMERA DEPTH TO HOUSING

1282868 LaserCam HR II 1-2/” USB 0.68 in [17.1 mm]
1282870 LaserCam HR II 2/3” USB 0.68 in [17.1 mm]
1360550 LaserCam HR II UV 0.67 in [16.9 mm]

LASERCAM HR II 
1/2” USB LASERCAM HR II 2/3” USB LASERCAM HR II UV

Figure 9-8.  Depth to Housing: LaserCam HR II Cameras
184



Troubleshooting, Tips, and Best Practices
• Never leave the CCD array open to the environment.
• Make sure that the protective window that you are installing has been properly 

cleaned before using.

9.7.5 Optimizing Camera Calculations
This section describes what to do to get the most out of the camera calculation.

WARNING!
Coherent cameras are provided with an LDFP filter to protect the imager from 
contamination. Removing the LDFP filter can allow contamination of debris 
and affect the image of the camera. These imagers cannot be cleaned in the 
same way as normal optical components. In most cases, cleaning attempts 
result in complete camera failure.

A camera needs only a handful of mW to get a good image. The question is how 
to take a laser and attenuate it down to a level to get the most data from the 
camera without saturating and loosing valuable information.
Filters have a fixed density, and the camera must have the input power adjusted 
to properly create the right amount of peak response for the best image. Many 
times, you need to control the amount of power going into the camera to select a 
desired level. This requires constant laser power and the ability to knock that 
power down to a level that would be useful for the camera.
Because lasers are limited in their ability to get a specific power and achieve 
lasers stability level, Coherent offers variable attenuation options. The use of a C-
VARM provides dynamic control of the power level and perfectly controls the 
power. This assumes you have 1W or less of incoming power. If there is more 
power than this, then additional attenuation is required. BCUBEs or fix optical 
attenuation work in this case.

Laser-Grade Attenuation Optics for Cameras
Features of laser-grade attenuation optics for cameras include:
• Laser-grade attenuation optics
• Compatible with all Coherent beam diagnostic cameras
• Virtually undistorted and interference-free attenuation
• Variable and fixed attenuation for beams up to 2000W/cm2 or 50J/cm2
• C-Mount threads couple directly to cameras

9.7.5.1 Attenuation Optics and Accessories 
Most cameras are too sensitive for direct viewing of laser beams. For example, a 
typical diagnostics camera saturates at only ~0.5 µW/cm2 power density (at ~633 
nm) or at ~9 nJ/cm2 (at 1064 nm) pulsed energy density. If the camera has an 
electronic shutter, it can be used for some CW beam attenuation, but there is 
more flexibility in using optical attenuation.
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Any attenuation optics introduced in the beam path must be manufactured to 
exacting specifications. The optics must be laser-grade substrate, and use the 
proper flatness and wedge to avoid etaloning and fringing, so that the beam is not 
distorted by the introduction of the attenuation. 
Coherent offers attenuation optics that are designed to these specifications and 
packaged for use with our cameras.
Typical attenuations are 1:1 to 400,000:1, but even larger attenuations are 
possible. All Coherent diagnostic cameras accept C-Mount optics and 
accessories, and are delivered without a standard window in front of the sensor 
array. Such windows are liable to distort the optical beam. However, a LDFP 
(Low-Distortion Face Plate) filter is supplied with each camera purchased from 
Coherent. The LDFP is a laser-grade optic specified and polished for diagnostics 
use. It is mounted in a housing with C-Mount threads and provides attenuation of 
room light so that the camera can be used with the lights on. For operation below 
400 nm, the LDFP must be removed. 
The Continuously Variable Attenuator Modules (C-VARM and UV C-VARM) 
contain two wedge attenuators that are continuously variable and a step 
attenuator that allows attenuation from 107:1 down to 3000:1. The C-VARM and 
UV C-VARM can be finely adjusted to achieve both precise attenuation levels and 
maximum use of the camera’s optical dynamic range. 
The Variable Attenuator Module (VARM) is a triple-wheel filter holder that 
contains three filters per wheel. The filters are made to our exacting specifications 
for transmission value and material quality. The VARM is adjustable in 
attenuation in 64 discrete steps of approximately 16% reduction each time from 
400,000:1 down to 1:1. The VARM can be easily returned to exactly the same 
attenuation level as previously used.
The BeamCUBE Fixed-Attenuator Modules (BCUBE and UV-BCUBE) provide 
fixed attenuation and beam pickoff for performing diagnostics on high power laser 
sources. The BCUBE and UV-BCUBE utilize the front surface reflection from an 
uncoated laser mirror to achieve beam samples at 2% to 10% of the incident 
radiation, depending upon beam polarization. Multiple BCUBEs can be coupled 
together for even higher fixed attenuation levels
BCUBE, UV-BCUBE, VARM, C-VARM, UV C-VARM and all other Coherent 
cameras have female C-Mount threading, making them easy to connect with the 
male C-Mount connection flange provided with each attenuator. Also, all 
attenuators have 1/4-20 tapped holes for independent post or plate mounting. 
The C-Mount flanges (threaded rings) also have a female RMS microscope 
thread. This allows a microscope objective to be coupled to the attenuators and 
extension barrels in order to create a flexible close-up imaging system for 
analysis of small/focused beams, fiber optics, laser diodes or LEDs.

9.7.5.2 Avoiding Multi-Filter Beam Distortion
The wavefront distortion through a number of optical filters can be calculated by 
taking the square root of the sum of the squares of the wavefront distortion of the 
individual components. For example, if the individual optics are made to λ/10 
specifications and six are used, a total λ/4 RMS wavefront distortion will be 
introduced to the beam:

√   0.12 + 0.12 + 0.12 + 0.12 + 0.12 + 0.12 = 0.25
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Troubleshooting, Tips, and Best Practices
In general, a camera cannot sense less than ~λ/4 total distortion in the beam, so 
if a series of filters is used, they must be made to very exacting laser-grade 
specifications. Attenuating optics from Coherent are manufactured to better than 
a λ/10 surface specification, so at least six optics in series can be used. Calculate 
the Low-Distortion Face Plate (LDFP) and each BCUBE as one optic, and the 
VARM or C-VARM as three optics each.

9.7.5.3 Attenuator Selection
Attenuation is selected on the basis of power density in W/cm2 or energy density 
in J/cm2. The attenuation from the camera’s Low-Distortion Face Plate (LDFP) 
allows an average power density of up to 1.2 mW/cm2. 
There are only two more steps to attenuation selection:

1. Choose either the VARM or the C-VARM for up to 1W/cm2.
2. In addition or alternatively, use a BCUBE beam splitter module to pick off 

between 2% and 10% of the beam (depending on polarization and 
wavelength).

For more information and assistance with attenuator selection, call your Coherent 
representative (Toll Free at 1-800-343-4912), go to shopcoherent.com, or contact 
Coherent Technical Support (see “Service and Support” (p. 195)).
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A SAFETY AND COMPLIANCE
This section describes requirements for safety for persons setting up or operating 
the BeamView.NET software in an environment:
• “Laser Safety Hazards” (p. 189)
• “Optical Safety” (p. 190)
• “Laser Back Reflection” (p. 191)

You must review these laser safety sections thoroughly BEFORE operating the 
BeamView.NET software. Carefully follow all safety instructions presented 
throughout this manual.

This user information reported in this manual is in compliance with the 
following standards for Light-Emitting Products EN/IEC 60825-1 “Safety of 
laser products – Part 1: Equipment classification and requirements” 21 CFR 
Title 21 Chapter 1, Subchapter J, Part 1040 “Performance standards for 
light-emitting products”.

A.1 Laser Safety Hazards
Hazards associated with lasers generally fall into the following categories:
• Biological hazards from exposure to laser radiation that may damage the eyes

or skin
• Electrical hazards generated in the laser power supply or associated circuits
• Chemical hazards resulting from contact of the laser beam with volatile or

flammable substances, or released as a result of laser material processing

The above list is not intended to be exhaustive. Anyone operating a laser must 
consider the interaction with its specific working environment to identify potential 
hazards.

For the BeamView.NET software, hazards vary with the input angle and the laser 
beam.

WARNING—LASER RADIATION!
Always avoid eye or skin exposure to both DIRECT and SCATTERED radiation.
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A.2 Optical Safety
Laser light, because of its optical qualities, poses safety hazards not associated 
with light from conventional light sources. The safe use of lasers requires all 
operators, and everyone near a laser, to be aware of the dangers involved. Users 
must be familiar with the instrument and the properties of coherent, intense 
beams of light.

The safety precautions listed below are to be read and observed by anyone 
working with or near the laser. At all times, ensure that all personnel who operate, 
maintain or service the laser are protected from accidental or unnecessary 
exposure to laser radiation exceeding the accessible emission limits defined in 
the laser safety standards.

WARNING!
Direct eye contact with the output beam from the laser may cause serious 
eye injury and possible blindness.

The greatest concern when using a laser is eye safety. In addition to the main 
beam, there are often many smaller beams present at various angles near a 
laser. These beams are formed by specular reflections of the main beam at 
polished surfaces such as lenses or beamsplitters. While weaker than the main 
beam, such beams may still be sufficiently intense to cause eye damage.

Laser beams are powerful enough to burn skin, clothing, or combustible 
materials, even at some distance. They can ignite volatile substances such as 
alcohol, gasoline, ether, and other solvents, and can damage light-sensitive 
elements in video cameras, photomultipliers, and photodiodes.

Laser Safety Eyewear
Always wear appropriate laser safety eyewear for protection against the specific 
wavelengths and laser energy being generated.

The appropriate eye protection can be calculated as defined in the “EN 207 
Personal eye protection equipment—Filters and eye-protectors against laser 
radiation (laser eye-protectors)”, in other national or international standards (such 
as ANSI, ACGIH, or OSHA) or as defined in national safety requirements.

CAUTION!
Laser safety eyewear protects the user from accidental exposure to laser 
radiation by blocking light at the laser wavelengths. Always wear the 
appropriate laser safety glasses matched to the lasers used in your 
environment.

Because laser safety eyewear may also prevent the operator from seeing the 
beam or the beam spot, exercise caution even while wearing safety glasses.
190



Safety and Compliance
Viewing Distance
A laser produces optical power levels that are dangerous to the eyes and skin if 
exposed directly or indirectly. Operate all laser products only with proper eye and 
skin protection at all times. Never view directly emitted or scattered radiation with 
unprotected eyes.

When viewing the laser during operation, the operator must maintain the Nominal 
Ocular Hazard Distance (NOHD) between the laser or scatter radiation and the 
operator's eyes. Check the Operator’s Manual for the laser you are using for 
details.

Maximum Accessible Radiation Level
A laser produces visible radiation over the various wavelengths. See the Product 
Label on your laser for details about maximum emission levels.

A.3 Laser Back Reflection
This section describes back reflection and tells how to prevent damage or noise 
caused by back reflection.

A.3.1 What is Back Reflection?
Back reflection (also referred to as retroreflection) occurs when a part of the laser 
beam is sent back into the laser’s exit aperture. Back reflection can be caused by 
any object in front of the laser (such as other equipment or even a wristwatch) 
and can result in instability, noise, or damage to the laser.

In a normal application, the laser beam exits the beam aperture and none of the 
light from the laser is reflected back. Ideally, 100% of the output power from the 
laser is used in the application and none of the light is scattered or sent back into 
the laser exit aperture.

The amount of back reflection that can damage a laser diode changes from 
device-to-device. Sometimes a back reflection as low as 4% of the total beam 
power is sufficient to cause damage.

Damage from back reflection can be immediate, or it can be subtle and slowly 
decrease the service life of the laser.

Indications that there are back reflections to the laser that may cause permanent 
damage include:
• No output power
• Low output power
• Over-current of the laser diode
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A.3.2 How to Prevent Back Reflection
The following procedure describes how to prevent a strong back reflection and 
possible damage to the laser:

1. Use the USB or RS-232 controls to set the power to minimum output power
before opening the laser aperture.

2. Do optical or laser alignment at this low output power to confirm there are no
back reflections.

Sources of back reflections include:
• Fiber, Fiber Ferrule, or Fiber Connector 
• Optical Filters that are not angled but are perpendicular to the beam
• Neutral Density Glass or Beam Attenuators that have a front surface

reflection that can create a back reflection.
• Beam Block at normal incidence that reflects power back into the laser
• Plano-concave or Plano-convex lenses where the flat surface reflects back

part of the beam
• Power measurement probes that use a reflective attenuator or have a

surface that reflects the laser light.
• Mirrors or other shiny surfaces from mounts or other optical components in

the beam path.

When measuring laser power with a power meter, always angle the power sensor 
so that the laser beam does not reflect back into the laser exit aperture.

To properly measure laser power:

1. Take the measurement near the laser.

2. Move the power sensor to maximize the reading of the output power. 

CAUTION!
DO NOT let this movement and alignment create a back reflection.

In many cases an object is positioned in front of the laser as a beam block. Make 
sure the object is not reflective and does not create a back reflection to the laser.

If you cannot adjust your application to decrease the back reflection of the laser 
light into the laser's exit aperture, add an optical isolator to protect the laser. 
Although the optical isolator adds cost and requires additional space, it can be an 
appropriate safety factor to increase the life of the laser.

Be aware of every optical surface in front of the laser. All object have the 
opportunity to create a back reflection. In many cases the front surface and the 
back surface of the optic are a source of back reflection.
• The closer the object is to the laser, the more angle is needed to direct the

back reflection away from the laser exit aperture. 
• The farther the object is away from the laser, the less angle is needed to

direct the back reflection away from the laser exit aperture. 
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IMPORTANT!
The Coherent product Warranty does not cover damages to the laser caused 
by customer handling failure. Take precautions with initial set-up to avoid 
damage to the laser. Avoid any condition where any part of the laser beam 
reflects back into the laser exit aperture.

A.4 Summary of Precautions
• Review the objects in front of the laser and note which surfaces are a

possible hazard for back reflections. Change the objects to be less reflective
whenever possible. Adding Anti-Reflective (AR) coatings to optics and more
diffuse surfaces to mounts or beam shutters can help.

• If possible, add an angle to the object so that the reflection does not enter
the laser exit aperture.

• Take precautions when moving objects that can create a back reflection in
front of the laser.

• Decrease the power from any possible back reflections by starting the laser
at lower output power—for example 10% output power—before opening the
laser shutter.

• Using correct safety precautions, watch where the reflections from objects
are returning to make sure the reflections are not at or near the laser exit
aperture.

• Take extra precautions when using a laser power meter— consider how
close the measurement is being taken to the laser and the angle at which the
beam can reflect off the sensor so that it doesn't reflect back into the laser.

• A laser that shows low output power, no output power, over-current, or high
noise, indicates a possibility that there is a back reflection into the laser.

• Add an optical isolator to those applications that have laser exit aperture
back reflections that cannot be corrected by angling the optics.
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B SERVICE AND SUPPORT
This section provides information about:
• How to contact Product Support
• How to obtain service
• Product shipping instructions

B.1 Contact Product Support
Coherent provides telephone and web-based technical assistance as a service to 
its customers and assumes no liability thereby for any injury or damage that may 
occur contemporaneous with such services.

For general Technical Support, contact your local Coherent Service 
Representative as described on the following page, or contact Coherent as 
follows:
• By phone: 1-(408)-764-4557 or 1-(800)-367-7890
• By e-mail: Product.Support@Coherent.com

• To view a list of contact names, telephone numbers, and addresses
worldwide, visit our website: www.Coherent.com

Under no circumstances do these support services affect the terms of any 
warranty agreement between Coherent and the buyer. Operation of any Coherent 
laser with any of its interlocks (or safety features) defeated is always at the 
operator's own risk.

Please be prepared to provide the following information:
• Model or part number of your unit
• Serial number of your unit
• A description of the problem
• Any corrective steps you may have attempted

B.1.1 LSM Support in the USA and North America
If you are shipping products from within the United States or North America, 
contact LMC Technical Support directly, as follows:
• By phone: North America (800) 343-4912 or (408) 767-4042
• By e-mail: LSM.service@coherent.com

Telephone coverage is available Monday through Friday (except during U.S. 
holidays). Inquiries received outside normal office hours are tracked by our 
automatic answering system and promptly returned the next business day.

For additional information about sensor products, go to:

https://www.coherent.com/measurement-control

For answers to frequently asked questions, go to this link, scroll down and click 
FAQ, then select “Ask a Question or Read the Answers”:
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https://www.coherent.com/measurement-control/measurement/laser-measurement-and-
control-help-center 

B.1.2 International LMC Support
If you are located in Europe, contact LMC Technical Support directly, as follows:
• Germany: +49–6071–968–0
• Japan: +813–5635–8680

B.2 Obtaining Service
To obtain service under this warranty, Customer must notify the Company of the 
defect before the expiration of the warranty period and make suitable 
arrangements for the performance of service.

The Company shall, in its sole discretion, determine whether to perform warranty 
service at the Customer's facility, at the Company's facility, or at an authorized 
repair station.

If Customer is directed by the Company to ship the product to the Company or a 
repair station, 

Customer shall:
• Package the product (to protect from damage during shipping) as instructed

in “Product Shipping Instructions” next.
• Ship it to the address specified by the Company, with shipping prepaid. back

to Coherent in conjunction with recalibration and recertification.
• Coherent shall pay the cost of shipping the Product back to the Customer in

conjunction with product failures within the first twelve (12) months of time of
sale or during an extended 12-month warranty period.

B.3 Product Shipping Instructions
You must include a Returned Material Authorization number (RMA) assigned by 
the Company on the outside of all shipping packages and containers. Items 
returned without an RMA number are subject to return to the sender. Detailed 
instructions to prepare a product for shipping are provided in the next section.

To prepare a product for shipping to Coherent:

1. Contact Coherent Customer Service (see “Contact Product Support” in the
next section) for a Return Material Authorization number.

2. Attach a tag to the product that includes the name and address of the owner,
the person to contact, the serial number, and the RMA number you received
from Coherent Customer Service. Pack this tag inside the box.

3. Wrap the product with polyethylene sheeting or equivalent material.

4. Using the original shipping and packaging materials, pack the product.

5. Seal the shipping carton with shipping tape or an industrial stapler.
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6. Add the RMA number you received from Coherent Customer Service to the
shipping label on the outside of the box.
Ship the product to the following address:
Coherent, Inc.

Laser Measurement and Control, Attn: RMA #
27650 SW 95th Ave.
Wilsonville, OR 97070
USA
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C WARRANTY
Coherent, Inc. warrants OBIS Laser Systems to the original purchaser (the Buyer) 
only; that the laser system that is the subject of this sale, (a) conforms to 
Coherent's published specifications, and (b) is free from defects in materials and 
workmanship.

Laser systems are warranted to conform to Coherent's published specifications and 
to be free from defects in materials and workmanship as specified in the sales or 
service contract. Replacement units shipped within warranty carry the remainder 
warranty of the failed unit.

C.1 Responsibilities of the Buyer
The Buyer is responsible for providing the appropriate utilities and an operating 
environment as outlined in the product literature. Damage to the laser system 
caused by failure of Buyer's utilities or failure to maintain an appropriate operating 
environment, is solely the responsibility of the Buyer and is specifically excluded 
from any warranty, warranty extension, or service agreement.

The Buyer is responsible for prompt notification to Coherent of any claims made 
under warranty. In no event will Coherent be responsible for warranty claims made 
later than seven (7) days after the expiration of warranty.

The foregoing warranty shall not apply to defects resulting from any of the following 
conditions:

C.2 Limitations of Warranty
The foregoing warranty shall not apply to defects resulting from any of the following 
conditions:
• Components and accessories manufactured by companies other than

Coherent, which have separate warranties
• Improper or inadequate maintenance by the Buyer
• Buyer-supplied interfacing
• Operation outside the environmental specifications of the product
• Unauthorized modification or misuse
• Improper site preparation and maintenance
• Opening the housing

Coherent assumes no responsibility for customer-supplied material. The 
obligations of Coherent are limited to repairing or replacing, without charge, 
equipment that proves to be defective during the warranty period. Replacement 
sub-assemblies may contain reconditioned parts. Repaired or replaced parts are 
warranted for the duration of the original warranty period only. The warranty on 
parts purchased after expiration of system warranty is ninety (90) days. This 
warranty does not cover damage due to misuse, negligence or accidents; or 
damage due to installations, repairs or adjustments not authorized specifically by 
Coherent.
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This warranty applies only to the original purchaser at the initial installation point 
in the country of purchase, unless otherwise specified in the sales contract. The 
warranty is transferable to another location or to another customer only by special 
agreement, which will include additional inspection or installation at the new site. 
Coherent disclaims any responsibility to provide product warranty, technical or 
service support to a customer that acquires products from someone other than 
Coherent or an authorized representative.

THIS WARRANTY IS EXCLUSIVE IN LIEU OF ALL OTHER WARRANTIES, 
WHETHER WRITTEN, ORAL OR IMPLIED, AND DOES NOT COVER 
INCIDENTAL OR CONSEQUENTIAL LOSS. COHERENT SPECIFICALLY 
DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE.
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GLOSSARY
°C Degrees Centigrade or Celsius
°F Degrees Fahrenheit
Ω Ohm(s)
μ Micron(s)
μm Micrometer(s) = 10-6 meters
μrad Microradian(s) = 10-6 radians
μsec Microsecond(s) = 10-6 seconds
1/e2 Beam diameter parameter = 0.13534

AC Alternating current
Address A unique one-byte identifier assigned to each device on the bus
Amp Ampere(s)
APC Angle physical contact
Application Protocol

A set of application defined commands and replies used to implement a system of
cooperative devices

Automatic Send Data Control
An optional hardware feature that is useful to control enable/disable of transmit enable
line of RS-485 transceiver

BNC Type of connector
Broadcast Message

Message sent by a master device and received by all connected slave devices
BUSMGMT

Message is a bus management message.

CCB Coherent Connection Bus, a RS-485 communication bus
CDRH Center for Devices and Radiological Health
cm Centimeter(s)
CW Continuous wave

DC Direct current
DDL Direct diode laser
Destination Address

Address of the recipient device for a message
DHCP Dynamic Host Configuration Protocol. A protocol that provides a means to dynamically

allocate IP addresses to computers on a local area network.
DLE Data link escape

EOM A two-byte sequence indicating the end of a message packet
ESD Electrostatic discharge
ETX End of message data

FC Fiber-connector
FP Fiber pigtail

g Gram(s) or earth’s gravitational force (gravity)
GUI Graphical user interface

HeNe Helium neon
Hz Hertz or cycles per second (frequency) (= 1/pulse period)

IEC International Electrotechnical Commission
IR Infrared (wavelength)
I/O Input/output
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kg Kilogram(s) = 103 grams
kHz Kilohertz = 103 hertz
kOhm Kilohm(s) = 103 ohms

LCD Liquid crystal display
LED Light emitting diode
LS version OBIS Laser, based on optically pumped semiconductor laser (OPSL)

technology
LX version OBIS Laser, based on direct diode laser (DDL) technology

m Meter(s) (length)
mA Milliamp(s) = 10-3 Amperes
mAmp Milliampere(s)
Master Controlling device which manages bus direction, assigns device addresses,

and generally the source for all application protocol command initiation
MHz Megahertz = 106 hertz
mm Millimeter(s) = 10-3 meters
mrad Milliradian(s) = 10-3 radians (angle)
ms Millisecond(s) = 10-3 seconds
mV Millivolt(s)
MVP Modulation and variable power
mW Milliwatt(s) = 10-3 Watts (power)

NA Numerical aperture
nm Nanometer(s) = 10-9 meters (wavelength)
Nm Newton meter (torque)

OBIS 1L Remote
A dedicated Coherent device that serves as a communication gateway to a
single laser and provides a CDRH-compliant Key Switch and interlock
capabilities.

OEM Original equipment manufacturer
OPSL Optically-pumped semiconductor laser
oz·in. Ounce inches

PIP Port Identification Pin, a signal pin located on the cable connecting the slave
device to the CCB

PPS Pulses per second

rms Root mean square (effective value of a sinusoidal wave)
RMA Return material authorization

SDR Shrunk delta ribbon. This connector type is used on the back panel of the OBIS
Laser for the full-feature I/O cable.

Slave Device which receives and interprets messages and responds as required
SOM A two-byte sequence indicating the start of a message packet
Source Address

Address of the device transmitting a message
Standard Message

Message sent from the master device to a specific slave device address
SRCCCB

Message originated from CCB stack.
SRCCONT

Message originated from master device (controller).
STX Start of message data
System Protocol

A set of predefined bus management commands and responses used by CCB
protocol stacks for set-up and management of the bus
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TEC Thermoelectric cooler
TEM Transverse electromagnetic mode (cross-sectional laser beam mode)
TTL Transistor-transistor logic

UART Universal asynchronous receiver/transmitter
UFC Ultra-flat contact
UV Ultraviolet

V Volt(s)
VAC Volts, alternating current
VDC Volts, direct current

W Watt(s) (power)

ST Version of OBIS Laser, based on optically pumped solid state laser technology
(DPSS)
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